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Preface

While R and Stata have many features in common, their languages are quite
different. Our goal in writing this book is to help you translate what you know
about Stata into a working knowledge of R as quickly and easily as possible.
We point out how they differ using terminology with which you are familiar
and we include many Stata terms in the table of contents and index. You can
find any R function by looking up its counterpart in Stata and vice versa. We
provide many example programs done in R and Stata so that you can see how
they compare topic by topic.
When finished, you should be able to use R to:

Read data from various types of text files and Stata data sets.
Manage your data through transformations, recodes, and combining data
sets from both the add-cases and add-variables approaches and restruc-
turing data from wide to long formats and vice versa.

e Create publication quality graphs including bar, histogram, pie, line,
scatter, regression, box, error bar, and interaction plots.

e Perform the basic types of analyses to measure strength of association and
group differences and be able to know where to turn to cover much more
complex methods.

Who This Book Is For

This book is, of course, for people who already know Stata. It may also be
useful to R users wishing to learn Stata. However, we explain none of the
Stata programs, only the R ones and how the packages differ, so it is not ideal
for that purpose.

This book is based on R for SAS and SPSS Users [34]. However, there is
quite a bit of additional material covered here, and, of course, the comparative
coverage is completely different.
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Who This Book Is Not For

We make no effort to teach statistics or graphics. Although we briefly state
the goal and assumptions of each analysis, we do not cover their formulas
or derivations. We have more than enough to discuss without tackling those
topics too. This is also not a book about writing R functions, it is about
using the thousands that already exist. We will write only a few very short
functions. If you want to learn more about writing functions, we recommend
John Chamber’s Software for Data Analysis: Programming with R [5]. How-
ever, if you know Stata, reading this book should ease your transition to more
complex books like that.

Practice Data Sets and Programs

All of the programs, data sets, and files that we use in this book are avail-
able for download at http://rdstats.com. A file containing corrections and
clarifications is also available there.

Acknowledgments
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reviewers.

A special thanks goes to Hadley Wickham, who provided much guid-
ance on his ggplot2 graphics package. Thanks to Gabor Grothendieck, Lauri
Nikkinen, and Marc Schwarz and for the R-Help help discussion that led to
Section 10.14: “Selecting First or Last Observations per Group.” Thanks to
Gabor Grothendieck also for a detailed discussion that lead to Section 10.4:
“Multiple Conditional Transformations.” Thanks to Michael A. McGuire for
his assistance with all things Macintosh.



Preface vii

The first author is grateful to his wife, Carla Foust, and sons Alexander
and Conor, who put up with many lost weekends as he wrote this book.

The second author wishes to thank Springer editor John Kimmel for
suggesting his participation in this project and his wife, Cheryl, children
Heather, Michael and Mitchell, and Sirr for their patience while he spent
time away from them working on this book.

Robert A. Muenchen
muenchen.bob@gmail.com
Knoxville, Tennessee
January 2010

Joseph M. Hilbe
hilbe@asu.edu
Florence, Arizona
January 2010

About the Authors

Robert A. Muenchen is a consulting statistician and author of the book, R
for SAS and SPSS Users [34]. He is currently the manager of Research Com-
puting Support (formerly the Statistical Consulting Center) at the University
of Tennessee. Bob has conducted research for a variety of public and private
organizations and has co-authored over 50 articles in scientific journals and
conference proceedings.

Bob has served on the advisory boards of the SAS Institute, SPSS Inc., the
Statistical Graphics Corporation, and PC Week Magazine. His suggested im-
provements have been incorporated into SAS, SPSS, JMP, STATGRAPHICS,
and several R packages.

His research interests include statistical computing, data graphics and vi-
sualization, text analysis, data mining, psychometrics, and resampling.

Joseph M. Hilbe is Solar System Ambassador with NASA /Jet Propulsion
Laboratory, California Institute of Technology, an adjunct professor of statis-
tics at Arizona State, and emeritus professor at the University of Hawaii. He
is an elected Fellow of the American Statistical Association and of the Royal
Statistical Society and is an elected member of the International Statistical
Institute.

Professor Hilbe was the first editor of the Stata Technical Bulletin, later
to become the Stata Journal, and was one of Stata Corporation’s first senior
statisticians (1991-1993). Hilbe is also the author of a number of textbooks,



viii Preface

including Logistic Regression Models [21], Negative Binomial Regression [23],
and with J. Hardin, Generalized Linear Models and Extensions, 2nd ed. [18]
and Generalized Estimating Equations [19].

S-PLUS@®)is a registered trademark of Tibco, Inc.

SAS®)is a registered trademark of SAS Institute.

SPSS@®)is a registered trademark of SPSS, Inc.

Stata@®)is a registered trademark of Statacorp, Inc.

STATISTICA®)is a trademark of StatSoft, Inc.

Windows 7@®), Windows Vista®), and Windows XP®)are registered
trademarks of Microsoft, Inc.

Macintosh@and Mac OS®)are registered trademarks of Apple, Inc.
Copyright (©)2010 Robert A. Muenchen and Joseph M. Hilbe. All rights
reserved.



Contents

Preface . ... ... v
1 Introduction.......... ... .. . . 1
L1 OVeIVIEW .ottt 1
1.2 Similarities Between R and Stata .......................... 2
1.3 Why Learn R? .. ..o 3
1.4 IsR Accurate? ........ ... 4

1.5 What About Tech Support? ..... ... ... ... .. .. ... ... .. 4
1.6 Getting Started Quickly .. ....... ... .. .. ... . 5
1.7 Programming Conventions............. ... ..., 5
1.8 Typographic Conventions. .............c.ooiuiiunieen.... 6

2 Installing and Updating R ......... .. .. ... .. ... .. .. .... 9
2.1 Installing Add-on Packages .......... ... ... .. .. ... ... 10
2.2 Loading an Add-on Package ........... ... . ... . ... ... 10
2.3 Updating Your Installation .......... ... ... .. .. ... .... 14
2.4 Uninstalling R ... . 15
2.5 Choosing Repositories. . ..., 15
2.6 Accessing Data in Packages .. ........ ... .. .. ... .. 17

3 Running R ... ... 19
3.1  Running R Interactively on Windows ...................... 19
3.2  Running R Interactively on Macintosh ..................... 21
3.3  Running R Interactively on Linux or UNIX ................. 23
3.4  Running Programs That Include Other Programs............ 25
3.5 Running Rin Batch Mode......... .. .. ... .. ... .. ... 25
3.6 Graphical User Interfaces............. .. ... ... iiii.. 26
3.6.1 R Commander ............. ... ... ..., 26

3.6.2 Rattle for Data Mining ............ ... ... ... ... 29

3.6.3 JGR Java GUIfor R..... ... .. .. .. . ... ... ... 30

ix



X Contents

4 Help and Documentation .............. .. ... .. .. .. .. .... 37
4.1 Introduction .......... ... 37
4.2 Help Files .. ..o 37
4.3 Starting Help ... 37
4.4  Help Examples . ........ o 39
4.5  Help for Functions That Call Other Functions............... 40
4.6  Help for Packages ........... .. . i 41
4.7 Help for Data Sets........ ... 42
4.8 Booksand Manuals................. ... 42
4.9 E-mail Lists . ... 42
4.10 Searching the Web. . ... ... ... .. . i 43
411 Vignettes. .. ..ottt 43

5 Programming Language Basics .................. ... .. ... 45
5.1  Introduction .......... .. ... . 45
5.2 Simple Calculations. .......... ... i 46
5.3  Data Structures ... ...... ...t 47

5.3.1 Vectors . ..o 47
5.3.2 Factors ...... ... . 51
5.3.3 Data Frames...........c. . i, 56
5.3.4 Matrices . ...ovii 60
5.3.5 ATTaYS « oot 63
5.3.6 Lists. o 63
5.4  Saving Your Work ...... .. .. 67
5.5 Comments to Document Your Programs.................... 69
5.6  Controlling Functions (Commands) ........................ 70
5.6.1 Controlling Functions with Arguments ............. 70
5.6.2 Controlling Functions with Formulas............... 72
5.6.3 Controlling Functions with an Object’s Class ....... 73
5.6.4 Controlling Functions with Extractor Functions . . ... 75
5.7  How Much Output is There?...... ... ... .. ... .. ... ... 7
5.8  Writing Your Own Functions (Macros) ..................... 81
5.9 R Program Demonstrating Programming Basics ............. 84

6 Data Acquisition ......... ... .. . 91
6.1 The R Data Editor ......... ... .. .. 91
6.2 Reading Delimited Text Files ............ ... ... ... ...... 93

6.2.1 Reading Comma-Delimited Text Files.............. 94
6.2.2 Reading Tab-Delimited Text Files ................. 95
6.2.3 Missing Values for Character Variables............. 97
6.2.4 Trouble with Tabs....... ... .. . ... . ... ... 98
6.2.5 Skipping Variables in Delimited Files .............. 99
6.2.6 Example Programs for Reading Delimited Text
Files. ... oo 100
6.3 Reading Text Data Within a Program .................. ... 102



Contents xi

6.3.1 The Easy Approach ......... ... .. .. ... ... ... 102
6.3.2 The More General Approach...................... 104
6.3.3 Example Programs for Reading Text Data Within a
Program ....... ... ... . 104
6.4 Reading Fixed-Width Text Files, One Record per Case. ...... 106
6.4.1 Macro Substitution ........ ... ... o i 109
6.4.2 Example Programs for Reading Fixed-Width Text
Files, One Record Per Case . ...................... 110
6.5 Reading Fixed-Width Text Files, Two or More Records per
CaSE et 111
6.5.1 Example Programs to Read Fixed-Width Text Files
with Two Records per Case....................... 112
6.6  Importing Data from Statainto R ......................... 113
6.6.1 R Program to Import Data from Stata ............. 114
6.7  Writing Data to a Comma-Delimited Text File .............. 114
6.7.1 Example Programs for Writing a Comma-Delimited
File. ..o 115
6.8 Exporting Data from R to Stata........................... 116
Selecting Variables ........ .. .. .. . ... i 119
7.1  Selecting Variables in Stata ........... ... .. .. ... ... ... 119
7.2 Selecting All Variables ......... .. .. .. i i, 120
7.3  Selecting Variables Using Index Numbers................ ... 120
7.4  Selecting Variables Using Column Names . .................. 123
7.5  Selecting Variables Using Logic .......... ... .. .. .. .. ... .. 124
7.6 Selecting Variables Using String Search .................... 126
7.7 Selecting Variables Using $ Notation ....................... 128
7.8  Selecting Variables Using Component Names................ 129
7.8.1 The attach Function ............. .. ... .. ...... 129
7.8.2 The with Function ........... ... ... .. ... ...... 130
7.8.3 Using Component Names in Formulas.............. 130
7.9  Selecting Variables with the subset Function ............... 131
7.10 Selecting Variables Using List Index ............. ... ... ... 132
7.11 Generating Indexes A to Z from Two Variable Names ........ 132
7.12 Saving Selected Variables to a New Dataset................. 133
7.13 Example Programs for Variable Selection ................... 134
7.13.1  Stata Program to Select Variables ................. 134
7.13.2 R Program to Select Variables .................... 134
Selecting Observations . ........... .. .. ... ... . .. 139
8.1  Selecting Observations in Stata............. ... ... ... .... 139
8.2  Selecting All Observations . ..............coiiiiiiinan.. 140
8.3  Selecting Observations Using Index Numbers ............... 140
8.4  Selecting Observations Using Row Names................... 143
8.5 Selecting Observations Using Logic ......... .. ... .. ... ... 145



Xii Contents

8.6  Selecting Observations Using String Search ................. 148
8.7  Selecting Observations Using the subset Function........... 150
8.8  Generating Indexes A to Z from Two Row Names ........... 151
8.9  Variable Selection Methods with No Counterpart for Selecting
ODbServations . . .. ..ottt 152
8.10 Saving Selected Observations to a New Data Frame.......... 152
8.11 Example Programs for Selecting Observations............... 152
8.11.1  Stata Program to Select Observations.............. 153
8.11.2 R Program to Select Observations ................. 153
9 Selecting Variables and Observations ....................... 157
9.1 The subset Function ............ .. .. .. ..., 157
9.2  Selecting Observations by Logic and Variables by Name . ... .. 158
9.3  Using Names to Select Both Observations and Variables. . . ... 159
9.4  Using Numeric Index Values to Select Both Observations and
Variables . . ... 160
9.5  Using Logic to Select Both Observations and Variables . ... ... 161
9.6  Saving and Loading Subsets ......... ... ... .. .. .. .. 162
9.7  Example Programs for Selecting Variables and Observations .. 162
9.7.1 Stata Program for Selecting Variables and
ODbServations. . .......oviunin i 162
9.7.2 R Program for Selecting Variables and Observations . 163
10 Data Management .. ........... .. .. . . i 167
10.1 Transforming Variables............ ... ... .. ... ..., 167
10.1.1  Example Programs for Transforming Variables .. .... 171
10.2 Functions or Commands? The apply Function Decides . ... ... 172
10.2.1  Applying the mean Function ...................... 173
10.2.2  Finding Nor NVALID ......... ... ... ... ... ... 176
10.2.3  Example Programs for Applying Statistical
Functions ........ .. . . . . 178
10.3 Conditional Transformations ............................. 180
10.3.1  Example Programs for Conditional
Transformations. ......... .. ... .. . .. . 182
10.4 Multiple Conditional Transformations...................... 183
10.4.1  Example Programs for Multiple Conditional
Transformations. ............ ... .. ... ... ... .. 185
10.5 Missing Values . ...t 186
10.5.1  Substituting Means for Missing Values ............. 188
10.5.2  Finding Complete Observations ................... 189
10.5.3 When “99” Has Meaning . ............. .. ... .. .... 190
10.5.4  Example Programs to Assign Missing Values........ 192
10.6 Renaming Variables (and Observations) .................... 194
10.6.1  Renaming Variables—Advanced Examples.......... 196
10.6.2 Renaming by Index........... ... .. .. .. .. .... 197

10.6.3 Renaming by Column Name ...................... 198



10.7

10.8

10.9

10.10

10.11

10.12

10.13

10.14

10.15

10.16

10.17

Contents

10.6.4 Renaming Many Sequentially Numbered Variable

NameS . oot e
10.6.5 Renaming Observations ..........................
10.6.6  Example Programs for Renaming Variables .........
Recoding Variables ......... .. .. .. . .
10.7.1  Recoding a Few Variables ........................
10.7.2  Recoding Many Variables ........................
10.7.3  Example Programs for Recoding Variables..........
Keeping and Dropping Variables ..........................
10.8.1 Example Programs for Keeping and Dropping

Variables . ...... . .
Stacking/Appending Data Sets . . .........vuueeineeo..
10.9.1  Example Programs for Stacking/Appending

Data Sets ...
Joining/Merging Data Sets .......... ...,
10.10.1 Example Programs for Joining/Merging Data Sets. . .
Creating Collapsed or Aggregated Data Sets ................
10.11.1 The aggregate Function .........................
10.11.2 The tapply Function ............................
10.11.3 Merging Aggregates with Original Data ............
10.11.4 Tabular Aggregation ... ...........couviieaen ..
10.11.5 The reshape Package .......... ... ... ... ... ....
10.11.6 Example Programs for Collapsing/Aggregating

By or Split-File Processing ........ ... .. .. .. ... .. ...
10.12.1 Comparing Summarization Methods ...............
10.12.2 Example Programs for By or Split-file Processing. . . .
Removing Duplicate Observations .........................
10.13.1 Example Programs for Removing Duplicate
ObServations. . . .....ouut it
Selecting First or Last Observations per Group..............
10.14.1 Example Programs for Selecting Last Observation
PEE GIOUD .« v v v ettt e e
Reshaping Variables to Observations and Back ..............
10.15.1 Example Programs for Reshaping Variables to
Observations and Back........... .. .. ... .. ..
Sorting Data Frames......... ... .. . . i
10.16.1 Example Programs for Sorting Data Sets ...........
Converting Data Structures. ................ ..., ..
10.17.1 Converting from Logical to Numeric Index
and Back. ... ... .

11 Enhancing Your Output ............ ... ... .. ... ... ... ....

11.1

Value Labels or Formats (and Measurement Level) ..........
11.1.1  Character Factors ............................ ...
11.1.2  Numeric Factors ........... ... ... .. ... ... ...

xiii



Xiv Contents

11.1.3  Making Factors of Many Variables................. 258
11.1.4  Converting Factors into Numeric or Character
Variables . ... ... 260
11.1.5  Dropping Factor Levels .......................... 262
11.1.6  Example Programs for Value Labels or Formats .. ... 263
11.2 Variable Labels ........ .. . i 266
11.2.1  Variable Labels in The Hmisc Package ............. 266
11.2.2  Long Variable Names as Labels ................... 267
11.2.3  Other Packages That Support Variable Labels ... ... 270
11.2.4  Example Programs for Variable Labels ............. 270
11.3  Output for Word Processing and Web Pages ................ 271
11.3.1  The xtable Package ............. .. ... .. .. .... 272
11.3.2  Other Options for Formatting Output ............. 274
11.3.3  Example Programs for Formatting Output ......... 275
12 Generating Data......... ... ... .. . 277
12.1 Generating Numeric Sequences . ............c.oooueennen. .. 278
12.2  Generating Factors ......... ... .. i i 279
12.3  Generating Repetitious Patterns (Not Factors) .............. 280
12.4 Generating Integer Measures. .. ........... oo, 281
12.5 Generating Continuous Measures .. ............c..ovven. .. 283
12.6 Generating a Data Frame .......... ... ... .. .. ... ..... 285
12.7 Example Programs for Generating Data .................... 285
12.7.1  Stata Program for Generating Data................ 285
12.7.2 R Program for Generating Data................... 286
13 Managing Your Files and Workspace ....................... 291
13.1 Loading and Listing Objects ........... ... ... ... .. .. .... 291
13.2  Understanding Your Search Path .......................... 294
13.3 Attaching Data Frames ......... .. ... ... .. .. ... ... 296
13.4 Attaching Files. .. ... ... ... i 298
13.5 Removing Objects from Your Workspace ................... 299
13.6 Minimizing Your Workspace ............ .. .. .. . ... 301
13.7 Setting Your Working Directory ............. .. .. .. .. .... 301
13.8 Saving Your Workspace ......... .. ... i 302
13.8.1  Saving Your Workspace Manually ................. 302
13.8.2  Saving Your Workspace Automatically ............. 303
13.9 Getting Operating Systems to Show You “.RData” Files .. ... 303
13.10 Organizing Projects with Windows Shortcuts ............... 304
13.11 Saving Your Programs and Output ........................ 304
13.12 Saving Your History ........ ... i 305
13.13 Large Data Set Considerations ............................ 305
13.14 Example R Program for Managing Files

and Workspace . . ... 307



Contents b'a’s

14 Graphics Overview ............ ... i 311
14.1 Stata Graphics . ....... .o 312
14.2 R Graphics . ... 312
14.3 The Grammar of Graphics............. ... .. ... ... ... .... 313
14.4  Other Graphics Packages ........ ... .. ... .. ... . ... 315
14.5 Graphics Procedures and Graphics Systems................. 315
14.6  Graphics Devices . .. ...oiiii i 316
14.7 Practice Data: mydatalO0 ....... ... ... ... .. ... 318

15 Traditional Graphics........... .. .. .. . .. i 319
15,1 Bar Plots. . ..o 319

15.1.1 Bar Plotsof Counts ............................. 319
15.1.2  Bar Plots for Subgroups of Counts................. 324
15.1.3 BarPlotsof Means .............. ... ... .. .... 326
15.2 Adding Titles, Labels, Colors, and Legends ................. 327
15.3 Graphics Parameters and Multiple Plots on a Page ......... 330
154 Pie Charts. . .....cooiii 331
15.5 Dot Charts . ... 333
15.6 Histograms .......... ...t 333
15.6.1 Basic Histograms........... .. .. .. . ... .. ... 334
15.6.2  Histograms Stacked............ ... ... .. ... ... 336
15.6.3  Histograms Overlaid ........... ... .. .. ... ... 337
15.7 Normal QQ Plots. ... ... . 341
15.8 Strip Charts . ... 342
15.9 Scatter Plots and Line Plots ......... .. ... .. ... . ... 347
15.9.1  Scatter plots with Jitter........... ... ... ... .... 350
15.9.2  Scatter plots with Large Data Sets ................ 350
15.9.3  Scatter plots with Lines .. ........................ 352
15.9.4  Scatter plots with Linear Fit by Group............. 353
15.9.5  Scatter plots by Group or Level (Coplots) .......... 354
15.9.6  Scatter plots with Confidence Ellipse .............. 356
15.9.7  Scatter plots with Confidence and Prediction
Intervals ... ... . 357
15.9.8  Plotting Labels Instead of Points .................. 362
15.9.9  Scatter plot Matrices ............ .. ... ... ... ... 364
15.10 Dual-Axes Plots .. ... 366
15.11 Box Plots . ... 368
15.12 Error Bar Plots . ...... ... 370
15.13 Interaction Plots ........ ... .. . 370
15.14 Adding Equations and Symbols to Graphs . ................. 371
15.15 Summary of Graphics Elements and Parameters............. 372
15.16 Plot Demonstrating Many Modifications.................... 373
15.17 Example Program for Traditional Graphics ................. 374
15.17.1 Stata Program for Traditional Graphics ............ 375

15.17.2 R Program for Traditional Graphics ............... 375



xvi Contents

16 Graphics with ggplot2 ......... ... ... ... ... ... ... . 385
16.1 Introduction .......... ... .. 385
16.1.1  Overview gplot and ggplot ...................... 386
16.1.2  Missing Values . ........ ..o i 387
16.1.3  Typographic Conventions ........................ 388

16.2 Bar Plots. ... 389
16.2.1  Pie Charts ...... ..o 392
16.2.2  Bar Charts for Groups .. ........... ... ... ... .. 393

16.3 Plots by Groupor Level ........ ... .. .. ..o i .. 394
16.4 Presummarized Data ........ .. ... .. ... i 396
16.5 Dot Charts . ... ..ot 397
16.6 Adding Titles and Labels........ ... .. ... ..o o o, 399
16.7 Histograms and Density Plots............. .. ... .. .. ... 400
16.7.1  Histograms ........... ... 400

16.7.2  Density Plots ....... ... .. .. 401
16.7.3  Histograms with Density Overlaid ................. 401
16.7.4  Histograms for Groups, Stacked ................... 403
16.7.5  Histograms for Groups, Overlaid .................. 404

16.8 Normal QQ Plots. ....... ... 405
16.9 Strip Plots .. ..o 405
16.10 Scatter Plots and Line Plots ........... ... .. .. .. .. ... ... 408
16.10.1 Scatter Plots with Jitter .......... ... ... .. .... 410
16.10.2 Scatter Plots for Large Data Sets.................. 411
16.10.3 Hexbin Plots ....... ... .. . i, 414
16.10.4 Scatter Plots with Fit Lines ...................... 415
16.10.5 Scatter Plots with Reference Lines................. 416
16.10.6  Scatter Plots with Labels Instead of Points ......... 420
16.10.7 Changing Plot Symbols ........... ... ... ... .... 421
16.10.8 Scatter Plot with Linear Fits by Group ............ 422
16.10.9 Scatter Plots Faceted for Groups .................. 422
16.10.10 Scatter Plot Matrix........... ... .. .. .. ... 424

16.11 Box Plots . ... 425
16.12 Error Bar Plots ...... .. .. . i 428
16.13 Logarithmic AXes ........ ...t 430
16.14 Aspect Ratio . ... .o i 430
16.15 Multiple Plotsona Page .......... ... .. ... .. .. . 431
16.16 Saving ggplot2 GraphstoaFile .......... ... ... ... ... .. 433
16.17 An Example Specifying All Defaults ....................... 433
16.18 Summary of Graphic Elements and Parameters ............. 435
16.19 Example Programs for ggplot2 ............ ... .. ... ... .. 436
17 Statistics . ... . 453
17.1 Scientific Notation........... ... . ... 453
17.2  Descriptive Statistics ...........co i 454
17.2.1  The Hmisc describe Function.................... 454

17.2.2  The summary Function ......... ... .. .. ... .... 456



Contents xvii

17.2.3  The table Function and Its Relatives.............. 457

17.2.4  The mean Function and Its Relatives............... 459

17.3 Cross-Tabulation ............ ... ... 460

17.3.1  The CrossTable Function ........................ 460

17.3.2  The tables and chisq.test Functions ............ 462

17.4  Correlation . ........ .. i 465

17.4.1  The cor Function .......... ... ... ... ... . ... 468

17.5 Linear Regression .............. .. ... i 470

17.5.1  Plotting Diagnostics ........ ... ... .. .. o ... 473

17.5.2  Comparing Models ......... ... ... .. .. ... ... 474

17.5.3  Making Predictions with New Data................ 475

17.6  t-Test: Independent Groups. ... .....c..oouviiiinneeneen.... 476

17.7 Equality of Variance ........ ... ... .. i i 477

17.8 t-Test: Paired or Repeated Measures . ...................... 478
17.9 Wilcoxon Mann-Whitney Rank Sum Test: Independent

GrOUDS .« v ettt e e 479

17.10 Wilcoxon Signed-Rank Test: Paired Groups................. 480

17.11 Analysis of Variance ............ .. ... ... 481

17.12 Sums of Squares. . ...t 486

17.13 The Kruskal-Wallis Test ........ ... .. ... .. ... ... 487

17.14 Example Programs for Statistical Tests..................... 489

17.14.1 Stata Program for Statistical Tests ................ 489

17.14.2 R Program for Statistical Tests ................... 491

18 Conclusion ............ i 497

Glossary of R jargon ... ... ... .. .. .. . . 499

Comparison of Stata commands and R functions............... 505

Automating Your R Setup........... .. ... . ... .. 507

C.1  Setting Options ... ... ..ot 507

C.2  Creating Objects ... ...t 508

C.3 Loading Packages ........... . ... ... 508

C.4  Running Functions ........... ... .. .. . .. 508

C.5 Example .Rprofile ...... ... .. . .. . 510

Example Simulation ......... ... ... ... .. 511

D.1  Stata Example Simulation ............ ... ... .. ... .. ... 511

D.2 R Example Simulation .......... .. . .. . ... . 512

References . ...... .. ... 513






List of Tables

5.1
5.2

10.1
10.2
10.3
10.4

11.1
11.2

13.1

14.1

15.1

15.2
15.3
15.4

16.1

B.1

Example formulas in Stata and R. ............................ 73
Modes and classes of various R objects. ........... ... ... .. .. 74
Mathematical operators in Stataand R........................ 168
Logical operators in Stata and R............ ... .. ... .. ...... 181
Comparison of summarization functions. ...................... 232
Data conversion functions............ ... .. .. . i . 249
Our practice data set printed in BTEX. .. ...t 272
Linear model results formatted by xtable ..................... 274
Workspace management functions ............................ 306
A comparison of R’s three main graphics packages . ............. 313

Graphics arguments for use with traditional high-level

graphics functions. ........ . . 344
Graphics parameters to set or query using only par(). .......... 345
Graphics parameters for both par and graphics functions. ....... 346
Graphics functions to add elements to existing plots............. 347
Comparison of the gplot and ggplot functions. ................ 388
Comparison of Stata commands and functions to R functions. . . .. 506

Xix






List of Figures

2.1
2.2
2.3
24
2.5

3.1
3.2
3.3
3.4
3.5
3.6
3.7
3.8
3.9
3.10
3.11
3.12

4.1
4.2
4.3

5.1

6.1
6.2

10.1
10.2

12.1

Choosing an R mirror site and package........................ 11
Display of packages in the library.......... ... .. .. ... .. .. 12
Display of R package repositories ... ......... .. ... . .. ... 16
Display of practice datasets ........... ... .. .. 17
Display of data sets in the car package........................ 18
R graphical user interface on Microsoft Windows. .............. 20
R graphical user interface on Macintosh. ...................... 22
R Commander GUT at startup ........... ... ..., 27
R Commander’s Data Viewer ............. ... .. ... ... ...... 28
R Commander GULin use .. ..., 28
Rattle GUI for data mining. ........ ... ... ... ... .. ... 30
Rattle writing an R program......... ... .. .. ... . . . .. 31
JGR program editor .......... . 31
JGR offering a list of arguments........ ... .. .. .. ... ... .. 32
JGR’s Package Manager......... ... oo 33
JGR’s Object Browser ........ ... i 34
JGR’s DataTable editor . ......... ... . . . i 35
R’s main help window .......... ... ... . . 38
Example results for searching help files........... ... ... ... ... 41
Help window for the foreign package. ......... .. ... ... .. ... 41
Help file for the mean function. ........... .. ... .. .. ... ...... 71
Adding a new variable in the data editor....................... 92
R data editor with practicedata ............................. 92
Renaming a variable using R’s data editor. ................. ... 195
Renaming variables using the edit function. ................... 196
Barplots of generated data............. ... .. .. . .. 282

xxi



Xx1i

12.2

14.1

15.1

15.2

15.3

15.4

15.5

15.6

15.7

15.8

15.9

15.10
15.11
15.12
15.13
15.14
15.15
15.16
15.17
15.18
15.19
15.20
15.21
15.22
15.23
15.24
15.25
15.26
15.27
15.28
15.29
15.30
15.31
15.32
15.33
15.34
15.35
15.36
15.37
15.38
15.39
15.40
15.41

List of Figures

Histograms of generated data ............. ... ... ... .. ..... 284
Napoleon’s march to Moscow .......... .. .. . .. . . . ... 314
Unlabeled bar plot using traditional graphics. .................. 320
Bad bar plot of unsummarized variable q4. .................... 320
Good bar plot of variable q4 . ...... ... .. .. 321
Barplot of gender. ....... ... ... 322
Horizontal bar plot ........ .. . 323
An unlabeled stacked bar plot of workshop..................... 323
Stacked bar plot of workshop split by gender................... 324
Mosaic plot of workshop by gender from plot. ................. 325
Mosaic plot of workshop by gender from mosaicplot ........... 325
Mosaic plot with three factors.......... ... .. .. ... ... ..... 326
Bar plot of means .......... ... 327
Bar plot of means by workshop and gender .................... 328
Bar plot with title and legend . ......... ... ... ... .. . . 328
Bar plots of counts by workshop and gender ................ ... 332
Pie chart of workshop .. ...... .. .. . 332
Dotchart of workshop within gender .......................... 333
Histogram of posttest .......... ... .. i 334
Histogram of posttest with kernel density curve, tick-marks . .. ... 335
Histogram of posttest, malesonly ............. .. ... .. ... ... 336
Multiframe plot of histograms for all, males.................... 337
Histogram of posttest overlaid with males ..................... 338
Histogram with breakpoints chosen from another ............... 340
Normal quantile plot......... ... .. . . . 341
Strip chart with jitter and stack ......... ... ... .. .o oL 343
Strip chart of posttest by workshop ............ ... ... .. ..., 344
Scatter plot of pretest and posttest ............ ... ... .. ... 348
Scatter plots demonstrating various types .............. ... .... 349
Scatter plots demonstrating jitter ........... .. .. ... oL 350
Scatter plots on large datasets.............. ... ... ... .. ... .. 351
Hexbin plot. ... 351
Scatter plot with various lines added ........... ... ... ... ..., 352
Scatter plot with lines and points by gender ................... 354
Scatter plots conditioned on workshop ........................ 355
Scatter plots conditioned on ql ......... .. .. .. ... .. . ... 356
Scatter plot with confidence ellipse ............. ... ... ... .... 357
Scatter plot to build on ......... ... .. . 358
Scatter plot simulating confidence intervals .................... 359
Scatter plot with confidence intervals ......................... 362
Scatter plot using gender as point symbols..................... 363
Scatter plot plotting character strings as points ................ 363

Scatter plot matrix .. ... ... 364



15.42
15.43
15.44
15.45
15.46
15.47
15.48

16.1

16.2

16.3

16.4

16.5

16.6

16.7

16.8

16.9

16.10
16.11
16.12
16.13
16.14
16.15
16.16
16.17
16.18
16.19
16.20
16.21
16.22
16.23
16.24
16.25
16.26
16.27
16.28
16.29
16.30
16.31
16.32
16.33
16.34
16.35
16.36
16.37

List of Figures  xxiii

Scatter plot matrix with smoothed fits ............. ... ... ..., 366
Scatter plot with dual axes ....... ... .. .. . i 367
box plot of posttest by workshop ........... ... ... ... ... .. 368
box plots of various types . ........... .. 369
Errorbar plot of posttest by workshop............ .. ... ... ... 371
Interaction plot of posttest by workshop and gender ............ 372
Plot demonstrating many annotations......................... 373
Bar plot done with ggplot2 package .............. ... ... ..... 389
Horizontal bar plot . ...... .. .. . . 390
Stacked bar plot of workshop ........ ... ... . il 391
Pie chart of workshop . ....... ... .. . . .. . 392
Barplot types of stack, fill, and dodge . ........... ... ... ... ... 394
Barplots of workshop for each gender ............ . ... ... ... 395
Barplot of presummarized data............ ... ... ... ... ... 397
Dotchart of workshop by gender.............................. 398
Barplot demonstrating titles and labels ........... ... ... .. .. 399
Histogram of posttest .......... ... .. . . i 401
Histogram with smaller bins ........ ... ... .. .. .. ... ..... 402
Density plot of posttest ........ ... . i 402
Histogram with density curve ........ ... .. . ... . ... ... 403
Histograms of posttest by gender ............. ... ... ... ..... 404
Histogram with bars filled by gender ........... .. .. ... ... .. 405
Normal quantile plot........ .. . .. 406
Strip chart with jitter .. ... .. .. .. . . 406
Strip chart by workshop . ........ ... . i 408
Scatter plots demonstrating various line types.................. 409
Scatter plots showing effect of jitter............ ... .. ... ..., 411
Scatter plot showing transparency .............. ... ... ... .... 412
Scatter plot with contour lines ............ .. .. ... .. .. ... .. 414
Hexbin plot of pretest and posttest ........... ... ... ... ..... 415
Scatter plot with regression line and confidence band ........... 416
Scatter plot with regression line but no confidence band ......... 417
Scatter plot with y=xlineadded ............................. 418
Scatter plot with vertical and horizontal reference lines.......... 418
Scatter plot with a multiple vertical reference lines ............. 419
Scatter plot using labels as points .......... ... ... ... .. ... 420
Scatter plot with point shape determined by gender ............ 421
Scatter plot showing regression fits determined by gender. ....... 422
Scatter Plots with regression fits by workshop and gender ....... 423
Scatter plot matrix with lowess fits and density curves .......... 424
box plot of posttest . ... ... ... 425
box plot of posttest by group with jitter....................... 426
box plot of posttest by workshop and gender................... 428
Error bar plot of posttest by workshop .................. ... ... 429



xxiv  List of Figures

16.38 Multiframe demonstration plot . ........... ... ... ... ... ... .. 431
16.39 Scatter plot programmed several ways ........................ 434
17.1 Diagnostic plots for regression ............ ... ... ... . 474

172 Tukey HSD plot. . ... e 485



1

Introduction

1.1 Overview

R [38] is a powerful and flexible environment for research computing. Written
by Ross Thaka, Robert Gentleman (hence the name “R”), the R Core Develop-
ment Team, and an army of volunteers, R provides a wider range of analytical
and graphical commands than any other software. The fact that this level of
power is available free of charge has dramatically changed the landscape of
research software.

R is a variation of the S language, developed by John Chambers, Rick
Becker, and others at Bell Labs'. The Association of Computing Machinery
presented John Chambers with a Software System Award and said that the S
language “...will forever alter the way people analyze, visualize, and manip-
ulate data...” and went on to say that it is “...an elegant, widely accepted,
and enduring software system, with conceptual integrity....” The original S
language is still commercially available as Tibco Spotfire S+. Most programs
written in the S language will run in R.

Stata, a product of Stata Corporation, has not yet incorporated an inter-
face to R in its software, but users have already posted programs to use R
within the Stata environment. It is expected that more facilities of this sort
will be developed in the near future.

For each aspect of R we discuss, we will compare and contrast it with Stata.
Many of the topics end with example programs that do almost identical things
in both software applications. R programs are often longer than similar Stata
code, but this is typically the case because R functions are more specific than
Stata commands.

Many R functions will appear familiar to Stata users; that is, R functions
such as 1m or glm will appear somewhat similar to Stata’s regress and glm
commands. There are other aspects of the two languages, however, that may

! For a fascinating history of S and R, see Appendix A of Software for Data
Analysis: Programming with R [5].

R.A. Muenchen, J.M. Hilbe, R for Stata Users, Statistics 1
and Computing, DOI 10.1007/978-1-4419-1318-0_1,
(© Springer Science+Business Media, LLC 2010
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appear more confusing at first. We hope to ease that confusion by focusing on
both the similarities and differences between R and Stata in this text. When
we examine a particular analysis (e.g., comparing two groups with a t-test)
someone who knows Stata will have very little trouble figuring out what R
is doing. However, the basics of the R language are very different, so that is
where we will spend the majority of our time.

We introduce topics in a carefully chosen order, so it is best to read
from beginning to end the first time through, even if you think you do not
need to know a particular topic. Later you can skip directly to the sec-
tion you need. We include a fair amount of redundancy on key topics to
help teach those topics and to make it easier to read just one section as a
future reference. The glossary in Appendix A defines R concepts in terms
that Stata users will understand and provides parallel definitions using R
terminology.

1.2 Similarities Between R and Stata

Stata is an excellent statistics package. One of the authors has used Stata for
over 20 years and has authored many Stata commands.

Perhaps more than any other two research computing environments, R
and Stata share many of the features that make them outstanding:

e Both include rich programming languages designed for writing new ana-
lytic methods, not just a set of prewritten commands.

e Both contain extensive sets of analytic commands written in their own
languages.

e The pre-written commands in R, and most in Stata, are visible and open
for you to change as you please.

e Both save command or function output in a form you can easily use as
input to further analysis.

e Both do modeling in a way that allows you to readily apply your models
for tasks such as making predictions on new data sets. Stata calls these
postestimation commands and R calls them extractor functions.

e In both, when you write a new command, it is on an equal footing with
commands written by the developers. There are no additional “Developer’s
Kits” to purchase.

e Both have legions of devoted users who have written numerous extensions
and who continue to add the latest methods many years before their com-
petitors.

e Both can search the Internet for user-written commands and download
them automatically to extend their capabilities quickly and easily.

e Both hold their data in the computer’s main memory, offering speed but
limiting the amount of data they can handle.
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1.3 Why Learn R?

With so many similarities, if you already know Stata, why should you bother
to learn R?

To augment Stata; i.e. to be able to perform statistical analyses that are
not available in Stata, but which are available in R. R offers a vast number
of analytical methods. There are now over 3,000 add-on packages available
for R and this number is growing at an exponential rate. Therefore, know-
ing both gives you a much greater range of tools for analyzing data.

To stay current with new analytic methods. The majority of statistics
textbooks, and journal articles, now being published use either Stata or
R for examples. R appears to be used more in many journals. Stata users
not understanding R are therefore not able to learn as much from texts or
articles using R for examples than they would be if they understood the
language.

If you continue to do all of your data management in Stata, you can learn
just enough R to import your data and run the procedures you need.

R is directly accessible from inside many statistics packages. SAS, SPSS,
and STATISTICA offer the ability to run R programs from within their
software. This means that when developers write programs in R, they are
assured a very wide audience. Roger Newson has written an interface [36]
between Stata and R that provides some of this ability. We expect to see
more done on this topic in the near future.

R has been object-oriented since its first version. Many of its commands
sense the types of data structures you have and do the best thing for each.
For example, once you tell it that gender is a categorical variable, it will
take statistically proper actions if you use it as a linear regression predic-
tor. At the time of publication, Stata Corporation had just announced its
future move toward object orientation.

Both languages consist of a core set of functions that are written in the
C language. However, only developers at Stata Corporation can modify
its most fundamental commands. Every aspect of R is open for anyone
to modify in any way they like. This complete flexibility attracts many
developers.

Both R and Stata offer graphics that are flexible, easy to use, and of high
quality. However, R also offers the very flexible and powerful Grammar of
Graphics approach. As we will see, developers have even gone so far as
replacing R’s core graphical system.

R is free. This means, of course, that you can use it for free, but it also
means developers know that their work is available to everyone. That helps
attract developers and is a major reason that there are so many add-on
packages for it.
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1.4 Is R Accurate?

When people first learn of R, one of their first questions is “Can a package
written by volunteers be as accurate as one written by a large corporation?”
People envision a lone programmer competing against a large corporate team.
Having worked closely with several software companies over the years, we
can assure you that this is not the case. A particular procedure is usually
written by one programmer, even at Stata Corporation. A thorough testing
process is then carried out by a few people within the company and then more
thoroughly by Stata users on publication of the new command or function.

The R Development Core Team runs each release of R through validation
suites that have known correct answers to ensure accurate results. They also
go through “Alpha,” “Beta,” and “Release Candidate” testing phases, which
are open to the public. Each phase has tighter restrictions on modifications
of R. Finally, the production version is released. The details of this process
are provided in R: Regulatory Compliance and Validation Issues, A Guidance
Document for the Use of R in Regulated Clinical Trial Environments, available
at http://www.r-project.org/doc/R-FDA.pdf [11].

When bugs are found in Stata, the developers typically make a fix within
days. Users are in continual communication with other users and developers
through the Statalist. An average of 100 communications are posted daily.
Questions are answered by other users or by Stata staff.

R also has open discussions of its known bugs and R’s developers fix them
quickly too. However, software of the complexity of Stata and R will never be
completely free of errors, regardless of its source.

1.5 What About Tech Support?

If a package is free, who supports it?

Stata users may call toll-free or e-mail technical support for problems
they experience with the software or for advice on how to run various software
commands. The response is near immediate, with a day delay in response being
on the high side. Even experienced Stata users sometimes require technical
advice for new commands or functions or have difficulties learning new areas
of statistics or new methodologies (e.g. the matrix programming). We have
always found support to he helpful and friendly.

You can also get support through the Stata Listserver, where it is normal
to get assistance from someone the very day you post your request.

R’s main source of support is the R-help mailing list. Other users and often
developers themselves will often provide immediate help. Sometimes you may
obtain different answers from various responders, but that is part of the nature
of statistics. For details on the various R e-mail support lists, see Chapter 4,
“Help and Documentation.”
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There are several commercial versions of R available, and the companies
that sell them do provide phone support. Here are some of these companies
and their web sites:

XL-Solutions Corp., http://www.experience-rplus.com/

Revolution Computing, Inc., http://www.revolution-computing.com/

Random Technologies, LLC, http://random-technologies-1lc.com/

1.6 Getting Started Quickly

If you wish to start using R quickly, you can do so by reading fewer than 50
pages of this book. Since you have Stata to do your basic descriptive statistics,
you are likely to need R’s modeling functions. Here are the steps you can follow
to use them.

1. Read the remainder of this chapter and Chapter 2, “Installing and Up-
dating R.” Download and install R on your computer.

2. Read the part of Chapter 3, “Running R,” that covers your operating
system.

3. In Chapter 5, “Programming Language Basics,” read Section 5.3.2 about
factors, and Section 5.3.3 about data frames.

4. Also in Chapter 5, read Section 5.6.1, “Controlling Functions with Ar-
guments,” and Section 5.6.2, “Controlling Functions with Formulas,” in-
cluding Table 5.1, “Example formulas in Stata and R.”

5. Read Section 6.6, “Importing Data from Stata.”

After reading the pages above, do all your data management in Stata,
stripping out observations containing any missing values. Then write out only
the variables and observations you need to a comma separated values file,
mydata.csv. Assuming your variables are named y, x1, x2,..., your entire R
program will look something like this:

library("Hmisc") # Contains stata.get function.
library("OtherLibrariesYouNeed") # If you need any.

mydata <- stata.get("mydata.dta") # imports your Stata file
mymodel <- TheFunctionYouNeed( y ~ x1+x2, data=mydata )
summary (mymodel)

plot (mymodel) # if your function does plots.

1.7 Programming Conventions

Although R has many ways to generate practice data and has a variety of
example data sets, we will use a tiny practice data set that is easy to enter.
We can then manipulate and print it repeatedly so that you can clearly see
the changes.
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You can download the practice data sets and program files from http://
r4stats.com. The example programs are set to look for their matching data
files in the directory (folder) named myRfolder, but that is easy to change to
whatever location you prefer. Each program begins by loading the data as if it
were a new session. That is not required if you already have the data loaded,
but it makes it easier to ensure that previous programming does not interfere
with the example. It also allows each program to run on its own.

Each example program in this book begins with a comment stating its
purpose and the name of the file in which it is stored. For example, the
programs for selecting variables each begin with a comment like the one below.

# R Program for Selecting Variables.
# Filename: SelectingVars.R

When displaying the programs within the book, we dispense with first line
since it appears as the title of the section.

R’s “#” symbol is like Stata’s “*” symbol. Words after it are regarded
as comments, until the end of the line. The filename in the practice files
will always match, so the two files for this topic are SelectingVars.do, and
SelectingVars.R. The R data objects and Stata data sets used in this book
are also available. Their names are the same as that used in the book, with
the extensions “.dta” and “.RData” for the Stata and R files, respectively.
For example, our most widely used data object, mydata, is stored in both
mydata.dta and mydata. RData. Also, all of the R objects we create, data and
functions, are stored in myAll.RData.

1.8 Typographic Conventions

We write all programming code and the names of all commands, functions,
and packages in this Courier font.

The names of other documents and menus are in this italic font.

Menus appear in the form File>Save as..., which means “choose Save
as. .. from the File menu.”

When learning a new language, it can be hard to tell the commands from
the names you can choose (e.g., variable or data set names). To help differen-
tiate, we use the common prefix “my” in names like mydata or mySubset.

R uses “>” to prompt you to input a new line and “+” to prompt you
to enter a continued line. When there is no output to see, we delete the
prompt characters to achieve a less cluttered look. However, when examples
include both input and output, we leave the input prompts in place. That
helps you identify which is which. So the first three lines below are the input
we submitted and the last line is the mean that R wrote out.

> ql <= c(1, 2, 2, 3,
+ 4, 5, 5, 5, 4)

> B
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> mean(ql)

[1] 3.4444

R tends to pack its input and different sections of output tightly together.
This makes it harder to read when you are learning it. Therefore, we also add
spacing in some places to improve legibility. In the example above, we added
a blank line on either side of the line containing “> mean(ql).”



2

Installing and Updating R

Stata and R are somewhat similar in that both are modular. Each comes with
a single “binary” executable file and a large number of individual functions or
commands. These are text files that users can modify in a text editor. Both
applications come with their own built-in text editors, and both allow the use
of outside text editors as well.

The binary executable files that come with R and Stata have been compiled
from the “source code” version that was written using C. When you install
R, you download the executable together with a set of add-on modules called
packages.

These are different from Stata’s ado files, which are single-purpose com-
mands or functions. R packages contain a number of related functions that
can be used for data management, graphics, or statistical analysis.

After the installation of the group of main R packages, a user may install
other packages later when they are needed. There are over 3,000 packages to
choose from. It is highly unlikely that someone would need them all.

The Comprehensive R Archive Networks (CRAN), located at http://
cran.r-project.org/, is R’s equivalent to Stata’s Statistical Software Com-
ponents (SSC) Archive. The most important difference between the two
archives is that CRAN is where you obtain R itself. The SSC contains only
add-ons to Stata, of course.

To download R, go to the CRAN link above, choose your operating system
under the web page heading Download and Install R. The binary versions
install quickly and easily. Binary versions exist for many operating systems,
including Windows, Mac OS X, and popular versions of Linux such as Ubuntu,
RedHat, Suse, and others that use either the RPM or APT installers.

Since R is an Open Source project, there are also source code versions of R
for experienced programmers who prefer to compile their own copy. Using that
version, you can modify R in any way you like. Although R’s developers write
most of the analytic commands using the R language, they use other languages
such as C and FORTRAN to write the most fundamental R, functions.

R.A. Muenchen, J.M. Hilbe, R for Stata Users, Statistics 9
and Computing, DOI 10.1007/978-1-4419-1318-0_2,
(© Springer Science+Business Media, LLC 2010
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Each version of R installs into its own directory (folder), so there is no
problem having multiple versions installed on your computer. You can then
install your favorite packages for the new release.

2.1 Installing Add-on Packages

While the main installation of R contains many useful functions, many addi-
tional packages, written by R users, are available on the Internet. The main
site for additional packages is at the CRAN web site under Packages. The
equivalent to Stata’s Statistical Software Components (SSC) Archive, CRAN
is the best place to read about and choose packages to install. You usually do
not need to download them from there yourself. R automates the download
and installation process.

Before installing packages, your computer account should have adminis-
trative privileges and you must start R in a manner that allows administrative
control. If you do not have administrative privileges on your computer, you can
install packages to a directory to which you have write access. For instructions,
see the FAQ (Frequently Asked Questions) at http://www.r-project.org/.

To start R with administrative control on Windows Vista and Windows 7,
right-click its menu choice and then choose Run as administrator. Window’s
User Account Control will then ask for your permission to allow R to modify
your computer.

On the R version for Microsoft Windows, you can choose Packages> Install
package(s) from the menus. It will ask you to choose a CRAN site or “mirror”
that is close to you; see Fig. 2.1, left. Then it will ask which package you wish
to install (right). Choose one of each and click OK.

If you prefer to use a function instead of the menus, you can use the
install.packages function. This is just like Stata’s ssc install command.
For example, to download and install Frank Harrell’s Hnisc package [14], start
R and enter this function call:

install.packages("Hmisc", dependencies=TRUE)

The argument dependencies=TRUE tells R to install any packages that
this package “depends” on and those that its author “suggests” as useful. R
will then prompt you to choose the closest mirror site and the package you
need.

2.2 Loading an Add-on Package

Once installed, a package is on your computer’s hard drive but not quite ready
to use. Each time you start R, you also have to load the package from the
library before you can use it. You can see what packages are installed and
ready to load with the library function.
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China A~ aaMl -~

Croatia W abind =

Denmark AcceptanceSampling =

France (Toulouse) accuracy

France (Lyon) acepack
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Iran . AdaptFit

Ireland ade4

Italy (Milano) adedTkGUI

Italy (Padua) adegenet
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Japan (Aizu) adimpro
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[ ok || cancel | [ ok || cancel |

Fig. 2.1. When installing software, you first choose a mirror site (left). Then the
next window appears, from which you choose the package you need (right).
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R packages available

Packages in library 'C:/PROGRA~1/R/R-2B~1.1/libracry":

base The R Base Package

boot Bootstrap R (S5-Plus) Functions (Canty)

class Functions for Classification

cluster Cluster Analysis Extended Rousseeuw et al.

codetools Code Analysis Tools for R

datasets The R Datasets Package

foreign Read Data Stored by Minitab, 8, SAS, SPSs§

gdata Various R programming tools for data mani§

ggplot2 An implementation of the Grammar of Graph$

gmodels Various R programming tools for model fit§

graphics The R Graphics Package

grDevices The R Graphics Devices and Support for Co$

grid The Grid Graphics Package

gtools Various R programming tools

hexbin Hexagonal Binning Routines

Hmisc Harrell Miscellaneous

KernSmooth Functions for kernel smoothing for Wand &5

lattice Lattice Graphics

MASS Main Package of Venables and Ripley's MASS
b

< >

Fig. 2.2. The library function shows you the packages that are installed and are
ready to load.

library()

That causes the window in Fig. 2.2 to appear, showing the packages you
have installed. The similar installed.packages function lists your installed
packages along with the version and location of each.

You can then load a package you need with the menu selection, Packages
> Load packages. It will show you the names of all packages that you have
installed but have not yet loaded. You can then choose one from the list.

Alternatively, you can use the library function. Here I am loading the
Hmisc package. Since the Linux version lacks menus, this function is the only
way to load packages.

library ("Hmisc")

Many packages load without any messages; you will just see the “>” prompt
again. When trying to load a package, you may see the error message below. It
means you have either mistyped the package name (remember capitalization
is important) or you have not installed the package before trying to load it.
In this case, Jim Lemon and Philippe Grosjean’s prettyR package [30] name
is typed accurately, so we have not yet installed it.

> library("prettyR")

Error in library(prettyR)
there is no package called ’prettyR’
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To see what packages you have loaded, use the search function.

> search()

[1] ".GlobalEnv" "package:Hmisc"

[3] "package:stats" "package:graphics"
[5] "package:grDevices" "package:utils"
[7] "package:datasets" "package:methods"
[9] "Autoloads" "package:base"

We will discuss this function in detail in Chapter 13, “Managing Your Files
and Workspace.”

Since there are so many packages written by users, two packages will oc-
casionally have functions with the same name. That can be very confusing
until you realize what is happening. For example, the Hmisc and prettyR
packages both have a describe function that does similar things. In such a
case, the package you load last will mask the function(s) in the package you
loaded earlier. For example, we loaded the Hmisc package first, and now we
am loading the prettyR package (having installed it in the meantime). The
following message results:

> library("prettyR")

Attaching package: ’prettyR’
The following object(s) are masked from package:Hmisc :
describe

You can avoid such conflicts by detaching each package as soon as you
are done using it by using the detach function. For example, the following
function call will detach the prettyR package:

detach("package:prettyR")

One approach that avoids conflicts is to load a package from the library
right before using it and then detach it immediately as in the following
example:

> library("Hmisc")
> describe(mydata)

—---output would appear here---
> detach("package:Hmisc")

If your favorite packages do not conflict with one anther, you can have R
load them each time you start R by putting the function calls in a file named
“ Rprofile.” That file can automate your settings just like the profile.do file
for Stata. For details, see Appendix C.
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2.3 Updating Your Installation

While Stata is configured to check for updates over the Internet every 7 days,
in R you must tell it to check using the update.packages function.

> update.packages()

graph :
Version 1.15.6 installed in C:/PROGRA"1/R/R-2671.1/library
Version 1.16.1 available at
http://rh-mirror.linux.iastate.edu/CRAN
Update (y/N/c)? y

WU, M

R will ask you if you want to update each package. If you enter “y,” it will
do it and show you the following. This message, repeated for each package,
tells you what file it is getting from the mirror you requested (Iowa State)
and where it placed the file.

trying URL ’http://rh-mirror.linux.iastate.edu
/CRAN/bin/windows/contrib/2.6/graph_1.16.1.zip’

Content type ’application/zip’ length 870777 bytes (850 Kb)

opened URL

downloaded 850 Kb

This next message tells you that the file was checked for errors (its sums
were checked) and it says where it stored the file. As long as you see no error
messages, the update is complete.

package ’graph’ successfully unpacked and MD5 sums checked

The downloaded packages are in
C:/Documents and Settings/muenchen/Local Settings/
Temp/Rtmpgf4C4B/downloaded_packages
updating HTML package descriptions

Moving to a whole new version of R is not as easy. First, you download
and install the new version just like you did the first one. Multiple versions
can coexist on the same computer. You can even run them at the same time if
you wanted to compare results across versions. When you install a new version
of R, you also have to install any add-on packages again. You can do that in
a step-by-step fashion as we discussed above. An easier way is to define a
character variable like “myPackages” that contains the names of the packages
you use. The following is an example that uses this approach to install all of
the packages we use in this book.

myPackages <- c("car","foreign","hexbin",
"ggplot2","gmodels","gplots", "Hmisc",
"lattice", "reshape","ggplot2","prettyR","Rcmdr")

install.packages (myPackages, dependencies=TRUE)
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We will discuss the details of the ¢ function used above later. We will also
discuss how to store programs like this so you can open and execute them
again in the future.

You can automate the creation of myPackages (or whatever name you
choose to store your package names) by placing the code that defines it in
your .Rprofile. Putting it there will ensure that myPackages is defined every
time you start R. As you find new packages to install, you can add to the
definition of myPackages. Then installing all of them when a new version of R
comes out is easy. Of course, you do not want to place the install.packages
function into your .Rprofile. There is no point in installing package every time
you start R! For details, see Appendix C.

2.4 Uninstalling R

When you get a new version of any software package, it is good to keep the
old one around for a while in case any bugs show up in the new one. Once
you are confident that you will no longer need an older version of R, you can
remove it.

On Microsoft Windows, R does not have an uninstaller accessible from
the usual Windows Add or Remove Programs control panel. Instead, you can
choose Start>Programs>R, Uninstall R z.x.z, where x.xx.x is the version of
R you are using. That menu choice runs the uninstall program, unins000.exe.
That program will remove R and any packages you have installed. That file
is located in the folder c:/program files/R/R x.x.x/.

To uninstall R on the Macintosh, simply drag the application to the trash.

Linux users can uninstall R by deleting /usr/local/lib/R.

Although it is rarely necessary to uninstall a single package, you can do so
with the uninstall.packages function. First though, you must make sure it
is not in use by detaching it. For example, to remove just the Hnisc package,
use the following:

detach("package:Hmisc") #If it is loaded.

remove.packages ("Hmisc")

Recall that R uses “#” to begin comments, so “#If it is loaded.” is just a
comment to document the program.

2.5 Choosing Repositories

While most R packages are stored at the CRAN site, there are other repos-
itories. If the Packages window does not list the one you need, you may
need to choose another repository. Several repositories are associated with
the BioConductor project. As they say at their main web site, “BioConductor
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is an open source and open development software project for the analysis and
comprehension of genomic data [16].” Another repository is at the Omegahat
Project for Statistical Computing [48],

To choose your repositories, choose Packages>Select repositories. .. or en-
ter the following function call and the Repositories selection window will ap-
pear (Fig. 2.3). Note that two CRAN repositories are selected by default. Your
operating system’s usual mouse commands work as usual to make contiguous
or noncontiguous selections. On Microsoft Windows, that is Shift-click and
Ctrl-click, respectively.

> setRepositories()

If you are working without a windowing system, R will prompt you to
enter the number(s) of the repositories you need.

--- Please select repositories for use in this session ---
1: + CRAN

2: + CRAN (extras)
3: Omegahat

4: BioC software
5: BioC annotation
6 BioC experiment
7 BioC extra

Enter one or more numbers separated by spaces
1: 1,2,4

Repositories

CRAN

CRAN (extras)
Omegahat

BioC software
BioC annotation
BioC experiment
BioC extra

OK Cancel

Fig. 2.3. Selecting repositories will determine which add-on packages R will offer
to install.
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2.6 Accessing Data in Packages

You can get a list of data sets available in each loaded package with the data
function. A window listing the default data sets will appear (Fig. 2.4).

> data()

R data sets = D'x'
Data sets in package ‘datasets’: &
AirPassengers Monthly Airline Passenger Numbers 1949-1960
BJsales Sales Data with Leading Indicator
Bisales.lead (BJsales) Sales Data with Leading Indicator
BOD Biochemical Oxygen Demand
co2 Carbon Dioxide uptake in grass plants
ChickwWeight Weight versus age of chicks on different di§
DNase Elisa assay of DNase
EuStockMarckets Daily Closing Prices of Major European Stoc$
Formaldehyde Determination of Formaldehyde
HairEyeColor Hair and Eye Color of Statistics Students
HarmanZ3.cor Harman Example 2.3
Harman74.cor Harman Example 7.4
Indometh Pharmacokinetics of Indomethicin
InsectSprays Effectiveness of Insect Sprays
Johnsondohnson Quarterly Earnings per Johnson & Johnson Sh§
LakeHuron Level of Lake Huron 1875-1972
LifeCycleSavings Intercountry Life-Cycle Savings Data
Loblolly Growth of Loblolly pine trees
Nile Flow of the River Nile
Orange Growth of Orange Trees
OrchardSprays Potency of Orchard Sprays
PlantGrowth Results from an Experiment on Plant Growth
Puromycin Reaction velocity of an enzymatic reaction
< >

Fig. 2.4. The data function displays all of the practice data sets for the packages
you have loaded.

You can use these practice data sets directly. For example, to look at the
top of the CO2 file (capital letters C and O, not zero!), you can use the head
function.

> head(C02)

Plant Type Treatment conc uptake
Qnl Quebec nonchilled 95 16.0
Qni1 Quebec nonchilled 175 30.4
Qnl1 Quebec nonchilled 250 34.8
Qnl Quebec nonchilled 350 37.2
Qnl Quebec nonchilled 500 35.3
Qnl1 Quebec nonchilled 675 39.2

o O W N

The similar tail function shows you the bottom few observations.
If you only want a list of data sets in a particular package, you can use the
package argument. For example, if you have installed the car package [12]
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(from John Fox’s Companion to Applied Regression book), you can load it
from the library and see the data sets only it has (Fig. 2.5) with the following
statements. Recall that R is case sensitive, so using a lowercase “un” would

not work.

> library("car")
> data(package="car")
> head (UN)

infant.mortality gdp

Afghanistan
Albania
Algeria
American.Samoa
Andorra
Angola

R data sets

Data sets in package ‘car’:

Rdler
Angell
Anscombe
Eaumann
Efox
Blackmoor
Burt
Can.pop
Chile
Chirot
Cowles
Davis
DavisThin
Duncan
Erickaen
Florida
Freedman
Friendly
Ginzberg
Greans
Guyer
Hartnagel
Leinhardt
Mandel
Migeation
Moote
Mroz
OBrienkaiser

154 2848
32 863
44 1531
11 NA
NA NA

124 355

Experimenter Expectations

Moral Integration of Amecican Cities

U. 5. State Public-School Expenditures

Methods of Teaching Reading Comprehension
Canadian Women's Labour-Force Participation
Exercise Histories of Eating-Disordered and Control Subjects
Fraudulent Data on IQs of Twins Raised Apart
Canadian Population Data

Voting Intentions in the 1988 Chilean Plebiscite
The 1907 Romanian Peasant Rebellion

Cowles and Davis's Data on Volunteering
Self-Reports of Height and Weight

Davis's Data on Drive for Thinness

Duncan's Occupational Prestige Data

The 1980 U.5. Census Undercount

Florida County Voting

Crowding and Crcime in U. 5. Metropolitan Areas
Format Effects on Recall

Data on Depression

Refuges Appeals

Anonymity and Cooperation

canadian Crime-Rates Time Series

Data on Infant-Moctality

Contrived Collinear Data

Canadian Intecprovincial Migration Data
Status, Authoritacianism, and Conformity

U.5. Women's Labor-Force Pacticipation

©'Brien and Kaiser's Repeated-Measures Data

Fig. 2.5. Display of data sets in the car package.

To see all of the data sets available in all installed packages, even those
not loaded from the library, enter the following function call:

data( package=.packages( all.available=TRUE ) )
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Running R

There are several ways you can run R:

Interactively using its programming language. You can see the result of
each function call immediately after you submit it.

Interactively using one of several graphical user interfaces (GUIs) that
you can add on to R. Some of these use programming and some use menus
much like Stata.

Noninteractively in batch mode using its programming language. You enter
your program into a file and run it all at once.

You can ease your way into R by continuing to use Stata or your favorite

spreadsheet program to enter and manage your data and then use one of the
methods below to import and analyze it. As you find errors in your data (and
you know you will), you can go back to your other software, correct them,
and then import it again. It is not an ideal way to work, but it does get you
into R quickly.

3.1 Running R Interactively on Windows

You can run R programs interactively in several steps:

1. Start R by choosing Start>All Programs>R>R z.x.x (where x.x.x is the

version of R you are using). The main R Console window will appear
looking like the left window in Fig. 3.1. Then enter your program choosing
one of the methods described in steps 2 and 3 below.

. Enter R functions into the R console. You can enter function calls into

the console one line at a time at the “>” prompt. R will execute each line
when you press the Enter key. If you enter them into the console, you can
retrieve them with the up arrow key and edit them to run again. We find
it much easier to use the program editor described in the next step.

R.A. Muenchen, J.M. Hilbe, R for Stata Users, Statistics 19
and Computing, DOI 10.1007/978-1-4419-1318-0_3,
(© Springer Science+Business Media, LLC 2010
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RGui

File Edit Packages Windows Help
EoEED) |

>

R Console = [0 [ L:\R for SAS & SPSS - Files...| - | O X

mydata <- read.table("mydata.tab”) # R Program to Read Delimited Text Files,

> mydata setwd ("/myRfolder™)

1
2
3
q
5
6
7
8

workshop gender gl gq
1

£
w
a8

# Read a tab delimited file with un-named ID column.
Imydata <- read.table("mydata.tab")
mydata

2

# Read a Comma Separated Value (CSV) file.
mydata <- read.table{"mydata.csv", header=TRUE,

sep=",", row.names="id", na.stringss" ")
mydata

P T S T
e N T ]
waunnEsan

# Read it again with read.csv.
mydata <- read.csv("mydata.csv",

row.names="id", na.strings=" ")
Imydata

: # Now use colClasses to skip gl and q2 with NULL.

Fig. 3.1. R graphical user interface on Microsoft Windows.

If you type the beginning of an R function, such as “me” and press Tab,
R will show you all of the R functions that begin with those letters, such
as mean or median. If you enter the name of a function and an open
parenthesis, such as “mean(,” R will show you the arguments that you
can use with that function.

Enter R functions into the R Editor. Open the R Editor by choosing
File>New Script. You can see it in the bottom right corner of Fig. 6.1.
You can enter programs as you would in the Stata commandline.

Submit your program from the R Editor. To submit just the current line,
you can hold the Ctrl key down and press “r,” for run, or choose Edit>Run
line or selection. To run a block of lines, select them first and then submit
them the same way. To run the whole program, choose Edit>Run All.
As you submit program statements, they will appear in the R Console
along with results and/or error messages. Make any changes you need and
submit the program again until finished. You can clear the console results
by choosing FEdit>Clear console or by holding the Ctrl key down and
pressing “l” (i.e. CTRL-1). See Help> Console for more keyboard shortcuts.
Save your program and output. Click on either the console window or the
R Editor window to make it active and choose File>Save to file. Unlike
in Stata, the console output will contain the commands and their output
blended together.

Save your data and any functions you may have written. The data and/or
function(s) you created are stored in an area called your workspace. You
can save that with the menu selection, File>Save Workspace. ... In a later
R session you can retrieve it with File>Load Workspace. ... You can also
save your workspace using the save.image function:
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save.image (file="myWorkspace.RData")
Later, you can read the workspace back in with the function call:
load("myWorkspace.RData")

For details, see Chapter 13, “Managing Your Files and Workspace.”

8. Optionally save your history. R has a history file that saves all of the
function calls you submit in a given session. This is just like the Stata log
menu. Unlike Stata, however, the history of the past function calls is not
cumulative on Windows computers. You can save the session history to
a file using File>Save History... and you can load it into future session
with File>Load History. ... There are also various R functions to do these
tasks.

savehistory(file="myHistory.Rhistory")
loadhistory(file="myHistory.Rhistory")

Note that the filename can be anything you like, but the extension should
be “.Rhistory.” In fact the entire filename will be simply “.Rhistory” if
you do not provide one. We prefer to always save a cumulative history file
automatically. For details, see Appendix C.

9. To quit R, choose File> Ezit or submit the function quit () or just g(). R
offers to save your workspace automatically on exit. If you are using the
save.image and load functions to tell R where to save and retrieve your
workspace in step 4 above, you can answer No. If you answer Yes, it will
save your work in the file “. RData” in your default working directory. Next
time you start R, it will load the contents of the .RData file automatically.
Creating a .RData file this way is a convenient way to work. However, we
prefer naming each project ourselves as described in step 4 above.

3.2 Running R Interactively on Macintosh

Like Stata, R programs run interactively on the Macintosh. R does so in
several steps.

1. Start R by choosing R in the Applications folder. The R console win-
dow will appear (see left window in Fig. 3.2). Then enter your program
choosing one of the methods described in steps 2 and 3 below.

2. Enter R functions in the console window. You can enter function calls
into the console one line at a time at the “>” prompt. R will execute each
line when you press the Enter key. If you enter them into the console,
you can retrieve them with the up arrow key and edit them to run again.
We find it much easier to use the program editor described in the next
step. If you type “me” at the command prompt and press Tab or hold
the Command key down and press “.” (i.e., CTRL-period), R will show
you all of the R functions that begin with those letters, such as mean or
median. When you type a whole function name, the functions arguments
will appear below it in the console window.
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Fig. 3.2. R graphical user interface on Macintosh.

3. Enter R functions into the R Editor. Open the R Editor by choosing
File>New Document. The R Editor will start with an empty window.
You can see it in the center of Fig. 3.2. You can enter R programs as you
would on the Stata command line or write do or ado files in the Stata
editor.

4. Submit your program from the R Editor. To submit one or more lines,
highlight them, then hold the Command key, and press Return, or choose
Edit> Ezecute. To run the whole program, select it by holding down the
Command key and pressing “a,” and then choose Edit> Ezecute.

5. As your submit program statements, they will appear in the R Console
along with results and/or error messages. Make any changes you need and
submit the program again until finished.

6. Save your program and output. Click on a window to make it the active
window and choose File>Save to file. The function calls and their output
are blended together, unlike Stata.

7. Save your data and any functions you may have written. The data and/or

function(s) you created are stored in an area called your workspace. You
can save your workspace with Workspace>Save Workspace File. ... In
a later R session you can retrieve it with Workspace>Load Workspace
File.... You can also perform these functions using the R functions
save.image and load.

save.image(file="myWorkspace.RData")

load ("myWorkspace.RData")

For details, see Chapter 13, “Managing Your Files and Workspace.”
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8. Optionally save your history. R has a history file that saves all of the
functions you submit in a given session (and not the output). This is just
like the Stata log menu. The history file is not cumulative on Macintosh
computers. You can view your history by clicking on the Show/Hide R
command history icon in the console window (to the right of the lock
icon). You can see the command history window on the right side of
Fig. 3.2. Notice that it has alternating stripes, matching its icon. Clicking
the icon once makes the history window slide out to the right of the
console. Clicking it again causes it to slide back and disappear. You can
see the various buttons at the bottom of the history, such as Save History
or Load History. You can use them to save your history or load it from a
previous session. You can also use R functions to do these tasks.

savehistory(file="myHistory.Rhistory")

loadhistory(file="myHistory.Rhistory")

The filename can be anything you like, but the extension should be “.Rhis-
tory.” In fact the entire filename will be simply “.Rhistory” if you do not
provide one. We prefer to always save a cumulative history file automati-
cally. For details, see Appendix C.

9. Exit R by choosing R>Quit R. Users of any operating system can quit
by submitting the function quit () or just q(). R will offer to save your
workspace automatically on exit. If you are using the save.image and
load functions to tell R where to save/retrieve your workspace in step 4
above, you can answer No. If you answer Yes, it will save your work in the
file “.RData” in your default working directory. Next time when you start
R, it will load the contents of the .RData file automatically. Creating a
.RData file this way is a convenient way to work. However, we recommend
naming each project yourself, as described in step 4 above.

3.3 Running R Interactively on Linux or UNIX

You can run R programs interactively in several steps.

1. Start R by entering the command “R,” which will bring up the “>”
prompt, where you enter commands. For a wide range of options, refer
to Appendix B , An Introduction to R [52], available at http://wuw.
r-project.org/ under Manuals, or in your R Help menu. You can enter
R functions using either of the methods described in steps 2 and 3 below.

2. Enter R functions into the console one line at a time at the “>” prompt.
R will execute each line when you press the Enter key. You can retrieve a
function call with the up arrow key and edit it, and then press Enter to
run again. You can include whole R programs from files with the source
function. For details, see Section 3.4, “Running Programs That Include
Other Programs.” If you type the beginning of an R function name like
“me” and press the Tab key, R will show you all of the R functions that
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begin with those letters, such as mean or median. If you type the function
name and an open parenthesis like “mean(” and press Tab, R will show
you the arguments you can use to control that function.

Enter R functions into a text editor. Although R for Linux or UNIX does
not come with its own GUI or program editor, a popular alternative is to
use the Emacs editor in ESS mode. It color-codes your programs to help
find syntax errors. You can submit your programs directly from Emacs to
R. See the R FAQ at http://wuww.r-project.org/ under R for Emacs
for details.

Save your program and output. Linux or UNIX users can route input and
output to a file with the sink function. You must specify it in advance of
any output you wish to save.

sink("myTranscript.txt", split=TRUE)

The argument split=TRUE tells R to display the text on the screen as
well as route it to the file. The file will contain a transcript of your work.
The function calls and their output are blended together, unlike Stata.
Save your data and any functions you may have written. The data and/or
function(s) you created are stored in an area called your workspace. Users
of any operating system can save it by calling the save.image function.

save.image (file="myWorkspace.RData")
Later, you can read the workspace back in with the function call
load ("myWorkspace.RData")

For details, see Chapter 13, “Managing Your Files and Workspace.”

R has a history file that saves all of the functions you submit in a given
session. This is just like the Stata log menu. The Linux/UNIX version of R
saves a cumulative set of function calls across sessions. You can also save
or load your history at any time with the savehistory and loadhistory
functions.

savehistory(file="myHistory.Rhistory")

loadhistory(file="myHistory.Rhistory")

Note that the filename can be anything you like, but the extension should
be “.Rhistory.” In fact the entire filename will be simply “.Rbhistory” if
you do not provide one.

Quit R by submitting the function quit() or just q(). R offers to save
your workspace automatically on exit. If you are using the save.image
and load functions to tell R where to save/retrieve your workspace in
step 4 above, you can answer No. If you answer Yes, it will save your
work in the file “.RData” in your default working directory. Next time
you start R, it will load the contents of the .RData file automatically.
Creating an .RData file this way is a convenient way to work. However,
we prefer naming each project ourselves as described in step 4 above.
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3.4 Running Programs That Include Other Programs

When you find yourself using the same block of code repeatedly in different
programs, it makes sense to save it to a file and include it into the other
programs where it is needed. Stata does this using a global constant, where
the program code is assigned a unique name and recalled into the program
code by giving the constant with a leading dollar sign. To include a program
in R, use the source function

source ("myprog.R")

One catch to keep in mind is that by default R will not display any results
that sourced files may have created. Of course, any objects they create —
data, functions, and so forth — will be available to the program code that
follows. If the program you source creates actual output that you want to see,
you can source the program in the following manner:

source ("myprog.R", echo=TRUE)

This will show you all of the output created by the program. If you prefer
to see only some results, you can wrap the print function around only those
functions whose output you do want displayed. For example, if you sourced
the following R program, it would display the standard deviation, but not the
mean:

x <- c(1, 2, 3, 4, 5)
mean (x) # This result will not display.
print( sd(x) ) # This one will.

An alternative to using the source function is to create your own R pack-
age. However, that is beyond the scope of this book.

3.5 Running R in Batch Mode

You can write a program to a file and run it all at once, routing its results to
another file (or files). This is called batch processing. If you had a program
named myprog.do, you would run it with the following command:

"C:\Program Files\StatalO\wstata" /b do myprog.do

Stata would run the program and place the results into a log file called
myprog.log.

In R, you can find the details of running batch on your operating system
by starting R and entering the following command. Note that the letters of
BATCH must be all uppercase.
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help (BATCH)

The following operating system command is an example of running an
R batch job on Microsoft Windows. You will need to change the path of
Rterm.exe to reflect its location on your computer and fill in your version in
place of x.x.x.

"C:\Program Files\R\R-x.x.x\bin\Rterm.exe"
--no-restore --no-save < myprog.r > myprog.out

The command wraps to two lines in this book, but enter it as a single
line. It is too long to fit in a standard cmd.exe window, so you will need to
change its default width from 80 to something wider, like 132. R will execute
myprog.r and write the results to myprog.out.

It is easier to write a small batch file like myR.bat.

"G:\Program Files\R\R-x.x.x\bin\Rterm.exe"
--no-restore --no-save < %1 > %1.Rout 2>&1

Once you have saved that in the file myR.bat, you can then submit
batch programs with the following command. It will route your results to
myprog.Rout. You can also download this batch file with this book’s example
programs and data sets at http://r4stats.com.

myR myprog.R

UNIX users can run a batch program with the following command. It, too,
will write your output to myprog.Rout.

R CMD BATCH myprog.R

There are, of course, many options to give you more control over how your
batch programs run. See the help file for details.

3.6 Graphical User Interfaces

The main R installation provides an interface to help you enter programs. It
does not include a point-and-click graphical user interface (GUI) for running
analyses. There are, however, several GUIs written by R users. You can learn
about several at the main R web site, http://www.r-project.org/ under
Related Projects and then R GUlIs.

3.6.1 R Commander

Our favorite GUI for general statistical analysis is John Fox’s R Commander
[13], which is similar to the Stata GUI. It provides menus for many analytic
and graphical methods and shows you the R function calls that it enters,
making it easy to learn to program in R as you use it. Since it does not
come with the main R installation, you have to install it one time with the
install.packages function.
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install.packages("Rcmdr", dependencies=TRUE)

R Commander uses many other packages, and R will download and install
them for you if you use the dependencies=TRUE argument.

Let us review the steps of a basic R Commander session. Below are the
steps we followed to create the screen image you see in Fig. 3.3 .

1. We started R. For details see the section “Running R Interactively on
Windows,” or similarly named sections for other operating systems pre-
viously covered in this chapter.

2. Then, from within R itself we started R Commander by loading its package
from the library. That brought up the window that looks something like
Fig. 3.3.

library("Rcmdr")

R Commander
File Edit Data Statistics Graphs Models Distributions Tools Help

R, Data set: <No active dataset> | Edit data set [View data set| Model: <No active model>
Script Window

Output Window :

Messages

NOTE: R Commander Version 1.3-15: Mon Aug 04 08:51:15 Z008

Fig. 3.3. The R Commander GUI, before any work is done.

3. We then chose Data>Load a data set and browsed to myRfolder, where
our practice data sets are stored. We had to tell it to look for All Files
because by default it looks for .RDA file types and ours are .RData. We
then chose the file mydata.RData. R Commander uses a different file
extension because it is unable to deal with more than one data set at
a time. Since mydata.RData contains only one data set, it works fine.

4. We next click on the View data set button in order to view the data. Then
the data appeared, as shown in Fig. 3.4.

5. We then chose Statistics>Summaries> Active Data Set. The output you
see on the bottom of the screen in Fig. 3.5.



28 3 Running R

Fig. 3.4. R Commander’s Data Viewer window that appears when you click the
View data set button.

R Commander

File Edit Data BSIE[5:{N Graphs Models Distributions Tools Help
R, Dataset: myd Summaries * |data set| Model:  <No active model>
| | . » : e |
Script Window. | Contingency tables .
showbata (nydata, MRS d Single-sample t-test... T
lsummary (mydata) Proportions ¥ Independent samples t-test...
| Variances »  Paired t-test...
Nonparametric tests *  One-way ANOVA...
| Dimensional analysis *  Multi-way ANOVA...
Fit models |
< >
Output Window [Sma}
!> summary (mydata) '_ﬁ'
| workshop gender ql q2 q3
| Min. :11.0 f 13 Min 1.00 Min. :1.00 Min. :2.000
| 1st Qu.:1.0 m :4 1st Qu.:2.00 1st Qu.:1.00 1st Qu.:4.000
Median :1.5 NA's:1 Median :3.50 Median :2.50 Median :4.000 L8
| Mean 1.5 Mean :3.25 Mean :2.75 Mean :4.143
3rd Qu.:2.0 3rd Qu.:4.25 3rd Qu.:4.25 3rd Qu.:5.000
| Max :2.0 Max. :5.00 Max. :5.00 Max. :5.000 .
| NA's  :1.000 W
Messages
: The dataset mydata has 8 rows and 6 columns. -
b

Fig. 3.5. The R Commander GUI with work in progress.
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6. Finally, we chose Statistics>Means.... You see that the menu is still

open, showing that we can choose various t-tests and analysis of variance
(ANOVA) procedures.

You can learn more about R Commander at http://cran.r-project.
org, under Packages.

3.6.2 Rattle for Data Mining

Graham William’s Rattle package [57] provides a tabbed-dialog box style of
user interface. Although its emphasis is on data mining, the interface is useful
for standard statistical analyses as well. Its name stands for the R analytical
tool to learn easily. That name fits it well, as it is very easy to learn. Its
point-and-click interface writes and executes R programs for you.

Before you install the rattle package, you must install some other tools.
See the web site for directions http://rattle.togaware.com. Once it is in-
stalled, you load it from your library in the usual way.

> library("rattle")

Rattle, Graphical interface for data mining
using R, Version 2.2.64.

Copyright (C) 2007 Graham.Williams@togaware.com, GPL

Type "rattle()" to shake, rattle, and roll your data.

As the instructions tell you, simply enter the call to the rattle function
to bring up its interface.

> rattle()

The main Rattle interface shown in Fig. 3.6 will then appear. It shows
the steps it uses to do an analysis on the tabs at the top of its window. You
move from left to right, clicking on each tab to do the following steps:

1. Data. Choose your data type from a Comma Separated Value (CSV) file,
Attribute Relation File Format (ARFF), Open DataBase Connectivity
(ODBC), .RData file, R data object already loaded or created before
starting Rattle, or even manual data entry.

2. Select. Choose your variables and the roles they play in the analysis. In
Fig. 3.6 we have chosen gender as the target variable (dependent variable)
and the other variables as inputs (independent variables or predictors).

3. Explore. Examine the variables using summary statistics, distributions,
interactive visualization via GGobi [47], correlation, hierarchical cluster
analysis of variables, and principal components. A very interesting feature
in distribution analysis is the application of Benford’s law, an examination
of the initial digits of data values that people use to detect fraudulent data
(e.g., faked expense account values)
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R Data Miner - [Rattle (mydata)]

Project Edit Tools Settings Help 0 Rattle Version 2.3.65 togaware.com
@ 8] =} [w] < a
Execute  New Open Save @ Export Quit

Data 'Explore Transform Cluster| Associate Model Evaluate Log
Type: ©OCSV File © ARFF ® R Dataset O Library © RData File © ODBC

Data Name: \mydata 3

OSample Percentage: |
@Input @Ignore Weight Calculator: Target: @ Auto © Categoric © Numeric
No. Variable Data Type Input Target Rlsk Ident Ignore Comment
1  workshop Numeric # : Unigue: 2
gender Categoric 2 c Missing: 1
3 g1 Numeric = ( - Unique: 5
4 q2 Numeric = ) C - Unique: 5
5 g3 Numeric = a = - Missing: 1 Unigue: 4
6 g4 Numeric - e = . Unique: 4

Variable roles noted. There are 5 input variables. Target ks gender reated as a Categoric 2 for classification.

Fig. 3.6. Rattle GUI for data mining.

4. Transform. Replace missing values with reasonable estimates (imputa-
tion), convert variables to factors, or look for outliers.

5. Model. Apply models from tree, boost, forest, SVM, regression, or all.

6. Evaluate. Assess model quality and compare different models using con-
fusion tables, lift charts, ROC curves, and so forth.

7. Log. See the R program that Rattle wrote for you to do all of the steps.

Figure 3.7 shows an R program that Rattle wrote when asked for box plots
of my data (box plots not shown).

3.6.3 JGR Java GUI for R

The Java GUI for R, JGR [20] (pronounced “jaguar”), is very similar to R’s
own simple interface, making it very easy to learn. Written by Markus Helbig,
Simon Urbanek, and Martin Theus, JGR provides some very helpful additions
to R, like syntax checking in its program editor. It also provides the help files
in a way that lets you execute any part of an example you select. That is very
helpful when trying to understand a complicated example.

JGR is installed differently than most R packages. On Microsoft Windows
or Apple Macintosh, you download two programs: an installer and a launcher.
Running the installer installs JGR and double-clicking the launcher starts it
up. The JGR web site that contains both programs is http://rosuda.org/
JGR/.

Linux users follow slightly different steps that are described at the site.
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R Data Miner - [Rattle (mydata)] = [ X
Project Edit Tools Settings Help © Rattle Version 2.3.65 togaware.com
@ D (=] @ <1 a
Evecut= | New  Open Save | Export = Quit

Data | Explore| Transform | Cluster| Associate Model Evaluabe_a_

# Rattle timestamp: 2008-08-04 10:34:09

# BOX PLOT

# Generate just the data for a boxplot of q1.

ids <- rbind(data.frame(dat=crs¢dataset[,][,"q1"], grp="All"),
data.frame(dat=crs$dataset[,][crs$datasetégender=="f","q1"], grp="f"),
data.frame(dat=crs$dataset[,][crs$datasetégender=="m","q1"], grp="m"))

# Plot the data, grouped appropriately.

|bp <- boxplot(dat ~ grp, ds, col=rainbow(3), xlab="gender", notch=TRUE)

# Use the doBy package to group the data for means. bl

Fig. 3.7. An R program written by Rattle to do a box plot.

We started JGR by double-clicking on its launcher and opened an R pro-
gram using File>Open Document. You can see the program in Fig. 3.8. Note
that the JGR program editor has automatically color-coded my comments,
function names, and arguments, making it much easier to spot errors. In the
printed version of this book those colors are displayed as shades of gray.

BL:\R for SAS & SPSS - Files\Programs\ReadDelimited. R _ o B2

File Edit Tools Window Help Preferences About

02k 9 X080 O 8

i | A

2 # R Program to Read Delimited Text Files.

3 setwd ("/myRfolder")

4

5\ # Read a tab delimited file with un-named ID column.

6 mydata <- read.table("mydata.tab")

7 mydata

8

ON# Read a Comma Separated Value (CSV) file.

ib_:mydata <- read.table("mydata.csv", header=TRUE,

11 sep=",", row.names="id", na.strings=" ") v

< >
Modified 1:1

Fig. 3.8. Color-coded editor in JGR helps prevent typing errors.
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In the next example, we typed "cor (" into the bottom of the console area
shown in Fig. 3.9. JGR then displayed a box showing the various arguments
that control the cor function for doing correlations. That is very helpful when
you are learning!

M Console _ o B
File Edit Tools Packages Workspace Window Help Preferences About
UBE B XEE B X i
> mydata <- read.table("mydata.tab") L
> mydata
workshop gender ql g2 g3 g4
1 1 £ L O & &
2 2 £ 2 1 4 [
3 1 P 2 2 4 3
4 7 <NA> 3 1 NA 3
5 1 m 4 5 2 4
6 2 m 5 4 5 5
7 1 m S5 3 4 4
8 2 m 4 § 5 5 bl
e ( cor (%, y = NULL, use = "all.obs", method = c("pearson”, A
"kendall”, "spearman”)) !

Fig. 3.9. JGR showing arguments that you might choose for the cor function.

JGR’s Package Manager makes it easier to control which packages you are
using (Fig. 3.10). Simply checking the boxes under “loaded” will load those
packages from your library. If you also check it under “default,” JGR will load
them every time you start JGR. Without JGR’s help, automatically loading
packages would require editing your .Rprofile.

JGR’s Object Browser makes it easy to manage your workspace; see
Fig. 3.11. Selecting different tabs across the top enable you to see the different
types of objects in your workspace. We right-clicked on gender, which brought
up the box listing the number of males, females, and missing values (NAs). If
you have a list of models, you can sort them easily by various measures, like
their R-squared values.
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- Package Man... E‘ E‘

Window
load... defa... Package Description

v/ | | ggplot2 An implementation of the G... -ﬁ-

Ll | | gpclib General Polygon Clipping Li...

L | | gplots Various R programming too...

Ll | | graph graph: A package to handle...

o V| graphics The R Graphics Package

V| V| grDevices The R Graphics Devices and...

v grid The Grid Graphics Package =

L | | gridBase Integration of base and grid... ~—

Ll | | gtools Various R programming tools

Ll || gWidgets gWidgets API for building to...

il | | gwidgetsRGtk2 Toolkit implementation of g...

Ll | |  Hmisc Harrell Miscellaneous

v/ V| iplots iPlots - interactive graphics ...

Ll | Irregular Time Series

v/ V| JavaGD Java Graphics Device

e V| IJGR JGR - Java Gui for R

w4 || kernlab Kernel Methods Lab

L | | KernSmooth Functions for kernel smooth... .v
Refresh || Close |

Fig. 3.10. JGR’s Package Manager, which allows you to load packages from the
library on demand or at startup.

Double-clicking on a data frame in the Object Browser starts the Data
Table editor (Fig. 3.12), which is much nicer than the one built into R. It lets
you rename variables, search for values, sort by clicking on variable names,
cut and paste values, and add or delete rows or columns.

There are many more useful features in JGR that are described on its web
site.
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Object Browser

Window

Data Objects | Models | Other Objects | Functions|

Jdata
2 mydata (data.frame) dim(8:6)

- ® workshop factor levels 4
s Bcender (facto )
~® gl (numeric)
~® g2 (numeric) o
~® g3 (numeric)
~® g4 (numeric) 4 4
Save Data Refresh Close

Fig. 3.11. JGR’s Object Browser shows information about each object in your
workspace.
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B pataTable - mydata

File Edit Tools Window Help Preferences About

row.names = workshop  gender ql g2 g3 g4

I 0| i 1:0 1:0 B0 1.0
Y 2 £ e k.0 B [l
3 <! ;54 2.0 2.0 4.0 [3.0
4 g NA (3.0 1.0 NA 3.0
5 u m 4.0 5.0 2.0 (4.0
6 2 m 5.0 4.0 B.0 [5.0
7 i m 5.0 |3.0 [4.0 4.0
8 2 m 4.0 5.0 5.0 5.0

Fig. 3.12. JGR’s Data Table editor, an improvement over R’s primitive one.



4

Help and Documentation

4.1 Introduction

The full Stata package comes with 17 volumes of reference manuals. Both these
manuals and the Stata help files are well written and authoritative and their
style is consistent. They are of great help to beginners through advanced users.

R has an extensive array of help files and documentation. However, they
can be somewhat intimidating at first, since many of them assume you already
know a lot about R.

4.2 Help Files

To see how R’s help files differ in style from those of Stata, let us examine the
help file for the print function, which is similar to Stata’s 1ist command. The
help file in R says you can use the print function to “Print Values,” which is
clear enough. However, it then goes on to say that “print prints its argument
and returns it invisibly (via invisible(x)). It is a generic function which
means that new printing methods can be easily added for new classes.” That
requires a much higher level of knowledge than does the Stata description of
its similar command: “LIST displays case values for variables in the active
data set.” However, when you are done with this book, you should have no
problem understanding most help files.

4.3 Starting Help

You can start the help system by choosing Help>HTML Help on Windows
or Help>R Help on Macintosh. On any operating system you can submit the
help.start function in the R Console. That is the way Linux/UNIX users
start it since they lack menus.

R.A. Muenchen, J.M. Hilbe, R for Stata Users, Statistics 37
and Computing, DOI 10.1007/978-1-4419-1318-0.4,
(© Springer Science+Business Media, LLC 2010
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help.start()

Regardless of how you start it, you will get a help window that looks something
like Fig. 4.1

) The R Language - Mozilla Firefox
Be Ed Wew Htory Eockmaks Took Hep
= € X (L M PROGRA LR A28~ Lidontmiinde: hem +} e F.

Statistical Data Analysis

Manuals
AnJutroduction fo B The R Language Definition
Writing R Extensions R Installation and Administration
Jatn [inpost/Export R lidemals
Reference
Paskages Search Engine & Revwords

Miscellaneous Material

About B Authors Resources
License Frequently Asked Cuestions Thewiks
FAQ for Windows port
* Pt | omep & it & fredn o Honightd [ Mach case

Fig. 4.1. R’s main help window.

Similar to using Stata’s command, to get help for a certain function such
as summary, use the form

help(summary)
or prefix the topic with a question mark:
?summary

To get help on an operator, enclose it in quotes. For example, to get help
on the assignment operator (equivalent to the equal sign in Stata), enter

help( ngn )

If you do not know the name of a function or operator, use the help.search
function to search the help files. This is similar to Stata’s findit command.

help.search("your search string")

A shortcut to the help.search function is to prefix the term with two
question marks, “?7.” For a single word search, use this form:
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??7yourstring
For a string with more than one term in it, enclose it in quotes:
??"your multi-word string"

A particularly useful help file is the one on extracting and replacing parts
of an object. That help file is opened with the following function call. The
capital letter in Extract is necessary.

help(Extract)

It is best to read that one after you have read Chapter 9, “Selecting
Variables and Observations.”

4.4 Help Examples

Most of R’s help files include examples that will execute. You can cut and
paste them into a script window to submit in easily understood pieces. You
can also have R execute all of the examples at once with the example function.
Here are the examples for the mean function, but do not try to understand
them now. We will cover the mean function later.

> example (mean)

mean> x <- c(0:10, 50)

mean> xm <- mean(x)

mean> c(xm, mean(x, trim = 0.10))
[1] 8.75 5.50

mean> mean(USArrests, trim = 0.2)

Murder Assault UrbanPop Rape
7.42 167.60 66.20 20.16

R changes the prompt of each example function call from “>” to “mean>”
to let you know that it is still submitting examples from the mean function’s
help files. Note that when an example is labeled “Not run,” it means that
while it is good to study, it will not run unless you adapt it to your needs.

A very nice feature of the JGR graphical user interface is that you can
execute most help file example programs by submitting them directly from
the help window. You simply select the part you wish to run, right-click on
the selection, and then choose “run line or selection.” See Section 3.6.3, “JGR
Java GUI for R,” for details.
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Like Stata user-authorized commands, in R you must first install a package
and then load it from your library before you can get help. So you cannot use
help to find things that you do not already know something about.

A popular addition to R is Frank Harrell’s Hmisc package [14]. It has
many useful functions that add SAS-like capabilities to R. One of these is
the contents function. Let us try to get help on it before loading the Hmisc
package.

> help("contents")

No documentation for ’contents’ in specified packages
and libraries: you could try ’77contents’

The help system does not find it, but it does remind you how you might
search the help files. However, that search would find the contents function
only if the Hmisc package were already installed. If you did not already know
that Hmisc had such a function, you might search the Internet (or read a good
book!) to find it. Let us now load the Hmisc package from our library (after
having installed it in the the meantime).

> library("Hmisc")

R responds with a warning. We will discuss what this means later, but it
does not cause a problem now.

Attaching package: ’Hmisc’

The following object(s) are masked from package:base :
format.pval,
round.POSIXt,
trunc.P0OSIXt,
units

Now that the Hmisc package is loaded, we can get help on the contents
function with the function call help(contents). We do not need to look at
the actual help file at the moment. We will cover that function much later.

Now that Hmisc is loaded from the library, the help.search function can
find the contents function (see Fig. 4.2)

> help.search("contents")

4.5 Help for Functions That Call Other Functions

R has functions that exist to call other functions. These are called generic
functions. In many cases, the help file for the generic function will refer you
to those other functions, providing all of the help you need. However, in some
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-~
Help files with alias or concept or title matching ‘contents" using fuzzy matching:

Internal Hmisc functions

Metadata for a Data Frame
Determinations of Nickel Content
Protein content of cows' milk
Defunct Functions in Package utils

Hmisc::dataDensityString
Hmis=c::contents
MASS: : abbey

nlme: :Milk
utils::utils-defunct

Type '7?PKG::FO0' to inspect entry 'PEG::FOO TITLE'.

< ¥

Fig. 4.2. Help search results on the string “contents.”

cases you need to dig for such help in other ways. We will discuss this topic
in Chapter 5 Programming Language Basics, section 5.6.3, Controlling Func-
tions with an Object’s Class. We will also examine an example of this in
Chapter 15, “Traditional Graphics,” section 15.9.9, “Scatter Plot Matrices.”

4.6 Help for Packages

Thus far we have examined ways to get help about a specific function. You can
also get help on an entire package by using the help argument in the library
function. For example, the foreign package [7] helps you import data from
other software. You can get help on the packages itself with

> library(help=foreign)

The window in Fig. 4.3 is only a partial view of the information R provides.
To get help on a package, you must first install it, but you need not load it.

Documentation for package foreign’ -~ D x
“

Information on package 'foreign'
Description:
Package: foreign
Priority: recommended
Version: 0.8-29
Date: 2008-08-07
Title: Read Data Stored by Minitab, S, SAS, SPSS, Stata, Systat,$
Depends: R (>= 2.6.0), stats
Imports: methods, utils
Maintainer: R-core <R-core@r-project.org>
Author: R-core members, Saikat DebRoy <saikat@stat.wisc.edu>, Rog$

COPYRIGHTS file in the sources.
Description: Functions for reading and writing data stored by statisti$

Stata, Systat, ..., and for reading and writing .dbf (dBa$
LazyLoad: yes
License: GPL (>= 2)
Packaged: Thu Aug 7 16:41:12 2008; ripley
Built: R 2.8.1; i386-pc-mingw32; 2008-12-22 09:25:51; windows

L4

< »

Fig. 4.3. Help window for the foreign package.
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However, not all packages provide help for the whole package. Most do provide
help on the functions that the package contains.

4.7 Help for Data Sets

Unlike Stata, R has help files associated with data sets. If an R data set has
a help file associated with it, you can read it with the help function. For
example,

help(esoph)

will tell you that this is a data set is “Data from a case-control study of
(o)esophageal cancer in Ile-et-Vilaine, France.”

The rough equivalent to this in Stata is to place a label in a data set
using the label data command. This allows a short one-line description of
the data set.

4.8 Books and Manuals

Other books on R are available free at http://cran.r-project.org/ under
documentation. We will use a number of functions from the Hmisc package.
Its manual is An Introduction to S and the Hmisc and Design Libraries [1] by
Alzola and Harrell. It is available at http://biostat.mc.vanderbilt.edu/
twiki/pub/Main/RS/sintro.pdf. The most widely recommended advanced
statistics book on R is Modern Applied Statistics with S (abbreviated MASS)
by Venables and Ripley [51]. Note that R is almost identical to the S
language and books on S usually point out what the differences are. An ex-
cellent book on managing data in R is Phil Spector’s Data Manipulation
with R [44]. We will discuss books on graphics in the chapters on that
topic.

4.9 E-mail Lists

There are several different e-mail discussion lists regarding R that you can
read about and sign up for at http://www.r-project.org/ under mailing
lists. We recommend signing up for the one named R-help. There you can
learn a lot by reading answers to the myriad of questions people post there.
If you post your own questions on the list, you are likely to get an
answer in an hour or two. However, please read the posting guide, http://
www.R-project.org/posting-guide.html, before sending your first ques-
tion. Taking the time to write a clear and concise question and provid-
ing a descriptive subject line will encourage others to take the time to
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respond. Sending a small example that demonstrates your problem clearly
is particularly helpful. See Chapter 12, “Generating Data” for ways to make
up a small data set for that purpose. Also include the version of R you are
using and your operating system. You can generate all of the relevant details
using the sessionInfo function:

> sessionInfo()
R version 2.8.1 (2008-12-22)
1386-pc-mingw32

locale:
LC_COLLATE=English_United States.1252;LC_CTYPE=English_United...

attached base packages:
[1] stats graphics grDevices utils datasets methods base

loaded via a namespace (and not attached):
[1] tools_2.8.1

4.10 Searching the Web

Searching the Web for information on R using generic search engines such
as Google can be frustrating, since the letter R refers to many different
things. However, if you add the letter R to other keywords, it is surpris-
ingly effective. Adding the word “package” to your search will also narrow it
down.

An excellent site that searches just for R topics is Jonathon Barron’s
R Site Search at http://finzi.psych.upenn.edu/search.html. You can
search just the R site while in R itself by entering the RSiteSearch function

RSiteSearch("your search string")

or go to http://www.r-project.org/ and click search. If you use the Firefox
web browser, there is a free plug-in called RsiteSearch you can use. Download
it from http://addictedtor.free.fr/rsitesearch/.

4.11 Vignettes

Another kind of help is a vignette, a short description. People who write
packages can put anything into its vignette. The function call

vignette (all=TRUE)
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will show you vignettes for all of the packages you have installed. To see the
vignette for a particular package, enter it in the vignette function with its
name in quotes:

vignette ("mypackage")

Unfortunately, many packages do not have vignettes.
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Programming Language Basics

5.1 Introduction

R is an object-oriented language. Everything that exists in it — variables,
data sets, functions (commands) — are all objects.

Stata has limitations on command and variable name lengths, based on
the version of the software being used. The limits are large, though, and rarely
result in a problem for Stata users. In Stata, leading periods in names are not
allowed and data set names cannot have periods at all.

Object names in R can be any length consisting of letters, numbers, un-
derscores “_,” or the period “.” and should begin with a letter.

However, in R if you always put quotes around a variable or data set name
(actually any object name), it can then contain any characters, including
spaces.

Case matters in both R and Stata, so you can have two variables—one
named myvar and another named MyVar—in the same data set, although
that is not a good idea! Some add-on packages tweak function names like
the capitalized “Save” to represent a compatible, but enhanced, version of a
built-in function like the lowercased “save.”

As in any statistics package, it is best to avoid names that match function
names like “mean” or that match logical conditions like “TRUE.”

Commands can begin and end anywhere on a line and R will ignore any
additional spaces. R will try to execute a function when it reaches the end of a
line. Therefore, to continue a function call on a new line, you must ensure that
the fragment you leave behind is not already a complete function call by itself.
Continuing a function call on a new line after a comma is usually a safe bet.
As you will see, R functions frequently use commas, making them a convenient
stopping point. The R console will tell you that it is continuing a line when
it changes the prompt from “>” to “+.” If you see “+” unexpectedly, you
may have simply forgotten to add the final close parenthesis, “).” Submitting
only that character will then finish your function call. If you are getting the
“+” and cannot figure out why, you can cancel the pending function call

R.A. Muenchen, J.M. Hilbe, R for Stata Users, Statistics 45
and Computing, DOI 10.1007/978-1-4419-1318-0_5,
(© Springer Science+Business Media, LLC 2010
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with the Escape key on Windows or CTRL-C on Macintosh or Linux/UNIX.
For CTRL-C, hold the CTRL key down (Linux/UNIX) or the control key
(Macintosh) while pressing the letter C. You may end any R function call
with a semicolon. That is not required though, except when entering multiple
function calls on a single line.

5.2 Simple Calculations

As with Stata’s display command, you can use R as a calculator. You simply
enter commands like

> 243

(11 5

The “[1]1” tells you the resulting value is the first result. It is only useful
when your results run across several lines. We can tell R to generate some
data for us to see how the numbering depends on the width of the output.
The form 1:50 will generate the integers from 1 to 50.

> 1:50

[1] 1+ 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18
[19] 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36
[37] 37 38 39 40 41 42 43 44 45 46 47 48 49 50

Now, it is obvious that the numbers in square brackets are counting or
indexing the values. We have set our line width to 64 characters to help things
fit in this book. We can use the options function to change the width to 40
and see how the bracketed numbers change.

> options(width=40)
> 1:50

[1] 1 2 3 4 5 6 7 8 910 11 12
[13] 13 14 15 16 17 18 19 20 21 22 23 24
[25] 25 26 27 28 29 30 31 32 33 34 35 36
[37] 37 38 39 40 41 42 43 44 45 46 47 48
[49] 49 50

> options(width=64) #Set it wider again.

In Stata, this setting is replicated by “list, linesize(64).”
You can assign the values to symbolic variables like x and y using the
assignment operator, a two-character sequence “<-.” You can use the equal
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sign as Stata does, but there are some rather esoteric advantages to using
“<-.” Here we use it to assign values to x and y and then do some simple
math.

> x <= 2
>y <=3

> x+y
[1] 5

> X*y
[1] 6

We have added extra spaces in the above commands and extra lines in the
output for legibility. Additional spaces do not affect the commands.

5.3 Data Structures

R has several different data structures, including vectors, factors, data frames,
matrices, arrays, and lists. The data frame is most like a data set in Stata.
Stata and R also have data structures specifically for time series, but those
are beyond the scope of this book. Mata, the imbedded matrix language
in Stata, supports matrices, arrays, vectors, and other similar R-like
functions.

5.3.1 Vectors

A wvector is an object that contains a set of values called elements. You can
think of it as a Stata variable but that would imply that it is a column in a
data set. It is not. It exists by itself and is neither a column nor a row. In
Stata, a column is normally stored as a column. For R, it is usually one of two
things: a variable or a set of parameter settings called arguments that you use
to control a function.

Creating Vectors

To keep things simple, all of our examples will use the same data set, a pre-
tend survey about how people liked various training workshops on statistics
packages. Let us enter the responses to the first question, “Which workshop
did you take?”

workshop <- c( 1,2,1,2,1,2,1,2 )
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All of the values of workshop are numeric, so the vector’s mode is numeric.
Stata refers to that as a variable’s type. As in Stata, if even if one value were
alphabetic (character or string), then the mode would be coerced, or forced,
to be character. R does all its work with functions, which are similar to Stata
commands and functions.

Functions have a name followed by its parameters, called arguments, in
parentheses. The ¢ function’s job is to combine multiple values into a sin-
gle vector. Remember it as c=combine. Its arguments are just the values to
combine—in this case 1,2,1,2....

To print our vector, we can use the print function. This is R’s equivalent
to the Stata 1ist command. However, this function is used so often; it is the
default function used when you type the name of any object! So when working
interactively, these two function calls do exactly the same thing:

> print (workshop)
[11 12121212
> workshop

[11 12121212

We run all of the examples in this book interactively; that is, we submit
function calls and see the results immediately. You can also run R in batch
mode, where you would put all your function calls into a file and tell R to
run them at once, routing the results to a file. In batch mode you must write
out the print function. We will point out a few other instances when you
must write out the print function name in later chapters. Although typing
out the print function for most of our examples is not necessary, we will do
it occasionally when showing how the R code looks in a typical analysis.

Let us create a character variable. Using R jargon, we would say we are
going to create a character vector, or a vector whose mode is character. These
are the genders of our hypothetical students:

> gender <—- C( Ilfll,Ilfll,Ilfll’NA,IImII,Ilmll,llmll,llmll )
> gender

[1] Ilfll Ilfll llfll NA Ilmll Ilmll Ilmll llmll

NA stands for Not Available, which R uses to represent missing values. Later
we will read data from files whose values are separated by commas. In that
case, R would recognize two commas in a row as having a missing value in
between them. However, the values in the ¢ function are its arguments. R does
not allow its functions to have missing arguments. Entering NA gets around
that limitation.
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Even when entering character values for gender, never enclose the NA in
quotes. If you did, it would be just those letters rather than a missing value.
Now let us enter the rest of our data:

ql <- ¢( 1,2,2,3,4,5,5,4 )
q2 <- c¢( 1,1,2,1,5,4,3,5 )
g3 <- c( 5,4,4,NA,2,5,4,5 )
q4 <- c¢( 1,1,3,3,4,5,4,5 )

Analyzing Vectors

To get a simple table of frequencies, we can use the table function, which is
similar to Stata’s tabulate command.

> table(workshop)

workshop
12
4 4

> table(gender)

gender
fm
34

The first thing you will notice about the output is how plain it is. No
percents are calculated and no lines drawn to form a table. When you first see
a table like the one for workshop, its complete lack of labels may leave you
wondering what it means. There are four people who took workshop 1, and
four people who took workshop 2. It is not hard to understand—just a shock
when you come from a package that labels its output better.

This is a difference in perspective between R and Stata. R creates output
that other functions can use immediately. Other functions exist that provide
more output, like percents. Still others format output into publication-quality
form. Stata allows use of statistical output via saved return codes.

Let us get the mean of the responses to question 3:

> mean(q3)

[1] NA

The result is NA or Not Available! Many R functions handle missing values
differently from Stata. R will usually provide output that is NA when per-
forming an operation on data that contains any missing values. It will typically
provide the answer you seek only when you tell it to override that perspective.
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There are several ways to do this in R. For the mean function, you set the NA
remove argument, na.rm, equal to TRUE.

> mean(q3, na.rm=TRUE)

[1] 4.142857

Selecting Vector Elements

So far we have performed a few simple analyses on the entire vector. You
can easily select subsets using a method called indexing or subscripting. You
specify which of the vector’s elements you want in square brackets following
the vector’s name. For example, to see the fifth element of ql, you enter

> q1[5]

(1] 4

When you want to specify multiple elements, you must first combine them
into a vector using the ¢ function. Therefore, to see elements 5 through 8, you
can use

> qll c(5,6,7,8) ]

[1] 455 4

won

The colon operator, “:,” can generate vectors directly, so an alternate way
of selecting elements 5 through 8 is

> ql[ 5:8 ]

[1] 455 4

You can also insert logical selections. They generate logical vectors to
perform your selection. Here we use “==" for logical equivalence, just as in
Stata:

> q1[ gender=="m"
[11 NA 4 5 5 4

Usually the goal of any of these selection methods is to perform some
analysis on a subset. For example, to get the mean response to item ql for
the males, we can use

> mean( ql[ gender=="m"], na.rm=TRUE )

[1] 4.5
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R’s ability to select elements of vectors is very flexible. We will demon-
strate how to apply these techniques toward selecting parts of other data
structures in the sections that immediately follow. Later we will devote three
entire chapters showing how to apply these techniques to data sets in Chap-
ter 7, “Selecting Variables” through Chapter 9, “Selecting Variables and
Observations.”

5.3.2 Factors

Two of the variables we entered above, workshop and gender, are clearly cat-
egorical. R has a special data structure called a factor for such variables.
Regardless of whether the original data is numeric or character, when it be-
comes a factor, its mode is numeric. This is also true for Stata.

Creating Factors from Numeric Vectors

Before we create a factor, let us enter workshop again as a numeric vector and
display its values.

> workshop <- c¢(1,2,1,2,1,2,1,2)
> workshop
[1112121212

Now let us perform two simple analyses.

> table(workshop)

workshop

12

4 4

> mean (workshop)

[1] 1.5

We see that four people took each workshop. We also see that the
mean function happily provided the mean of the workshops, which is a
fairly nonsensical measure for a categorical variable. R usually tries to do
correct things statistically, but we have not yet told it that workshop is
categorical.

You can select elements of factors the same way you select elements of
vectors. For example, to choose the third element of gender, you can use
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> gender [3]
[1] £

Levels: fm

To see the first two and the last two elements, you can put those index

values into a vector using the ¢ function like this:

> gender[ c(1,2,7,8) ]
[1] f fmm

Levels: fm

Let us now see the genders of the people who took the Stata workshop,

which has a value of 2.

> gender [ workshop==2 ]

[1] "froNA "m" "p"

Now let us enter the variable again, convert it to a factor using the factor
function, and display its values.

> workshop <- c(1,2,1,2,1,2,1,2)
> workshop <- factor( workshop )
> workshop

[11 12121212

Levels: 1 2

After using the factor function, we see the display of workshop values has
an additional feature, the levels. Let us repeat our two analytic functions:

> table(workshop)
workshop

12

4 4

> mean(workshop)

[1] NA
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Warning message:
In argument is not numeric or logical: returning NA

The output from the table function is identical, but now the mean function
warns us that this is not a reasonable request and it results in, or returns, a
missing value of NA.

Now that workshop is a factor, we can check the genders of the people
who took the Stata workshop (workshop 2) in two ways:

> gender [ workshop==2 ]
[1] "f" NA "m" "m"

> gender[ workshop=="2" ]
[1] "f" NA "m" "m"

The second example uses quotes around the 2 and it still works. This is
due to the fact that the original numeric values are now also stored as value
labels.

Let us enter workshop again and use additional arguments in the call to
the factor function so we can assign more useful value labels.

workshop <- ¢(1,2,1,2,1,2,1,2)
workshop <- factor(

workshop,

levels=c(1,2,3,4),

labels=c("R","Stata","SPSS","SAS")
)

The factor function call above has three arguments:

1. The name of a vector to convert to a factor.

2. The levels or values that the data can have. This allows you to specify
values that are not yet in the data. In our case, workshop is limited to the
values 1 and 2, but we can include the values 3 and 4 for future expansion.
You cannot do that in Stata.

3. Optionally, the labels for the levels. The factor function will match the
labels to the levels in the order they both appear here. The order of
the values in the data set is irrelevant. If you do not provide the labels
argument, R will use the values themselves as the labels.

Now when we print the data, it shows us that the people in our practice
data set have only taken workshops in R and Stata. It also lists the levels so
you can see what labels are possible:
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> workshop
[11 R Stata R Stata R Stata R  Stata

Levels: R Stata SPSS SAS

The table function now displays the workshop labels and how many people
took each.

> table(workshop)
workshop

R  Stata SPSS SAS
4 4 0 0

The labels have now replaced the original values. So to check the genders of
the people who took the workshop on Stata, we can no longer use the value 2.

> gender [ workshop==2 ]
factor(0)

Levels: Male Female
When we select based on the value label, it works.

> gender[ workshop=="Stata" ]
[1] Female <NA> Male Male

Levels: Male Female

Creating Factors from Character Vectors

You can convert character vectors to factors in a similar manner. Let us again
enter gender as a character vector and print its values.

> gender <- C( Ilfll’Ilfll’Ilfll,NA,IImII’Ilmll’llmll,llmll )
> gender

[1] IlflI Ilfll llf" NA |Iml| Ilmll Ilmll llmll

Notice that the missing value, NA, does not have quotes around it. R
leaves out the quotes to let you know that it is not a valid character string
that might stand for something like North America.
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If we are happy with those labels, we can convert gender to a factor by
using the simplest form of the factor function:

> gender <- factor(gender)
> gender
[1] f f f NAmmmm

Levels: £ m

If, instead, we want nicer labels, we can use the longer form. It uses the
same approach we used for workshop, but the values on the levels argument
need to be in quotes:

> gender <- factor(

+ gender,

+ levels=c("m","f"),

+ labels=c("Male","Female")
+

)
> gender
[1] Female Female Female NA Male Male Male Male
Levels: Male Female
> table(gender)
gender

Male Female
4 3

You now need to use the new labels when performing selections on gender.
For example, to see which workshops the males took, this returns a value of
NA because gender never has a value of “m” at this point.

> workshop[ gender=="m" ]
[1] <NA>

Levels: R SAS SPSS STATA
Instead, specifying the new label of “Male” find the workshops they took:

> workshop[ gender=="Male" ]
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[1] <NA> R Stata R Stata

Levels: R Stata SPSS SAS

Note that the last line of output conveniently tells you all of the levels of the
factor even though the males did not take all of the workshops.
We will examine factors in more detail, and compare them to Stata value
labels in Section 11.1, “Value Labels or Formats (and Measurement Level).”
For the remainder of the book we will use the shorter gender value labels,
((m” and LLf.”

5.3.3 Data Frames

The data structure in R that is most like a Stata data set is the data frame.
Stata data sets are always rectangular, with wvariables in the columns and
observations in the rows. A data frame is also rectangular. In R terminology,
the columns are called wvectors, variables, or just columns. R calls the rows
observations, cases, or just rows.

A data frame is a generalized matriz, one that can contain both character
and numeric columns. A data frame is also a special type of list, one which
requires each component to have the same length. We will discuss matrices
and lists in the next two sections.

We have already seen that R can store variables in vectors and factors.
Why does it need another data structure? R can generate almost any type of
analysis or graph from data stored in vectors or factors. For example, getting
a scatter plot of the responses to ql versus g4 is easy. R will pair the first
number from each vector as the first (x,y) pair to plot and so on down the line.
However, it is up to you to make sure that this pairing makes sense. If you
sort one vector independent of the others, or remove the missing values from
vectors independently, the critical information of how the pairs should form is
lost. A plot will still appear, but it will contain a completely misleading view
of the data. Sorting almost any two variables in ascending order independently
will create the appearance of a very strong relationship. The data frame helps
maintain this critical pairing information.

Creating a Data Frame

The most common way to create a data frame is to read it from another source
such as a text file, spreadsheet, or database. You can usually do that with a
single function call. We will do that later in Chapter 6, “Data Acquisition”.
For the moment, we will create one by combining our vectors and factors. The
following is our program so far:

workshop <- c¢(1,2,1,2,1,2,1,2)
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workshop <- factor(workshop,
levels = c(1,2,3,4),
labels = c("R","Stata","SPSS","SAS") )

gender <_ C("f" s |Ifll s |Ifl| ’NA’ llmll s llmll s |Imll s |Iml|)

gender <- factor(gender)

ql <- ¢(1,2,2,3,4,5,5,4)
q2 <- ¢(1,1,2,1,5,4,3,5)
q3 <- c(5,4,4,NA,2,5,4,5)
q4 <- ¢(1,1,3,3,4,5,4,5)

Now we will use the data.frame function to combine our variables (vectors
and factors) into a data frame. Its arguments are simply the names of the
objects we wish to combine.

> mydata <- data.frame(workshop,gender,ql,q2,93,q94)

> mydata

workshop gender ql g2 g3 q4
1 R f 11 56 1
2 Stata f 2 1 4 1
3 R f 2 2 4 3
4 Stata <NA> 3 1 NA 3
5 R m 4 5 2 4
6 Stata m 5 4 5 5
7 R m 5 3 4 4
8 Stata m 4 5 5 5

Notice that the missing value for gender is now shown as “<NA>.” When R
prints data frames, it drops the quotes around character values and so must
differentiate missing value NAs from valid character strings that happen to
be the letters “NA.” If we wanted to rename the vectors as we created the
data frame, we could do so with the following form. Here the vector “gender”
will be stored in mydata with the name “sex” and the others will keep their
original names. Of course, we could have renamed every variable using this
approach.

mydata <- data.frame(workshop, sex=gender, ql, g2, q3, q4)

Although we had already made gender into a factor, the data.frame func-
tion will coerce all character variables to become factors when the data frame
is created. You do not always want that to happen (for example when you
have vectors that store people’s names and addresses.) To prevent that from
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occurring, you can add the stringsAsFactors=FALSE argument in the call to
the data.frame function.

R data frames have a formal place for an ID variable it calls row names.
These can be informative text labels like subject names, but, by default, they
are sequential numbers stored as character values. The row.names function
will display them:

> row.names (mydata)

[1] Illll Il2|l "3" l|4ll |I5" "6" Il7|l ll8|l

Stata displays sequential numbers like this in its data editor. However,
those numbers are reassigned to new observations when you sort your data.
Row names in R are more useful since sorting never changes their values. You
can always use them to return your data to its original state by sorting on
the row names. See Section 10.16, “Sorting Data Frames,” for details.

Stata users typically enter an ID variable based on the built-in Stata con-
stant “n,” which contains the observation/case number of data stored in
memory. However, this variable is like any other unless you manually supply
it to a procedure that identifies observations. In R, procedures that identify
observations will do so automatically using row names. If you set an ID vari-
able to be row names while reading a text file, the variable’s original name
(id, subject, SSN,...) vanishes. Since functions that do things—Ilike iden-
tify outliers—will use the information automatically, you usually do not need
the name. We will discuss row names further when we read text files and in
Section 10.6, “Renaming Variables (...and Observations).”

Selecting Components of Data Frames

There are several ways to select the components of a data frame. For now,
we will focus on just two: selecting by index numbers and by a method called
$ notation. We will save the other methods for later chapters.

Selecting Data Frame Components by Index Numbers

While vectors and factors have only one-dimensional index values with which
to select their elements, data frames have two. These are in the form

mydataframe [rows, columns]

For example, can choose the eighth observation’s value of the sixth
variable, g4, using

> mydatal 8, 6 ]

[1] 5
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If we leave out a row or column specification, R will assume we want them
all. So to select all of the observations for the sixth variable, we can use

> mydatal , 6 ]

[1] 11334545

It so happens that the above example is selecting a vector. We saw before
that we could add index values to the end of a vector to select a subset of it.
So for variable q4, we could choose its fifth through eighth elements using

> q4[ 5:8 ]
[11 4545

In our data frame, mydatal[ ,6] is the same vector as variable q4. There-
fore, we can make this same selection by appending the [5:8] to it to make
the same selection:

> mydatal , 6 ][ 5:8 ]

[1] 45 4 5

Selecting Data Frame Components Using $ Notation

Since the components of our data frame have names, we can also select them
by those names using the form

myDataFrameName$myComponentName

Therefore, to select q1 from mydata, we can use
> mydata$ql
[11 12234554

The variable q1 is still a vector, so we can append index values to it to make
further selections. To select the fifth through eighth value (the males), we
can use

> mydata$ql[ 5:8 ]
[1] 4 55 4

As we will soon see, there are many other ways to select subsets of data
frames. We will save the other methods for Chapter 7, “Selecting Variables”
through Chapter 9, “Selecting Variables and Observations.”
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5.3.4 Matrices

A matriz is a two-dimensional data object that looks like a Stata data set,
but it is actually one long vector wrapped into rows and columns. Because
of this, its values must be of the same mode, [i.e., all numeric, all character,
or all logical (more on logical vectors later)]. This constraint makes matrices
more efficient than data frames for some types of analyses.

Creating a Matrix

The cbind function takes columns and binds them together into a matrix:

> mymatrix <- cbind(ql, g2, 93, g4)
> mymatrix

ql 92 g3 g4
[1,]
[2,]
[3,]
[4,]
[5,]
[6,]
[7,]
[8,]

NI

N

SO WD
O W > ar NN~ -
=
O O W W

[S2 I G2 I o)

As you can see, a matrix is a two-dimensional array of values. The numbers
to the left side in brackets are the row numbers. The form [1, | means that it
is row number one and the lack of a number following the comma means that
R has displayed all of the columns.

We can get the dimensions of the matrix with the dim function.

> dim(mymatrix)

[1] 8 4

The first dimension is the number of rows, 8, and the second is the number
of columns, 4.

To create a matrix, you do not need to start with separate vectors as
we did. You can create one directly with the matrix function. The matrix
function call below has four arguments. The first argument is data, which you
must enter enclosed in the ¢ function. The next three specify the number of
rows, columns, and whether or not you are entering the data by rows. If you
leave the byrow=TRUE argument off, you would enter the data turned on its
side. We prefer to enter it by rows since it looks more like the format used
with Stata data sets.
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mymatrix <- matrix(
c(1, 1, 5, 1,
2’ b 4,

B >

B

S

B

=

A,

B

B > B

B ) H

B >

-

>

aodd WwN
SO W W

4 b s ) b
nrow=8, ncol=4, byrow=TRUE)

> >

g wd o= N
g N
[$)]

>

>
+
+
+
+
+
+
+
+
+

> mymatrix

(,11 [,2] [,3] [,4]

[1,] 1 1 5 1
2,1 2 1 4 1
[3,] 2 2 4 3
(4,] 3 1 NA 3
[5,] 4 5 2 4
[6,] 5 4 5 5
7,1 5 3 4 4
[8,] 4 5 5 5

We see that the result is the same as before, except that the columns are
no longer named ql, q2, q3, q4. Now let us see what the table, mean and cor
functions do with matrices. We will use the earlier version of our matrix, so
we will see the variable names.

> table(mymatrix)

mymatrix
12345

64489

> mean( mymatrix, na.rm=TRUE )
[1] 3.266667

> cor( mymatrix, use="pairwise" )

ql q2 q3 q4
ql 1.0000000 0.7395179 -0.1250000 0.9013878
q2 0.7395179 1.0000000 -0.2700309 0.8090398
g3 -0.1250000 -0.2700309 1.0000000 -0.2182179
g4 0.9013878 0.8090398 -0.2182179 1.0000000
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The table function counts the responses across all survey questions at
once! That is not something Stata would usually do. It is odd, but not useless.
We can see that 9 times people strongly agreed (a value of 5) with any of the
questions on our survey.

The mean function gets the mean response of them all. Again, it is not of
much interest in our situation, but you might find cases where it would be of
value.

The cor function correlates each item with the others, which is a very
common statistical procedure. The fact that the names ql1, ql,. .. appear shows
that we are using the version of the matrix we created by combining the vectors
with those names.

If you put a matrix into a data frame, its columns will become individual
vectors. For example, now that we have mymatrix, we can create our practice
data frame in two ways. Both have an identical result:

mydata <- data.frame( workshop, gender, ql, 92, g3, g4 )
or
mydata <- data.frame( workshop, gender, mymatrix )

In our case, there is not much difference between the two approaches. However,
If you had 100 variables already in a matrix, the latter would be much easier
to do.

Selecting Subsets of Matrices

Like data frames, matrices have two dimensions. You can select a subset of a
matrix by specifying the two index values in the form

mymatrix [rows, columns]
For example, we can choose the eighth row and the fourth column using
> mymatrix[ 8, 4 ]
q4
5

We can chose the males, rows five through eight, and variables q3 and q4
using:

> mymatrix[ 5:8, 3:4]

[,11 [,2]
[1,] 2 4
[2,] 5 5
[3,] 4 4
4,1 5 5
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When discussing vectors, we learned that we could select parts of a vector
using only one-dimensional indexes. For example, q4[1:4] selects the first
four elements of the vector q4. When we leave out one of the two index values
for a matrix, we are selecting a vector. Therefore, we can do this very same
example by appending [1:4] to mymatrix[ ,4] asin

> mymatrix[ ,4]1[1:4]

[1] 1133

Most of the other methods we have used for selecting elements of vectors
or factors work in a similar manner with matrices.

5.3.5 Arrays

An array is a multidimensional extension of the matrix structure. You can
think of it as a set of matrices. The use of arrays is beyond our scope.

5.3.6 Lists

A list is a very flexible data structure. You can use it to store combinations of
any other objects, even other lists. The objects stored in a list are called its
components. That is a broader term than wvariables, or elements of a vector,
reflecting the wider range of objects possible.

You can use a list to store related sets of data stored in different formats
like vectors and matrices (see the example below). R often uses lists to store
different bits of output from the same analysis. For example, results from a
linear regression would have equation parameters, residuals and so on. See
Chapter 17, “Statistics” for details.

You can also use lists to store sets of arguments to control functions. We
will do that later when reading multiple lines of data per case from a text file.
Since each record we read will contain a different set of variables—each with
a different set of column widths we would need to describe—a list is a perfect
way to store them. For an example, see Section 6.5, “Reading Fixed-Width
Text Files, Two or More Records per Case.”

We will also store arguments when aggregating data by workshop and
gender in Section 10.11, “Creating Collapsed or Aggregated Data Sets.”

Creating a List

For now, we will focus on storing data in a list. We can combine our variables
(vectors) and our matriz into a list using the list function.

> mylist <- list(workshop, gender, ql, g2, 93, g4, mymatrix)

Now let us print it.
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> mylist

[[11]
[1] R Stata R Stata R Stata R Stata
Levels: R Stata SPSS SAS

[[2]]
[1] £ f f <NA> m m m m
Levels: fm

[[3]1]
[1] 12234554

[[41]
(11 11215435

[[5]1]
[1] 5 4 4NA 2 5 4 5

el]
(11 11334545

[[7]1]

ql 92 q3 g4
[1,]
[2,]
[3,]
[4,]
[5,]
[6,]
[7,]
(8,]

NNENCH

N

B OO W NN e

Wb Ul RN R
=

OO W W e

[S2 I S G2 I V)

Notice how the vector components of the list print sideways now. That
allows each variable to have a different length, or even to have a totally dif-
ferent structure, like a matrix. Also notice that it counts the components of
the list with an additional index value in double brackets [[1]], [[2]]. ... Then
each component has its usual index values in single brackets.

Recall that when we added our matrix to a data frame, the structure
of the matrix vanished and the matrix columns became variables in the data
frame. Here though, the matrix is able to maintain its separate identity within
the list.

Let us create the list again, this time naming each component.
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> mylist <- list(

+  workshop=workshop,
+ gender=gender,

+ ql=ql,

+92=q2,

+ 93=q3,

+  gd=q4,

+ mymatrix=mymatrix)

Now when we print it, the names [[1]], [[2]],...are replaced by the names we
supplied.

> mylist

$workshop

[11 R Stata R Stata R Stata R Stata

Levels: R Stata

$gender
[1] £ f f <NA> m m m m
Levels: £ m

$aq1
[11 12234554
$q2
[11 11215435
$a3
[1] 5 4 4NA 2 5 4 5
$q4
[11 11334545
$mymatrix

ql 92 g3 g4
1,7 1 1 5 1
2,1 2 1 4 1
[3,] 2 2 4 3
[4,] 3 1NA 3
[5,] 4 5 2 4
[6,] 5 4 5 5
[7,] 5 3 4 4
[8,] 4 5 5 5
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Selecting Components of a List

Since a data frame is a specific type of list, any method of selecting components
that we discussed for data frames will also apply here. However, since the types
of objects a list can store is broader, so too are the techniques for selecting
its components.

Selecting Components of a List by Index Numbers

To select the components from a list, we can always use the double-bracketed
index values. For example, to select the vector containing gender, we can use

> mylist[[2]]

[1] Ilfll llfll llfll NA |Iml| Ilmll llmll llmll
To select the matrix, we can use

> mylist [[7]]

(.11 [,21 [,3] [,4]

[1,] 1 1 5 1
[2,1] 2 1 4 1
[3,] 2 2 4 3
[4,] 3 1 NA 3
[5,] 4 5 2 4
[6,] 5 4 5 5
[7,] 5 3 4 4
[8,] 4 5 5 5

When selecting components from a list, we can continue to add index
values to select subsets of that component. Recall that earlier we selected
the fifth through eighth rows and third through fourth columns of mymatrix
by appending [5:8,3:4] to its name, mymatrix[5:8,3:4]. Now that we can
select this matrix by referring to mylist [[7]], we can also append [5:8,3:4]
to that:

> mylist[[7]1]1[ 5:8, 3:4 1]

[,11 [,2]
[1,] 2 4
[2,1] 5 5
[3,] 4 4
4,1 5 5

R’s indexing approach starts looking pretty confusing at this point, but do
not worry. In future chapters we will see that selections usually look far more
natural with variable names used to select columns and with logical selections
choosing rows.
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Selecting Components of a List Using $ Notation

Since we have named our list’s components, we can make the same selections
by using the form

myListName$myComponentName
Therefore, to select the component named ql, we can use

> mylist$ql
[1] 122345514

We can also append index values in square brackets to our selections to
choose subsets. Here we select my matrix, then choose the fifth through eighth
rows and third and fourth columns:

> mylist$mymatrix[ 5:8, 3:4 ]

q3 q4
1,1 2 4
[2,] 5 5
[3,] 4 4
(4,1 5 5

5.4 Saving Your Work

When learning any new computer program, always do a small amount of work,
save it, and get completely out of the software. Then go back in and verify
that you really did know how to save your work.

This is a good point at which to stop, clean things up, and save your
work. Until you save your work, everything resides in the computer’s main
random access memory. You never know when a power outage might erase it.
R calls this temporary work area its workspace. We want to transfer everything
we have created from this temporary workspace to a permanent file on our
computer’s hard drive.

You can use the 1s function to see all of the data objects you have created.
If you put no arguments between the 1s function’s parentheses, you will get
a list of all your objects. Another more descriptive name for this function is
objects. I use 1s below instead of objects because it is more popular. That
may be due to the fact that Linux and UNIX have an “ls” command that
performs a similar function by listing your files.

If you have done the examples from the beginning of this chapter, here are
the objects you will see in your workspace.
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> 1s()
[1] "gender" "mydata" "mylist" "mymatrix" "qi"
[6] Ilq2l| |Iq3Il llq n Ilworkshopll "X"
[11] ||yl|

We want to save some of these objects to our computer’s hard drive, but
where will they go? The directory or folder that R will store files in is called
its working directory. Unless you tell it otherwise, R will put any file you save
into that directory. On Windows XP or earlier, that is:

C:\Documents and Settings\username\My Documents. On Windows Vista or
later, that is: C:\Users\ Yourname\My Documents. On Macintosh, the default
working directory is /Users/username.

The setwd function sets your working directory, telling R where you would
like your files to go. The getwd function gets your working directory for you
to see.

> getwd()

[1] "C:/Documents and Settings/username/My Documents"
> setwd("/myRfolder")
> getwd()

[1] "/myRfolder"

Notice that we use a forward slash in “/myRfolder.” R can use forward slashes
in filenames even on computers running Windows! The usual backslashes used
in Windows file specifications have a different meaning in R, and in this con-
text will generate an error message:

> setwd("\myRfolder") #backslashes are bad in filenames!
Error in setwd("myRfolder") : cannot change working directory

In addition: Warning messages:
1: ’\m’ is an unrecognized escape in a character string
2: unrecognized escape removed from "\myRfolder"

The message warns you that R is trying to figure out what “\m” means. We
will discuss why later.

So now we know what is in our workspace and where our working directory
resides. We are ready to save our work. However, which objects should we
save? Once we have combined our vectors into a data frame, we do not need
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the individual vectors any more. We will save just our data frame, mydata,
and the matrix of survey questions, mymatrix.

The save function saves the objects you tell it, to the file you list as its
last argument.

save(mydata, mymatrix, file="mydata.RData")

While Stata users typically only save one data set to a file, R users often
save multiple objects to a single file using this approach.

Rather than tell R what you do want to save, you could remove the objects
that you do not want to save and then save everything that remains. We can
remove the ones we do not want by listing them as arguments separated by
commas on the remove function. It also has a more popular shorter name, rm.

> rm( x,y,workshop,gender,ql,92,93,q94,mylist )
> 1s()

[1] "mydata" "mymatrix"

The save.image function will save all objects in your workspace to the file
you specify:

save.image (file="myWorkspace.RData")

When you exit R, it will ask if you want to save your workspace. Since we are
saving it to a file we have named, you can tell it no. The next time you start
R, you can load your work with the load function.

> load("mydata.RData")
If you want to see what you have loaded, use the 1s function:

> 1s()

[1] "mydata" "mymatrix"

For more details, see Chapter 13, Managing Your Files and Workspace.

5.5 Comments to Document Your Programs

No matter how simple you may think a program is when you write it, it is
good to sprinkle in comments liberally to remind yourself later what you did
and why you did it. As we have discussed briefly, R uses the # operator to
begin a comment. R comments continue until the end of the line. You can put
comments in the middle of statements, but only if they are at the end of the
line:
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# This comment is on its own line, between functions.

workshop <- ¢(1,2,1,2, #This comment is within the arguments.
1,2,1,2) #And this is at the end.

Unlike Stata /*...*/ style comments, there is no way to comment out
a whole block of code that you want to ignore. R users get around that by
pretending to define a function whose only goal is to have R ignore the code.
For example:

BigComment <- function(x)
{
# Here is code I do not want to run,
# but I might need to run it later.
mean(x, na.rm=TRUE)
sd(x, na.rm=TRUE)
}

While Stata allows errors to exist in the code that has been commented out,
R does not. R is actually creating the function, so the code within it must be
correct.

A better way to comment out a large block of text is to use a text editor
that can easily add (and later remove) the # character to the front of each
line in a selected block of code.

5.6 Controlling Functions (Commands)

Stata controls its procedures though commands like glm and related options
such as # to specify which variables are factors (categorical). Stata commands
and functions have options controlling exactly what appears in the output.
Modeling statements have a formula syntax. R has analogs to these methods,
plus a few unique ones.

5.6.1 Controlling Functions with Arguments

Stata uses options to control what commands calculate and display. R does
too, using slightly different terminology. R uses arguments to control func-
tions. Let us look at the help file for the mean function. The following function
call will display its help file:

> help(mean)

In Fig. 5.1, in the section labeled Usage, the help file tells us that the over-
all form of the function is mean(x, ...). That means you have to provide an
R object represented by x, followed by arguments represented by “....” The
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#’ R Help for package base (=]

a & o
Hide Frint  Options
Contents |ipdex | Search| | mean(base) R Documentation
@ Mathdataframe A
el Arithmetic Mean
@ Math factor s e
@ Math POSDOE Description
@ Math POSIXt
D matrmut Generic function for the (trimmed) arithmetic mean.
3 matric
B ma Usage
@ miacol
Dmean mean(x, ...)
Rlmean data frame
@ mean Date ## Default $3 method:
3 mean default mean(x, trim = 0, na.mm = FALSE, ...)
@ mean diftime
@ mean POSIXct Arguments
B mean POSDat
8 v Sk x An R object. Currently there are methods for mumeric data frames, numeric vectors and dates. A
B Meenory complex vector is allowed for trim = 0, only.
@) Memorny-limnits
B mernory, trim the fraction (0 to 0.5) of observations to be trimmed from each end of x before the mean is
Bmerge f computed. Values of trim outside that range are taken as the nearest endpoint.
B merge data frame na. = a logical value indicating whether xa values should be stripped before the computation p
B S T further arguments passed to or from other methods.

Fig. 5.1. Help file for the mean function.

Default S8 Method section tells us the arguments used by the mean function
itself as well as their initial, or default, settings. So if you do not tell it oth-
erwise, it will not trim any data (trim=0) and will not remove missing values
(na.rm=FALSE). That means the presence of any missing values will result in
the mean being missing or NA too. The “...” means that more arguments
are possible, but the mean function will pass those along to other functions
that it calls. We will see examples of that later.

The Arguments section gets into the details. It tells you that x can be a
numeric data frame, numeric vector, or date vector. It also has a comment
about complex vectors, which are beyond our scope. The trim argument tells
R the percent of the extreme values to exclude before calculating the mean.
It goes on to define what na.rm and “...” do.

We can run the mean function on our q3 variable by naming each argument.
We deleted it previously with the rm function, but imagine that we had not
done that. Here we call the function, naming its arguments in the order they
appear in the help file and setting their values.

mean(x=q3, trim=.25, na.rm=TRUE)
If you name all of the arguments, you can use them in any order.
mean (na.rm=TRUE, x=q3, trim=.25)

We can also run it by listing every argument in their proper positions but
without the argument names:

mean(q3, .25, TRUE)
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All of these approaches work equally well. However, people usually run R
functions by listing the object to analyze first without its name, followed by
the names and values of only those arguments they want to change:

mean(q3, trim=.25, na.rm=TRUE)

You can also abbreviate some argument names, but it is a bit tricky. As
in Stata, the abbreviation you choose must have enough letters to be unique.
However, some functions pass arguments they do not recognize to other func-
tions they control. As mentioned earlier in this section, this is indicated by
“...”7 as the function’s last argument in the help file. Once a function has
started passing arguments to other functions, R will pass them all unless it
sees the full name of an argument it uses!

People sometimes abbreviate the values TRUE or FALSE as T or F. This
is a bad idea, as you can define T or F to be anything you like, leading to
undesired results. You may avoid that trap yourself, but if you write a function
that others will use, they may use those variable names. So the function below
will also run, but I do not recommend running it this way.

mean (g3, t=.25 na=T)

It is a good idea to avoid abbreviations when naming R arguments.

5.6.2 Controlling Functions with Formulas

An important type of argument is the formula. It is the first parameter in
functions that do modeling. For example, we can do linear regression, predict-
ing g4 from the others with the following call to the 1m function for [inear
models.

Im( g4 ~ ql+q2+q3, data=mydata )

Some modeling functions accept arguments in the form of both formulas
and vectors. For example, both of these function calls will compare the genders
on the mean of variable ql.

t.test( q1 ~ gender, data=mydata )

t.test( q1[ which(gender=="Female") ],
ql[ which(gender=="Male") 1],
data=mydata) #Data ignored!

However, there is one very important difference. When using a formula, the
data argument can supply the name of a data frame that R will search before
looking elsewhere for variables. When not using a formula, as in the second
example, the data argument is ignored! We deleted the variables outside the
data frame, so R no longer knows where gl is. The variable q1 still exists in
mydata, but even though we use the data argument to point to it, R will find
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it only for formulas. This approach maintains R’s extreme flexibility while
helping to keep formulas short. We will clarify this in Section 17.5, “Linear
Regression.”

The symbols that R uses for formulas are somewhat different from those
used by Stata. Table 5.1 shows some common examples using a, b, and c as
categorical factors and y, x1, and x2 as continuous numeric variables.

Table 5.1. Example formulas in Stata and R.

Model Stata R

Simple regression MODEL reg y x y°x

Multiple regression MODEL reg y i.x1#i.x2 v x1+x2+x1:x2
with interaction

Regression without MODEL reg y x1, nocons yT-1+x
intercept

One-way analysis MODEL oneway y a vy a
of variance

Two-way analysis MODEL anova y a b a*b y~atb+a:b y~a*b

of variance
with interaction

Analysis of MODEL anova y a, cont(x) y~a x
covariance

Analysis of variance MODEL anova y bla y~b \%in\% a y~“a/b
with b nested
within a

5.6.3 Controlling Functions with an Object’s Class

In R, each data structure stores its class as an attribute, or stored setting,
that functions use to determine how to process the object. For objects whose
mode is numeric, character, or logical, an object’s class is its mode. However,
for matrices, arrays, factors, lists, or data frames, other values are possible

(see Table 5.2).
You can display an object’s class with the class function:

> workshop <- c( 1,2,1,2,1,2,1,2 )
> class(workshop)

[1] "numeric"
> summary (workshop)

Min. 1st Qu. Median Mean 3rd Qu. Max.
1.0 1.0 1.5 1.5 2.0 2.0
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Table 5.2. Modes and classes of various R objects.

Object Mode Class
Numeric vector numeric numeric
Character vector character character
Factor numeric factor
Data frame list data.frame
List list list
Numeric matrix numeric matrix
Character matrix character matrix
Model list Im. ..
Table numeric table

The class “numeric” indicates that this version of workshop is a numeric
vector, not yet a factor. The summary function provided us with inappropriate
information because we failed to tell it that workshop is a factor. Note that
when we convert workshop into a factor, we are changing its class to factor
and then summary gives us the more appropriate counts instead:

> workshop <- factor(workshop,
+ levels=c(1,2,3,4),
+ labels=c("R","Stata","SPSS","SAS") )

> class(workshop)
[1] "factor"

> summary (workshop)

R Stata SPSS SAS
4 4 0 0

When we first created gender, it was a character vector so its class was
character. Later we made its class factor. Numeric vectors like 1 have a class
of numeric. The names of some other classes are obvious: factor, data.frame,
matrix, list, and array. Objects created by functions have many other classes.
For example, the linear model function, 1m, stores its output in objects with
a class of Im.

R has some special functions called generic functions. They accept multiple
classes of objects and change their processing accordingly. These functions are
tiny. Their task is simply to determine the class of the object and then pass it
off to another that will do the actual work. The methods function will tell you
what other functions a generic function will call. Let us look at the methods
that the summary function uses.

> methods (summary)

[1] summary.aov summary.aovlist
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[3] summary.connection summary.data.frame
[6] summary.Date summary.default
[7] summary.ecdf* summary.factor

[9] summary.glm summary.infl

[11] summary.lm summary.loess*
[13] summary.manova summary.matrix
[15] summary.mlm summary.nls*

[17] summary.packageStatus* summary.P0SIXct
[19] summary.POSIX1t summary . ppr*

[21] summary.prcomp* summary . princomp*
[23] summary.stepfun summary.stl*

[25] summary.table summary . tukeysmooth*

Non-visible functions are asterisked

So when we enter summary(mydata), the summary function sees that my-
data is a data frame and then passes it to the function summary.data.frame.
The functions marked with asterisks above are “non-visible.” Visible functions
you can be seen by typing their name (without any parentheses). That makes
it easy to copy and change them, although only an advanced user would want
to do that.

When we discussed the help files, we saw that the mean function ended with
an argument of “. . ..” That indicates that the function will pass arguments on
to other functions. While it is very helpful that generic functions automatically
do the “right thing” when you give it various objects to analyze, it complicates
the process of using help files.

When written well, the help file for a generic function will refer you to
other functions, providing a clear path to all you need to know. However,
it does not always go so smoothly. We will see a good example of this in
Chapter 15, “Traditional Graphics”. The plot function is generic. When we
call it with our data frame, it will give us a scatter plot matrix. However,
to find out all of the arguments we might use to improve the plot, we have
to use methods(plot) to find that plot.data.frame exists. We could then
use help(plot.data.frame) to find that plot.data.frame calls the pairs
function, then finally help(pairs) to find the arguments we seek. This is
a worst-case scenario, but it is important to realize that this situation does
occasionally arise. As you work with R, you may occasionally forget the mode
or class of an object you created. This can result in unexpected output. You
can always use the mode or class functions to remind yourself. Table 5.2
shows several R objects and their modes and classes.

5.6.4 Controlling Functions with Extractor Functions

Commands in Stata typically display all their output at once. Ancillary post-
estimation commands, however, are commonly used in Stata and add to the
scope of statistical output available for a given primary command.
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R has simple functions, like the mean function, that show all of their results
at once. However, R functions that model relationships among variables tend
to show you very little output initially. You save the output to a model
object and then use extractor functions to get more information when you
need it.

This section is poorly named from an R expert’s perspective. Extractor
functions do not actually control other functions the way options control Stata
output. Instead they show us what the other function has already done. In
essence, most modeling in R is done through its equivalent to the Stata postes-
timation commands.

Let us look at an example of predicting g4 from gl with linear regression
using the 1m function.

> 1m( g4~ql+q2+q3, data=mydata)

Call:
Im(formula = g4 ~ ql + g2 + g3, data = mydata)

Coefficients:
(Intercept) ql q2 q3
-1.3243 0.4297 0.6310 0.3150

The output is extremely sparse, lacking the usual tests of significance. Now,
instead, we will store the results in a model object called myModel and we
will check its class with the class function.

> myModel <- 1m( g4 ~ ql+q2+q3, data=mydata )
> class(myModel)

[1] "m"

The class function tells us that myModel has a class of “Im” for linear model.
We have seen that R functions offer different results (methods) for different
types (classes) of objects. So let us see what the summary function does with
this class of object:

> summary (mymodel)

Call:
Im(formula = g4 ~ ql + g2 + g3, data = mydata)

Residuals:
1 2 3 5 6 7
-0.31139 -0.42616 0.94283 -0.17975 0.07658 0.02257
8

-0.12468
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Coefficients:

Estimate Std. Error t value Pr(>|tl)
(Intercept) -1.3243 1.2877 -1.028 0.379
ql 0.4297 0.2623 1.638 0.200
q2 0.6310 0.2503 2.521 0.086
q3 0.3150 0.2557 1.232 0.306

Signif. codes: 0 *** 0.001 *x 0.01 * 0.05 . 0.1

Residual standard error: 0.6382 on 3 degrees of freedom
(1 observation deleted due to missingness)

Multiple R-squared: 0.9299, Adjusted R-squared: 0.8598

F-statistic: 13.27 on 3 and 3 DF, p-value: 0.03084

This is the type of output that Stata shows immediately. There are many
other extractor functions that we might use, including anova to extract an
analysis of variance table, plot for diagnostic plots, predict to get predicted
values, resid to get residuals, and so on. We will discuss those in Chapter 17,
“Statistics.”

What are the advantages of the extractor approach?

You get only what you need, when you need it.

The output is in a form that is very easy to use in further analysis.

You use methods that are consistent across functions in a similar manner
to Stata. For example, requests for regression residuals are uniform across
R functions and Stata commands.

5.7 How Much Output is There?

In the previous section we discussed saving output and using extractor func-
tions to get more results. However, how do we know what an output object
contains? Previously, the print function showed us what was in our objects,
so let us give that a try. We can do that by simply typing an object’s name
or by explicitly using the print function. To make it perfectly clear that we
are using the print function, let us actually type out its name.

Call:
Im(formula = g4 ~ ql + g2 + g3, data = mydata)
Coefficients:

(Intercept) ql q2 q3
-1.3243 0.4297 0.6310 0.3150
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We see that the object contains the original function call complete with its
arguments and the linear model coefficients. Now let us check the mode, class,
and names of myModel.

> mode (myModel)
[1] "list"

> class(myModel)
[1] "p"

> names (myModel)

[1] "coefficients" "residuals" "effects" "rank"
[6] "fitted.values" "assign" "qr" "df.residual"
[9] "na.action" "xlevels" "call" "terms"
[13] "model"

So we see that myModel is a list, or collection of objects. More specifically,
it is a list with a class of “lm.” The names function shows us the names of
all of the objects in it. Why did the print function not show them to us?
Because the print function has a predetermined method for displaying lm
class objects. That method says, basically, “If an object’s class is Im, then
print only the original formula that created the model and its coefficients.”

When we put our own variables together into a list, it had a class of simply
“list” (its mode was list also). The print function’s method for that class tells
it to print all of the list’s components. We can strip away the class attribute
of any object with the unclass function. In this case, it resets its class to
“list.” If we do that, then the print function will indeed print all of the list’s
components.

> print( unclass(mymodel) )

$coefficients
(Intercept) ql q2 q3
-1.3242616 0.4297468 0.6310127 0.3149789

$residuals
1 2 3 5 6
-0.31139241 -0.42616034 0.94282700 -0.17974684 0.07658228
7 8

0.02257384 -0.12468354
$effects
(Intercept) ql q2 q3
-8.6931829 3.6733345 -1.4475844  0.7861009 0.2801541

0.7929917 -0.7172223
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$rank
[1] 4

$fitted.values

1 2 3 5 6 7

1.311392 1.426160 2.057173 4.179747 4.923418 3.977426
8

5.124684

$assign

[11 0123

$qr

$aqr

(Intercept) ql q2 q3

1 -2.6457513 -8.6931829 -7.9372539 -10.9609697

2 0.3779645 3.9279220 3.3096380 -0.3273268

3 0.3779645 0.1677124 -2.6544861 0.7220481

5 0.3779645 -0.3414626 0.4356232 2.4957256

6 0.3779645 -0.5960502 -0.3321400 -0.1051645

7 0.3779645 -0.5960502 -0.7088608 0.4471879

8 0.3779645 -0.3414626 0.4356232 -0.4186885

attr(,"assign")

[1J] 0123

$qraux

[1] 1.377964 1.167712 1.087546 1.783367

$pivot
[11] 1 2 3 4

$tol
[1] 1e-07

$rank
[1] 4

attr(,"class")
[1] llqr"

$df .residual
[1] 3

$na.action
4
4
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attr(,"class")
[1] "omit"

$xlevels
list()

$call
Im(formula = g4 ~ ql + g2 + g3, data = mydata)

$terms
q4 " ql + g2 + g3
attr(,"variables")
list(q4, ql, 92, q3)
attr(,"factors")

ql 92 g3
g4 0 0 0
qgl 1 0 0
2 0 1 0
3 0 0 1
attr(,"term.labels")
[1] "q1" "g2" "q3"
attr(,"order")
[11 111
attr(,"intercept")
[1] 1
attr(,"response")
[1] 1
attr(,".Environment")
<environment: R_GlobalEnv>
attr(,"predvars")
list (g4, qi, 92, 93)
attr(,"dataClasses")

qé ql q2 q3

"numeric numeric" "numeric numeric"
$model
g4 ql1 92 g3

1 1 1
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It looks like the print function was doing us a big favor by not printing
everything! When you explore the contents of any object, you can take this
approach or, just given the names, explore things one at a time. For example,
we saw that myModel contained the object named “$coefficients.” One way
to print one component of a list is to refer to it as mylist$mycomponent. So in
this case we can see just the component that contains the model coefficients
by entering

> myModel$coefficients

(Intercept) ql q2 q3
-1.3242616 0.4297468 0.6310127 0.3149789

That looks like a vector. Let us use the class function to check.
> class( myModel$coefficients )
[1] "numeric"

Yes, it is a numeric vector. So we can use it with anything that accepts such
data. For example, we might get a bar plot of the coefficients with the following
(plot not shown). We will discuss bar plots more in Chapter 15, “Traditional
Graphics.”

> barplot( myModel$coefficients )

For many modeling functions, it is very informative to perform a similar
exploration on the objects created by them.

5.8 Writing Your Own Functions (Macros)

In a similar manner as in Stata, R users may write functions using the same
language used for anything else. The resulting function is used in exactly the
same way as a function that came with R.

Let us write some variations of a simple function, one that calculates the
mean and standard deviation at the same time. For this example, we will
apply it to just the numbers 1, 2, 3, 4, and 5.

> myvar <- c( 1,2,3,4,5 )
We will begin the function called mystats and tell it that it is a function of x.

What follows in curly brackets is the function itself. We will create this with
an error to see what happens.
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# A bad function.
mystats <- function(x)
{
mean(x, na.rm=TRUE)
sd(x, na.rm=TRUE)
}

Now let us apply it like any other function.

> mystats(myvar)

[1] 1.5811

We got the standard deviation, but what happened to the mean? When we
introduced the print function, we said that usually you could type an object’s
name rather than say print(myobject). Well, this is one of the cases where
we need to explicitly tell R to print the result. Let us add that to the function.

# A good function that just prints.
mystats <- function(x)
{
print( mean(x, na.rm=TRUE) )
print(  sd(x, na.rm=TRUE) )
}

Now let us run it.

> mystats(myvar)
[11 3
[1] 1.5811

That looks better. Let us create our function in a slightly different way, so
that it will write our results to a vector for further use. We will use the c
function to combine the results into a vector.

# A function with vector output.
mystats <- function(x)

{
mymean <- mean(x, na.rm=TRUE)
mysd <- sd(x, na.rm=TRUE)
c( mean=mymean, sd=mysd )

}
Now when we run it, we get the results in vector form.

> mystats(myvar)

mean sd
3.0000 1.5811
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As with any R function that creates a vector, we can assign the result to
a variable to use in any way we like.

> myVector <- mystats(myvar)
> myVector

mean sd
3.0000 1.5811

Many R functions return their results in the form of a list. Recall that
each member of a list can be any data structure. Let us use a list to save the
original data, as well as the mean and standard deviation. We will use the
list function as we did when we combined all our variables into one list.

# A function with list output.
mystats <- function(x)
{
myinput <- x
mymean <- mean(x, na.rm=TRUE)
mysd <-  sd(x, na.rm=TRUE)
list(data=myinput, mean=mymean, sd=mysd)

}
Now let us run it to see how the results look.
mystats (myvar)

$data
[1] 1 23 45

$mean
[1] 3

$sd
[1] 1.5811

We can save the result to mylist and then print just the data.
> myStatlist <- mystats(myvar)

> myStatlist$data
[11 1 2345

If you want to see the function itself, simply type the name of the function
without any parentheses following.
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> mystats

function(x)
{
myinput <- x
mymean <- mean(x, na.rm=TRUE)
mysd <- sd(x, na.rm=TRUE)
list(data=myinput,mean=mymean, sd=mysd)

3

You could easily copy this function into a script editor window and change it.
You can see and change many R functions this way.

5.9 R Program Demonstrating Programming Basics

Most of the chapters in this book end with equivalent example programs in
both Stata and R. This chapter focuses so much on R that we end only with
the program for R.

# Programming Basics.

# ---Simple Calculations——-

2+3

X <= 2

y <=3

x+y

XXy

# —---Data Structures—--

# Vectors

workshop <- c¢(1,2,1,2,1,2,1,2)
print (workshop)

workshop

gender <- C("f" s nen R nen ,NA, "m" s nm" s n"m" R ||mu)
ql <- ¢(1,2,2,3,4,5,5,4)
q2 <- ¢(1,1,2,1,5,4,3,5)
g3 <- c(5,4,4,NA,2,5,4,5)
q4 <- ¢(1,1,3,3,4,5,4,5)

# Selecting Elements of Vectors
q1[5]
qll <(5,6,7,8) ]
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qil 5:8 1]
ql[ gender=="n"
mean( ql[ gender=="m"], na.rm=TRUE)

# —---Factors-—-
# Numeric Factors

# First, as a vector

workshop <- c(1,2,1,2,1,2,1,2)
workshop

table (workshop)

mean (workshop)

gender [ workshop==2 ]

# Now as a factor

workshop <- c¢(1,2,1,2,1,2,1,2)
workshop <- factor( workshop )
workshop

table (workshop)

mean (workshop) #generates error now.
gender [ workshop==2 ]

gender [ workshop=="2" 1]

# Recreate workshop, making it a factor
# including levels that don’t yet exist.
workshop <- c¢(1,2,1,2,1,2,1,2)
workshop <- factor(
workshop,
levels=c(1,2,3,4),
labels=c("R","Stata","SPSS","SAS")
)

# Recreate it with just the levels it
# curently has.
workshop <- c¢(1,2,1,2,1,2,1,2)
workshop <- factor(
workshop,
levels=c(1,2),
labels=c("R","Stata")
)

workshop
table (workshop)
gender [ workshop==2 ]
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gender [ workshop=="2" ]
gender [ workshop=="Stata" ]

# Character factors

gender <- c("f","f","f" NA,"m","m","m","m")
gender <- factor(
gender,
levels=c("m","£f"),
labels=c("Male","Female")
)

gender

table(gender)

workshop[ gender=="m"
workshop[ gender=="Male" ]

# Recreate gender and make it a factor,

# keeping simpler m and f as labels.

gender <_ C("f" |Ifll Ilfll NA llmll lImIl |Imll Ilmll)
gender <- factor(gender)

gender

# Data Frames
mydata <- data.frame(workshop,gender,ql,92,93,q94)
mydata

# Selecting components by index numbers
mydatal 8, 6 ] #8th obs, 6th var
mydatal , 6 ] #All obs, 6th var
mydatal , 6 ][ 5:8 ] #6th var, obs 5:8

# Selecting components by name

mydata$ql
mydata$qll[ 5:8 ]

Example renaming gender to sex while
creating a data frame (left as a comment)

mydata <- data.frame(workshop, sex=gender,
ql, 92, @3, q4)

# Matrices



5.9 R Program Demonstrating Programming Basics

# Creating from vectors

mymatrix <- cbind(ql, g2, g3, q4)
mymatrix

dim(mymatrix)

# Creating from matrix function
# left as a comment so we keep

# version with names ql, q2...

#

# mymatrix <- matrix(

# c(1,1, 5,1,

# 2,1, 4, 1,
# 2, 2, 4, 3,
# 3, 1, NA,3,
# 4, 5, 2, 4,
# 5, 4, 5, 5,
# 5, 3, 4, 4,
# 4, 5, 5, 5),

# nrow=8, ncol=4, byrow=TRUE)
# mymatrix

table (mymatrix)
mean(mymatrix, na.rm=TRUE)
cor (mymatrix, use="pairwise")

# Selecting Subsets of Matrices

mymatrix[ 8, 4]
mymatrix[ 5:8, 3:4]
mymatrix[ ,4][1:4]

# Lists

mylist <- list(workshop, gender,
ql, 92, g3, g4, mymatrix)

mylist

# List, this time adding names
mylist <- list(
workshop=workshop,
gender=gender,
ql=ql,
q2=q2,
q3=93,
q4=q4,
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mymatrix=mymatrix)
mylist

# Selecting components by index numbers.
mylist[[2]]

mylist[[7]]

mylist[[7]][ 5:8, 3:4 1]

# Selecting components by name.
mylist$ql
mylist$mymatrix[ 5:8, 3:4 ]

# -—-Saving Your Work---

1sQ)
objects() #same as 1s()

save.image("myall.RData")
save(mydata, file="mydata.RData")

The 2nd approach is commented to keep

the q variables for following examples.

rm(x,y,workshop,gender,ql,q2,93,94,
mymatrix,mylist)

1sQ)

save.image(file="mydata.RData")

H H H H HH

# —-——Comments to Document Your Programs--—-

# This comment is on its own line, between functions.
workshop <- c¢(1,2,1,2, #This comment is within the arguments.
1,2,1,2) #And this is at the end.

# -——Controlling Functions---

# Controlling Functions with Arguments
help(mean)

mean(x=q3, trim=.25, na.rm=TRUE)

mean (na.rm=TRUE, x=q3, trim=.25)



5.9 R Program Demonstrating Programming Basics

mean(q3, .25, TRUE)
mean(q3, t=.25, na.rm=TRUE)
# Controlling Functions With Formulas
Im( g4 ~ ql+q2+q3, data=mydata )
t.test(ql ~ gender, data=mydata)
t.test( ql[ which(gender=="Female") ],

ql[ which(gender=="Male") 1],

data=mydata) #Data ignored!

# Controlling Functions with Extractor Functions

Im( g4 ~ ql+q2+q3, data=mydata )

myModel <- 1lm( g4 ~ ql+q2+q3, data=mydata )
class (myModel)
summary (myModel)

# How Much Output Is There?
print (mymodel)

mode (myModel)
class (myModel)
names (myModel)
print( unclass(myModeel) )

myModel$coefficients
class( myModel$coefficients )
barplot ( myModel$coefficients )

# —---Writing Your Own Functions (Macros)---

myvar <- c¢(1,2,3,4,5)

# A bad function.
mystats <- function(x)

{

mean(x, na.rm=TRUE)
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sd(x, na.rm=TRUE)
}

mystats (myvar)

# A good function that just prints.
mystats <- function(x)
{
print( mean(x, na.rm=TRUE) )
print( sd(x, na.rm=TRUE) )
}

mystats (myvar)

# A function with vector output.
mystats <- function(x)

{
mymean <- mean(x, na.rm=TRUE)
mysd <- sd(x, na.rm=TRUE)
c( mean=mymean, sd=mysd )

}

mystats (myvar)
myVector <- mystats(myvar)
myVector

# A function with list output.
mystats <- function(x)

{
myinput <- x
mymean <- mean(x, na.rm=TRUE)
mysd <- sd(x, na.rm=TRUE)
list(data=myinput, mean=mymean, sd=mysd)
}

mystats (myvar)

myStatlist <- mystats(myvar)
myStatlist

mystats

save (mydata,mymatrix,mylist,mystats,
file="myAll.RData")
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Data Acquisition

R can read or import data from a wide range of sources. It includes a data
editor for manual input, and it can access files in text as well as Stata format.
For other topics, such as reading importing data from relational databases,
see the R Data Import/Export manual [39].

6.1 The R Data Editor

R has a simple spreadsheet-style data editor. Unlike Stata, you cannot use it
to create a new data frame. You can only edit an existing one. However, it
is easy to create an empty data frame, which you can then fill in using the
editor:

mydata <- edit( data.frame() )

The window in Fig. 6.1 will appear. Initially the variables are named vari,
var?2, and so on. You can easily change these names by clicking on them.
Clicking on the variable name wvar! brought up the Variable editor window
shown in the center of Fig. 6.1. We will change it to “id” and leave the
“numeric” button selected so that it will be a numeric variable. We then
close the variable editor window by clicking the usual X in the upper right
corner.

Follow the steps above until you have created the data frame shown in
Fig. 6.2. Make sure to click “character” when defining a character variable.
When you come to the NA values for observation 4, leave them blank. You
could enter the two-character string “NA” for numeric variables, but R will
not recognize that as a missing value for character variables here. Exit the
editor and save changes by choosing File> Close or by clicking the Windows
X button. There is no File>Save option, which feels quite scary the first time
you use it, but R does indeed save the data.

Notice that the variable in our ID variable matches the row names on
the leftmost edge of Fig. 6.2. R went ahead and created row names of “1,”

R.A. Muenchen, J.M. Hilbe, R for Stata Users, Statistics 91
and Computing, DOI 10.1007/978-1-4419-1318-0_6,
(© Springer Science+Business Media, LLC 2010
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Data Editor = (O
id var2 var3 var4 vars varé

1]0

i

3 Variable editor (;

4q

5 T —

6

7 type  ®numeric O character

a 1 L 1

Fig. 6.1. Adding a new variable in the data editor.

Data Editor

id workshop | gender |gil q2 g3 q4
1 1 i - 1 1 5 1
2|2 2 -+ 2 1 4 1
3 |3 3 - 2 2 4 3
4 |4 % <NA> 3 1 NA 3
S |S 1 m 4 S 2 4
6 |6 2 m S5 4 5 5
77 | 1 m 5 3 4 9
8 |8 2 m 4 5 5 5
&8 i | &)
Fig. 6.2. The data editor with our practice data entered.
“2,7...s0 why did we bother to enter them into the variable id? Because while

the data editor allows us to easily change variable names, it does not allow
us to change row names. If you are happy with its default names, you do not
need to create your own id variable. However, if you wanted to enter your own
row names using the data editor, you can enter them instead into a variable
like id and then later set that variable to be row names with the following
function call:

row.names (mydata) <- mydata$id
This function call selects id from mydata using the form,
dataframe$variable

which we will discuss further in Section 7.7, “Selecting Variables Using $
Notation.”
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Before using this data, you would also want to use the factor function to
make workshop and gender into factors.

mydata$workshop <- factor (mydata$workshop)
mydata$gender <- factor(mydata$gender)

To see how to do this with fancier value labels, see our discussion in
Section 11.1, “Value Labels or Formats (and Measurement Level).”

We now have a data frame that we can analyze, save as a perma-
nent R data file, or export in text format. R does not directly export to
Stata.

When we were initially creating the empty data frame, we could have
entered the variable names with the following function call

mydata <- data.frame(id=0., workshop=0.,
gender=" ", q1=0., g2=0., g3=0., g4=0.)

This is a major time saver when you have to create more than one copy of
the data or if you plan to create a similar data set in the future.

R has a fix function that actually calls the more aptly named edit func-
tion and then writes the data back to your original data frame. So

fix(mydata)
does the same thing as
mydata <- edit(mydata)

We recommend not using the edit function on existing data frames as we
find it all too easy to begin editing with just

edit(mydata) #Do NOT do this!

It will look identical on the screen, but this does not tell edit where to save
your work. When you exit, your work will appear to be lost. However, R
stores the last value you gave it in an object named .Last.value. So you
can retrieve the data with this function call.

mydata <- .Last.value

We will use the edit function later when renaming variables.

6.2 Reading Delimited Text Files

Delimited text files use special characters, such as spaces, tabs, or commas to
separate each data value. We will cover comma- and tab-delimited files in two
subsections below, followed by subsections that point out problems you can
have reading character (string) values and tabs.
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6.2.1 Reading Comma-Delimited Text Files

Let us first read a comma separated value (CSV) file like

workshop,gender,ql,q2,93,94
1,1,£,1,1,5,1

2,2,£,2,1,4,1
3,1,£,2,2,4,3
4,2, ,3,1, ,3
5,1,m,4,5,2,4
6,2,m,5,4,5,5
7,1,m,5,3,4,4
8,2,m,4,5,5,5

There are several important things to notice about this data.

1. The top row contains variable names. This is called the file’s header line. If
you leave the names out, R will name the variables “V1,” “V2.”...similar
to Stata’s “varl,” “var2,”...default names.!

2. ID numbers are in the leftmost column, but the header line does not

contain a name like “ID” for it.

. Values are separated by commas.

. Spaces (blanks) represent missing values.

. There are no blanks before or after the character values of “m” and “f.”

. Each line of data is ended with a single stroke of the Enter key, not with

a final comma. Your operating system stores either a line feed character,
or a carriage return and a line feed. R will treat them the same.

SO W

You can read this file using the read.csv function call below. If you have
already set your working directory in your current R session, you do not need
to set it again.

> setwd("/myRfolder")
> mydata <- read.csv("mydata.csv")
> mydata

workshop gender ql g2 q3 q4

1 1 f 11 56 1
2 2 f 2 1 4 1
3 1 f 2 2 4 3
4 2 3 1 NA 3
5 1 m 4 5 2 4

! Note the inconsistency with R’s own data editor, which uses the default names,
“varl,” “var2,”....



6.2 Reading Delimited Text Files 95

6 2 m 5 4 5 5
7 1 m 5 3 4 4
8 2 m 4 5 5 5

Notice that it read the id variable and stored it automatically in row names
position on the left side of the data frame. It did that because R found eight
columns of data but only seven names. Whenever R finds one fewer names
than columns, it assumes the first column must be an id variable.

So what does R do when the header line does contain a name for the first
column, like the following?

id,workshop,gender,ql,q2,q93,q94
1,1,f,1,1,5,1
2,2,f,2,1,4,1

If we read the file exactly as before, we would have an additional vari-
able named “id.” R would also create row names of “1,” “2)”..., but our
ID variable may have contained more useful information. Not getting your
ID variable into the row names attribute does not cause any major prob-
lems, but R will automatically identify observations by their row names,
so if you have an ID variable, it makes sense to get it into the row names
attribute.

To tell R which variable contains the row names, we add the row.names
argument.

> mydata <- read.csv("mydatalID.csv",
+  row.names="id")

> mydata

workshop gender ql g2 g3 q4
1 1 f 11 5 1
2 2 f 2 1 4 1

When we let R figure out that there was an ID variable, it had to be the
first column. That is usually where ID variables reside, but if you ever have
one in another location, then you will have to use the row.names argument
to store it in the row names attribute.

6.2.2 Reading Tab-Delimited Text Files

Reading tab-delimited files in R is done very similarly to comma-delimited
files, but uses the read.delim function.
The following is the tab-delimited text file we will read.
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workshop gender qil q2 q3 g4
1 1 £ 11 5 1
2 2 £ 2 1 4 1
3 1 f 2 2 4 3
4 2 3 1 3
5 1 m 4 5 2 4
6 2 m 5 4 5 5
7 1 m 5 3 4 4
8 2 m 4 5 5 b

There are several important things to notice about this data.

1. The top row contains variable names, each of which are separated by a
single tab. There is no tab before the first variable name, even though
adding one would make it line up with the workshop values better!

2. ID numbers are in the leftmost column, but that column is not named in

the header line with the other variable names.

. The data values are separated by a single tab character.

4. Two tab characters in a row represent a missing value. There are no spaces
between the tabs. In other words, the space bar was never pressed when
this file was created.

w

As with comma separated values, the fact that R sees eight variables with
only seven names tells it that the first column is an ID variable to store in
the row names attribute.

> setwd("/myRfolder")

> mydata <- read.table("mydata.tab")

> mydata

workshop gender ql g2 g3 q4
1 1 f 11 5 1
2 2 f 2 1 4 1
3 1 f 2 2 4 3
4 2 <KNA> 3 1 NA 3
5 1 m 4 5 2 4
6 2 m 5 4 5 5
7 1 m 5 3 4 4
8 2 m 4 5 5 5

Now let us read a file that includes a name for our ID variable:

id workshop gender ql 92 93 g4
1 1 f 1 1 5
2 2 f 2 1 4 1
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We can read this file format with exactly the same command that we used
earlier. However, the ID variable would not end up stored in the row names
attribute. So R would not know to use it in functions that identify observa-
tions. We can correct that by adding the row.names argument:

> mydata <- read.csv("mydataID.csv",
+ row.names="id")

> mydata

workshop gender ql g2 q3 q4
1 1 f 1 1 5 1
2 2 f 2 1 4 1

6.2.3 Missing Values for Character Variables

In the previous two subsections, we ignored a potential problem. The missing
value for variable q3 was always displayed as NA, Not Available. However,
the missing value for gender was displayed as a blank.

If we had entered R’s standard missing value, “NA,” where we had missing
values, then even the character data would have shown up as missing. However,
few other programs write out NA as missing.

Just as in Stata, you can read blanks as character values, and R will not
set them to missing unless you specifically tell it to do so. Often, it is not
very important to set those values to missing. A person’s address is a good
example. If we do not know it, there is little need to set it to be missing.

However, when you need to use a character variable in an analysis, setting
it to be missing is, of course, very important. Later in the book we will use
gender in analyses, so we must make sure that blank values are set to missing.

In our comma-delimited file, the missing value for gender was entered as
a single space. Therefore, the argument na.char=" " added to any of the
comma-delimited examples will set the value to missing. Note there is a single
space between the quotes in that argument.

In our tab-delimited file, the missing value for gender was entered as noth-
ing between two tabs (i.e., just two tabs in a row). Therefore, the argument
na.char="" added to any of the tab-delimited examples will set the value to
missing. Note that there is now no space between the quotes in that argument.

However, in both comma- and tab-delimited files, it is very easy to acci-
dentally have blanks where you think there are none or to enter more than
you meant. Then your na.char setting will be wrong for some cases.

It is best to use a solution that will get rid of all trailing blanks.
That is what the argument strip.white=TRUE does. When you use that,
na.char="" will work regardless of how many blanks may have been there
before.
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Let us try it with our comma-delimited file, since it contains a blank we
can get rid of

> mydata <- read.csv("mydataID.csv",
+ row.names="id",
+ strip.white=TRUE,

+ na.strings="" )
> mydata

workshop gender ql g2 g3 q4
1 1 f 1 1 5 1
2 2 f 2 1 4 1
3 1 f 2 2 4 3
4 2 <KNA> 3 1 NA 3
5 1 m 4 5 2 4
6 2 m 5 4 5 5
7 1 m 5 3 4 4
8 2 m 4 5 5 5

The only difference between this output and the last one we read for
mydatalD.csv is that gender is shown as <NA> now instead of blank. R adds
angle brackets, “<>’ around the value so you can tell NA stands for Not
Available (missing) rather than something meaningful, such as North America.

The strip.white=TRUE argument also provides the benefit of getting rid
of trailing blanks that that would set some genders equal to "m" and others
to"m "or "m ". We do not want trailing blanks to accidentally split the
males into different groups!

Finally, getting rid of trailing blanks saves space. Since R, like Stata, stores
its data in your computer’s main memory, saving space is very important.

6.2.4 Trouble with Tabs

In many text editors, including R’s, tabs are invisible. That makes it easy to
enter an additional tab or two, throwing R off track.

If R complains of too many names in the header line, or not enough values
on data lines, or if it creates more variables than you expected, often you have
an inconsistent number of tabs somewhere.

Check the header line that contains your variable names and the first few
lines of data for extra tabs, especially at the beginning or end of a line. If you
have an ID variable in the first column and it is not named in your header
line, it is very tempting to put a tab before the first variable name. That will
get it to line up over the first column, but it will also tell R that your first
variable name is missing!

If you have a data file that has some short values and some very long values
in the same column, the person who entered it may have put two tabs after the
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short values to get the following column to line up again. In that case, you can
read it with the read.table function. That function has greater flexibility for
reading delimited files, and, in fact, the read.csv and read.delim functions
do their work by calling the read.table function with several arguments set.

When a file has varying number of tabs between values, read.table can
read it because its default delimiter is any number of tabs and/or spaces!
However, this also means that you cannot represent missing values by entering
two tabs in a row, or even by putting a space between two tabs. With our
practice tabbed data set, it would generate the error message “line 4 did
not have 7 elements.” In that case, you must enter some code to represent
missing. The value “NA” is the one that R understands automatically, for
both numeric and character values. If you use any other codes, such as “.” or
“999,” see Section 10.5, “Missing Values” to learn how to handle them.

With read.table, if you specify the argument, delim="\t", then it uses
one single tab as a delimiter.

6.2.5 Skipping Variables in Delimited Files

As with Stata, R must hold all its data in your computer’s main memory.
This makes skipping columns while reading data particularly important.

The following is the R function call to read the data while skipping the
fourth and fifth columns. If you have already set your working directory in
your current R session, you do not need to set it again.

> setwd("/myRfolder")

> myCols <- read.delim("mydata.tab",

+ strip.white=TRUE,

+ na.strings="",

+ colClasses=c("integer", "integer", "character",
+ "NULL", "NULL", "integer", "integer") )

> myCols

workshop gender q3 g4
1 1 f 5 1
2 2 f 4 1
3 1 f 4 3
4 2 <NA> NA 3
5 1 m 2 4
6 2 m 5 5
7 1 m 4 4
8 2 m 5 5
>

> # Clean up and save workspace.
> rm(myCols)
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We used the name myCols to avoid overwriting mydata. You use the
colClasses argument to specify the class of each column. The classes include
logical (TRUE/FALSE), integer (whole numbers), numeric (can include dec-
imals), character (alphanumeric string values), and factor (categorical values
like gender). See the help file for other classes like dates. The class we need
for this example is NULL. We use it to drop variables.

However, colClasses requires you to specify the classes of all columns,
including any initial ID or row names variable. The classes must be included
within quotes since they are character strings. The colClasses argument is
also helpful for reading other variable types such as dates.

6.2.6 Example Programs for Reading Delimited Text Files
Stata Program for Reading Delimited Text Files

Stata can read comma-delimited files having variable names on the first line,
or it can read a file having no imbedded variable names. Use of the “names”
option tells Stata that the first line consists of variable names, otherwise it
assumes that all observations are to be read as data. For this example, we
specify names for the columns of data in a comma-delimited text file called
mydatalD.txt. The infile command is used for this purpose. Following read-
ing in the data, we use the 1ist command to display the data in the RESULTS
window. Note that Stata has a number of alternative data reading capabilities.

In the files we read below, mydatalD.csv and mydatalD.tab, the id variable
is named, along with the other variables, in the first line of the file. That is
the style best read by Stata and most other statistics programs.

* Filename: ReadDelimited.do

*---comma-delimited File---

clear

insheet using "C:\myRfolder\mydataID.csv", comma names
list

*---tab-delimited File---

clear

insheet using "C:\myRfolder\mydataID.tab", tab names
list

save "C:\myRfolder\mydata.dta", replace

R Program for Reading Delimited Text Files

In these examples, the files mydata.csv and mydata.tab both contain an ID
variable in column 1. However, the first line of the files, which containing
variable names (the header line), does not name the ID variable. That is the
style that R prefers. The versions named, mydatalD.csv and mydatalD.tab,
include the name of the ID variable.
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# Filename: ReadDelimited.R
setwd ("/myRfolder")
#---comma-delimited File---

# Read comma-delimited file.
# With id variable not named.

mydata <- read.csv("mydata.csv")
mydata

# Read a similar comma-delimited file.
# This time the id variable is named.

mydata <- read.csv("mydataID.csv",
row.names="id")
mydata

#---tab-delimited File——-

# Read a tab-delimited file with un-named ID column.
mydata <- read.delim("mydata.tab")
mydata

# Read a similar tab-delimited file.
# This time the id variable is named.

mydata <- read.delim("mydataID.tab",
row.names="id")
mydata

#---Stripping Out White Space---

mydata <- read.csv("mydataID.csv",
row.names="id",
strip.white=TRUE,
na.strings="" )

mydata

#---Using colClasses to skip ql and g2 with NULL---

myCols <- read.delim("mydata.tab",

101
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strip.white=TRUE,
na.strings="",
colClasses=c("integer", "integer", "character",
"NULL", "NULL", "integer", "integer") )
myCols

# Clean up and save workspace.
rm(myCols)

save.image(file="mydata.RData")

6.3 Reading Text Data Within a Program

It is often useful to have a small data set entered inside a program. This
approach is popular when teaching or for an example when you post a question
on Internet discussion lists. You only have one file and anyone can copy it and
run it without changing it to locate a data file. Stata does this using the input
command.

Although beginners are often drawn to this approach due to its simplicity,
it is not a good idea to use this for more than a few dozen observations. To
see the top and bottom of your program requires scrolling past all of the data,
which is needlessly time-consuming. As we will soon see, R also displays the
data in the console, scrolling potential error messages off the screen if there
is more than a screen’s worth of data.

We will discuss two ways to read data within an R program: one that is
easy and one that is more generally applicable.

6.3.1 The Easy Approach

The easy approach is to nest the stdin function within any other R function
that reads data. It tells R that the data is coming from the the same place
the program is, which is called the standard input.

In our next example, we will use comma separated value (CSV) format,
so we will nest a call to the stdin function within a call to the read.csv
function.

mydata <- read.csv( stdin() )
workshop,gender,ql,92,93,q94
1,1,£,1,1,5,1
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# Blank line above ends input.
mydata

Note that we actually typed “NA” in for missing values, and we were careful
to never add any spaces before or after the gender values of “m” or “f.” That
let us dispense with any additional arguments for the read.csv function. Of
course, you could instead enter the data as any example in this chapter, in
which case you would need to include the arguments to match the data.

Let us run this example and see what the output looks like.

> mydata <- read.csv( stdin() )
0: workshop,gender,ql,q2,93,q94
1: 1,1,£,1,1,5,1
2: 2,2,f,2,1,4,1
3: 3,1,£,2,2,4,3
4: 4,2,NA,3,1,NA,3
5: 5,1,m,4,5,2,4
6: 6,2,m,5,4,5,5
7: 7,1,m,5,3,4,4
8: 8,2,m,4,5,5,5
9
> # Blank line above ends input.
> mydata

workshop gender ql g2 q3 q4
1 1 f 1 1 5 1
2 2 f 2 1 4 1
3 1 f 2 2 4 3
4 2 <NA> 3 1 NA 3
5 1 m 4 5 2 4
6 2 m 5 4 5 5
7 1 m 5 3 4 4
8 2 m 4 5 5 5

We often add blank lines between sections of output to make it easier to
read, but given that a blank line is actually used to end the data, we do not
do so with this output.

You can see that R displays the data itself, and it prefixes each line with
“0:7, “1:7, «2:7. ... With all of the data displayed, this is obviously not some-
thing you would want to do with hundreds of observations! When we read
data from files, we saw that R did not display it in the console.

The ninth line shows that it is blank and the numeric prefixing stops as R
returns to its usual “>” prompt. It is the blank line that tells R that there is
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no more data. If you forget it, R will read your next program lines as data,
continuing until it finds a blank line!

Printing the data by entering mydata shows us that the row names were
correctly assigned and the two missing values are also correct.

6.3.2 The More General Approach

The previous subsection showed how to read data in the middle of an R
program, and it required only a minor change. It had one important limitation
however: you cannot use stdin to read data in programs that are sourced
(included) from files.

Since putting data in the middle of a file is often done for interactive
demonstrations, that is not often a serious limitation. However, there are
times when you want to put the whole program, including data, in a separate
file like “myprog.R” and bring it into R with the command

source ("myprog.R")

To do this, we can place the whole data set into a character vector with a
single value named “mystring”:

mystring <-
"workshop,gender,ql,92,93,q4
1,1,£,1,1,5,1

2,2,f
3,1,f,2,2,4,
4,2,NA,3,1,N
5,1,m
6,2,m
7,1,m

8,2,m,4,5,5,5"
mydata <- read.csv( textConnection(mystring) )
mydata

Note that the c function is not used to combine all of those values into
a vector. At the moment, the whole data set is one single character value!
The textConnection function converts mystring into the equivalent of a file,
which R then processes the same way as it would a file.

mydata <- read.csv( textConnection(mystring) )

6.3.3 Example Programs for Reading Text Data Within a Program
Stata Program for Reading Text Data Within a Program

* Filename: ReadWithin.do
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clear all
input id workshop strl gender ql-q4, automatic

0 ~N O Ul d WN =
N = NE NN
g8 88 8 -
OO W N
g wdh R, N

end

[a
-
n

ct

R Program for Reading Text Data Within a Program

# Filename: ReadWithin.R

# The stdin approach.

mydata <- read.csv( stdin() )
workshop,gender,ql,q2,93,94
1,1,f,1,1,5,1

# Blank line above ends input.
mydata

# The textConnection approach
# that works when sourcing files.

mystring <-
"workshop,gender,ql,92,q93,q4
1,1,£,1,1,5,1
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mydata <- read.csv( textConnection(mystring) )
mydata

# Set working directory & save workspace.
setwd ("/myRfolder")

save.image(file="mydata.RData")

6.4 Reading Fixed-Width Text Files, One Record
per Case

Files that separate data values with delimiters such as spaces or commas are
convenient for people to work with, but they make a file larger. So many text
files dispense with such conveniences and instead keep variable values locked
into the exact same column(s) of every record.

If you have a nondelimited text file with one record per case, you can read
it using the following approach. R has nowhere near the flexibility in reading
fixed-width text files that Stata has. As you will soon see, making an error
specifying the width of one variable will result in reading the wrong columns
for all those that follow. While Stata offer approaches that would do that too,
we do not recommend their use.

Other languages such as Perl or Python are extremely good at reading
text files and converting them to a form that R can easily read.

Below is the same data that we used in other examples, but now it is in
fixed-width format.

011£1151
022£2141
031£2243
042 31 3
051m4524
062m5455
071mb5344
082m4555

The important things to notice about this file are the following:

1. No names appear on first line.

. Nothing separates values.

3. The first value of each record is two columns wide; the remainder take
only one column each.

4. Blanks represent missing values, but we could use any other character that
would fit into the fixed number of columns allocated to each variable.

[\
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5. The last line of the file contains data. That is what Stata expects, but
R generates a warning that there is an “incomplete final line found.” It
works fine though. If the warning in R bothers you, simply edit the file
and press Enter once at the end of the last line.

The R function that reads fixed-width files is read.fwf. The following is
an example of it reading the above file:

> setwd("/myRfolder")

> mydata <- read.fwf (

+ file="mydataFWF.txt",

+ width=c(2,-1,1,1,1,1,1),

+ col.names=c("id", "gender", "qi", "qg2", "q3", "q4"),
+ row.names="id",

+ na.strings="",

+ f£i11=TRUE,

+ strip.white=TRUE)

Warning message:

In readlLines(file, n = thisblock)
incomplete final line found on ’mydataFWF.txt’

> mydata

gender gl g2 g3 g4
1 f 1 1 5 1
2 f 2 1 4 1
3 f 2 2 4 3
4 <NA> 3 1 NA 3
5 m 3 5 2 4
6 m 5 4 5 5
7 m 5 3 4 4
8 m 4 5 5 5

The read.fwf function call above uses seven arguments:

1. The file argument lists the name of the file. It will read it from
your current working directory. You can set the working directory with
setwd("path") or you can specify a path as part of the file specification.
We have been using the file argument in most of our previous examples,
but we never bothered to name it. Since the file argument is the first
one for this function, people typically just list it first. However, we list it
here to remind you that all arguments do have names.

2. The width argument provides the width, or number of columns, required
by each variable in order. The widths we supplied as a numeric vector are
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created using the ¢ function. The first number, 2, tells R to read ID from
columns 1 and 2. The next number, —1, tells R to skip one column. In
our next example, we will not need to read the workshop variable, so we
will put in a —1 to skip it now. The remaining pattern of 1, 1, 1, 1, 1 tells
R that each for of the remaining five variables will require one column
each. Be very careful at this step! If you made an error and told R that ID
was 1 column wide, then read.fwf would read all of the other variables
from the wrong columns. When you are reading many variables, specifying
their length by listing them all like this is tedious. You can make this task
much easier by using R’s ability to generate vectors of repetitive patterns.
For details, see Chapter 12, “Generating Data.”

3. The col.names argument provides the column or variable names. Those,
too, we provide in a character vector. We create it using the c¢ function,
c("id","gender","ql","q2","q3","q4"). Since the names are charac-
ter (string) data, we must enclose them in quotes. Names can also be
tedious to enter. R’s ability to generate vectors of repetitive patterns com-
bined with the paste function can generate long sets of variable names.
For details, see Chapter 12, “Generating Data.”

4. The row.names argument tells R that we have a variable that stores a
name or identifier for each row. It also tells it which of the variable names
from the col.names argument that is: “id.”

5. The na.strings="" argument tells R that an empty field is a missing
value. It already is for numeric data, but, as in Stata, a blank is a valid
character value. Note that there is no blank between the quotes! That is
because we set the strip.white option to strip out extra blanks from
the end of strings. As you see, R displays missing data for character data
within angle brackets as <NA>.

6. The £i11 argument tells R to fill in blank spaces if the file contains lines
that are not of the full length (like the Stata £illin command). Now is a
good time to stop and enter help(read.fwf). Note that there is no £ill
argument offered. It does, however, list its last argument as “....” This
means that it will pass any additional arguments on to another function
that read.fwf might call. In this case, it is the read.table function.
Clicking the link to that function will reveal the £ill argument and what
it does.

7. The strip.white argument tells R to remove any additional blanks it
finds in character data values. Therefore, if we were reading a long text
string like "Bob " it will delete the additional spaces and store just
"Bob". That saves space and makes logical comparisons easier. It is all too
easy to count the number of blanks incorrectly when making a comparison
like name=="Bob ",

The file was read just fine. The warning message about an “incomplete
final line” is caused by the lack of a blank line at the end of the file. Stata
would not display a warning message about such a condition.
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The read.fwf function calls the read.table function to do its work, so
you can use any of those arguments here as well. For example, you could use
stringsAsFactors to prevent R from converting string variables to factors,
as it would do here by default.

6.4.1 Macro Substitution

The above example is a good one to use to begin to learn what Stata would
call macro substitution. This approach makes your programs much easier to
write and maintain. The most interesting aspect to macro substitution in R
is that R has no macro language! R is powerful enough to do this using its
standard features.

Since file paths often get quite long, we will store it in a character vector
named myfile. This approach also lets you put all of the file references you use
at the top of your programs, so you can change them easily. We do this with
the assignment

myfile <- "mydataFWF.txt"

Next, we will store our variable names in another character vector,
myVariableNames. This makes it much easier to manage when you have a
more realistic data set that may contain hundreds of variables:

myVariableNames <- c("id", "gender", "qi", "g2", "q3", "q4")

Now we will do the same with our variable widths. This makes our next
example, which reads multiple records per case, much easier.

myVariableWidths <- c(2, -1, 1, 1, 1, 1, 1)
Finally we will put it all together in a call to the read.fwf function.

> mydata <- read.fwf(

+ file=myfile,

+ width=myVariableWidths,

+ col.names=myVariableNames,
+ row.names="id",
+ na.strings="",
+ £i11=TRUE,
+ strip.white=TRUE)

Warning message:

In readlines(file, n = thisblock)
incomplete final line found on mydataFWF txt’
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6.4.2 Example Programs for Reading Fixed-Width Text Files,
One Record Per Case

These programs do not save the data, since they skip the workshop variable
for demonstration purposes.

Stata Program for Fixed-Width Text Files, One Record per Case

* Filename: ReadFWF1.do

infix id 1-2 workshop 3 gender 4 q1 56 q2 6 g3 7 q4 8 ///
using c:\myRfolder\mydataFWF.txt, clear
list

R Program for Fixed-Width Text Files, One Record per Case

# Filename: ReadFWF1.R

setwd ("/myRfolder")

mydata <- read.fwf(
file="mydataFWF.txt",
width=c(2,-1,1,1,1,1,1),
col.names=c("id","gender","ql","q2","q3","q4"),
row.names="id",
na.strings="",

£i11=TRUE,
strip.white=TRUE)
mydata

# Now we’ll use "macro" substitution to do the same thing.

myfile <- "mydataFWF.txt"
myVariableNames <- c("id","gender","ql1","q2","q3","q4")
myVariableWidths <- c(2,-1,1,1,1,1,1)

mydata <- read.fwf(
file=myfile,
width=myVariableWidths,
col.names=myVariableNames,
row.names="id",
na.strings="",
£i11=TRUE,
strip.white=TRUE)

mydata
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6.5 Reading Fixed-Width Text Files, Two or More
Records per Case

It is common to have to read several records per case. In this section we will
read two records per case, but it is easy to generalize from that to any number
of records. This section builds on Section 6.4, so if you have not just finished
reading it, you will want to do so now. We will only use the macro substitution
form in this example.

First, we will store the filename in the character vector named myfile:

myfile <- "mydataFWF.txt"

Next, we will store the variable names in another character vector. We will
pretend that our same file now has two records per case with ql to q4 on the
first record and g5 to g8 in the same columns on the second. Even though id,
group, and gender appear on every line, we will not read them again from the
second line. Here are our variable names:

myVariableNames <- c("id", "group", "gender",
llqlll s llq2|l , Ilq3l| s Ilq4ll s
llq5ll s llq6ll , Ilq7ll s Ilq8ll )

Now we need to specify the columns to read. We must store the column
widths for each line of data (per case) in its own vector. Note that on record 2
we begin with —2, —1, —1 to skip the values for id, group, and gender.

myRecordiWidths <- c¢( 2, 1, 1, 1, 1, 1, 1)
myRecord2Widths <- c(-2,-1,-1, 1, 1, 1, 1)

Next, we need to store both of the above variables in a list. The following
call to the 1ist function combines the two record width vectors into one list
named myVariableWidths:

myVariableWidths <- list( myRecordlWidths, myRecord2Widths )
Let us look at the new list:

> myVariableWidths
(r111]
112111111

[[2]1]
1] -2-1-1 1 1 1 1

You can see that the component labeled [[1]] is the first numeric vector
and the one labeled [[2]] is the second. The fact that the list contains two
components tells the width argument that we have two records per case. Now
we are ready to use the read.fwf function to read the data file:
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> mydata <- read.fwf(

+ file=myfile,

+ width=myVariableWidths,

+ col.names=myVariableNames,
+ row.names="id",
+ na.strings="",
+ fi11=TRUE,
+ strip.white=TRUE)

Warning message:

incomplete final line found by readlLines on ’mydataFWF.txt’
in: readLines(file, n = thisblock)

> mydata

group gender ql g2 g3 g4 g5 g6 q7 g8
1 1 f 116 1 2 1 4 1
3 1 f 2 2 4 3 3 1NA 3
5 1 m 3 5 2 4 5 4 5 5
7 1 m 5 3 4 4 4 5 5 5

You can see we now have only four records and eight q variables, so it has
worked well. It is also finally obvious that the row names do not always come
out as simple sequential numbers. It just so happened that is what we have
had until now. Because we are setting our row names from our id variable and
we are reading two records per case, we end up with only the odd-numbered
values. However, if we had let R create its own row names, they would have
ended up, “1,” “2,” “3,” and “4.”

As earlier, the warning message is caused by the lack of a blank line at the
end of the file. That does not cause problems.

6.5.1 Example Programs to Read Fixed-Width Text Files
with Two Records per Case

Stata Program to Read Two Records per Case

* Filename: ReadFWF2.do

clear

#delimit ;

infix 2 lines 1: id 1-2 workshop 3 gender 4 //

ql 592 6 g3 7 g4 8

2: g5 5 g6 6 q7 7 98 8 using c:\myRfolder\mydataFWF.txt;
#delimit cr

list
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R Program to Read Two Records per Case

# Filename: ReadFWF2.R
setwd ("/myRfolder")

# Set all of the values to use.
myfile <- "mydataFWF.txt"
myVariableNames <- c("id","group", "gender",
"ql","q2","q3", "q4",
"g5","q6","q7","q8")
myRecordiWidths <- c( 2, 1, 1, 1, 1, 1, 1)
myRecord2Widths <- c(-2,-1,-1, 1, 1, 1, 1)
myVariableWidths <- list(myRecordiWidths,myRecord2Widths)

#Now plug them in and read the data:
mydata <- read.fwf(
file=myfile,
width=myVariableWidths,
col.names=myVariableNames,
row.names="id",
na.strings="",

£i11=TRUE,
strip.white=TRUE )
mydata

6.6 Importing Data from Stata into R

R can read a Stata data set in a standard “dta” file using R’s built-in foreign
package. That is the most widely-documented approach. However, when we
wrote this, that approach read only the older version 8 or 9 format. If the
data file is saved as a version 10 file or later, you must save it again using the
command saveold.

A better way to import data into R from Stata is to use the stata.get
function from Frank Harrell’s Hmisc package. It can easily bring in files from
any version of Stata, including the latest. It also has the ability to read for-
matted values, dates, variable labels, and lengths. The Hmisc package does
not come with R, but it is easy to install. For instructions, see Section 2.1,
“Installing Add-on Packages.”

Since the Hmisc package uses the foreign package, we load them both
from the library:

> library("foreign")

> library("Hmisc")
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Next, we import the file with a simple call to the stata.get function, and
print the data:

> mydata <- stata.get("c:/myRfolder/mydata.dta")

> mydata

id workshop gender ql q2 g3 g4
1 1 1 f 11 6 1
2 2 2 £f 2 1 4 1
3 3 1 £f 2 2 4 3
4 4 2 3 1NA 3
5 5 1 m 4 5 2 4
6 6 2 m 5 4 5 5
T 7 1 m 5 3 4 4
8 8 2 m 4 5 5 5

For more information on using Stata files, see Data Analysis Using Stata
[25], the Base Reference Manual [45], or the Data-Management Reference
Manual [46]. The latter is a large volume detailing every aspect of managing
data in Stata, including the importing and exporting of data.

6.6.1 R Program to Import Data from Stata

# Filename: ImportFromStata.R

library("foreign")

library("Hmisc")

mydata <- stata.get("c:/myRfolder/mydata.dta")
mydata

6.7 Writing Data to a Comma-Delimited Text File

If you need to export data from R to another package, the comma separated
value file is a good way to do it. R can write data to a standard CSV file,
and it can write one formatted specifically for Stata, along with a do file to
read it.

You can write a comma-delimited CSV file from R using the write.csv
function. It writes CSV files the same way the read.csv function reads them,
using many of the same arguments.

write.csv(mydata,
file="mydataExported.csv", na="")
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The argument, na="" tells R to write out nothing for missing values. If you
leave that out, it will write out “NA” instead.

When you are exporting data from R, it is helpful to be able to open the
file(s) under program control. That way you can adjust the arguments until
you get what you need.

To look at the contents of any text file in R, you can use the file.show
function. Let us use it to see the file we just created.

> file.show("mydataExported.txt")

nn , llgender" , llqlll , llq2|| , llqsll , l|q4ll

Illll,llfll’1,1’5,1

Il2l|,llfll,2,1’4’1

Il3ll’llfll’2’2’4

"4",NA,3,1,NA

|l5||’llmll,3 5’2’

"6","111",5,4,5

Il7l|,llmll’5 3 4
m",4,5,5

Il8ll’ll |I’

B

B

The write.csv function actually uses the write.table function with
some convenient options set, such as commas as delimiters. If you need to
write the file out in a different format, write.table offers a very fine level of
control. See help(write.table) for details.

6.7.1 Example Programs for Writing a Comma-Delimited File
Stata Program for Writing a CSV File

* Filename: WriteToText.do

use c:\myRfolder\mydata,clear
outfile using c:\myRfolder\mydata.csv, comma
type mydata.csv

R Program for Writing a CSV File

# Filename: WriteToText.R

write.csv(mydata,
file="mydataExported.csv", na="")
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6.8 Exporting Data from R to Stata

The foreign package contains a function specifically aimed at exporting data
to other packages, including Stata. Its write.foreign function writes out
a comma-delimited text file along with a matching Stata program file. To
complete the importation into Stata, you must edit the program file in Stata,
then execute it to read the text file, and, finally, create a data set.

To begin the process, you must load the foreign package.

library("foreign")
Then you call the write.foreign function:

write.foreign(mydata,
datafile="mydataExported.csv",
codefile="mydataExported.do",
package="Stata")

This function call uses four arguments:

1. The name of the R data frame you wish to export.

2. The datafile argument tells R the name of text data file. R will write
it to the current working directory unless you specify the full path in the
filename.

3. The codefile argument tells R the filename of a program that Stata can
use to read the text data file. You will have to use this file in Stata to
read the data file and create a Stata-formatted file.

4. The package argument takes the value "Stata" to determine which type
of program R writes to the codefile location.

We can use the file.show function to pop up windows and examine
the files.

file.show("mydataExported.csv")
file.show("mydataExported.do")

The file mydataExported.csv is very similar to the one we wrote out using
write.csv. Notice that it uses periods as missing values, which Stata will
interpret properly.

N R NERENR N R
w -
[N,

0 ~NO O WN -
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The following is the Stata program that R created:

infile gender:gender_fmt ql g2 q3 q4 ///
using mydataExported.csv , automatic

R wrote it as one line; we split it so that it would fit on the page.

Example Program for Exporting Data from R to Stata

This program first writes out a comma-delimited file from R. Then it does it
again, along with a matching Stata do file to read it.

# Filename: ExportToStata.R
setwd ("/myRfolder")

# A standard CSV file.

write.csv(mydata,
file="mydataExported.csv", na="")

file.show("mydataExported.csv")

# A CSV for Stata with matching do file.
library("foreign")

write.foreign(mydata,
datafile="mydataExported.csv",
codefile="mydataExported.do",
package="Stata")

# Look at the contents of our new files.
file.show("mydataExported.csv")
file.show("mydataExported.do")
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Selecting Variables

In Stata, selecting variables for an analysis is simple, while selecting
observations is often a bit more complicated. In R, these two processes can
be almost identical. As a result, variable selection in R can at times be some-
what more complex. However, since you need to learn that complexity to
select observations, it is not much added effort.

Selecting observations in Stata requires you to use logical conditions with
commands like if or in. You do not usually use that logic to select vari-
ables. It is possible to do so, through the use of macros. If you have used
Stata for long, you probably know dozens of ways to select observations, but
you did not see them all in the first introductory guide you read. With R,
it is best to dive in and see all of the methods of selecting variables because
understanding them is the key to understanding other documentation, espe-
cially the help files and discussions on the R-Help mailing list. Even though
you select variables and observations in R using almost identical methods, we
will discuss them in two different chapters, with different example programs.
This chapter focuses only on selecting variables. The next chapter will use al-
most identical descriptions with examples for selecting observations. We view
that as helpful reinforcement, but no doubt some will view it as rather dull
repetition!

7.1 Selecting Variables in Stata

Selecting variables in Stata is rather simple. It is worth reviewing them now
before discussing R’s approach. Our example data set contains the following
variables: workshop, gender, ql, g2, q3, and g4. Stata lets you refer to them
by individual names or in contiguous order separated by a dash, “-,” as in

summarize workshop-q4

[1P))

You can select any variable beginning with the letter “q” using the star
operator.

R.A. Muenchen, J.M. Hilbe, R for Stata Users, Statistics 119
and Computing, DOI 10.1007/978-1-4419-1318-0_7,
(© Springer Science+Business Media, LLC 2010
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summarize g%
or
list ql-q4

Finally, if you do not tell it which variable to use, Stata uses them all. For
example, if you want Stata to summarize all variables in the data set, type
“summarize,” or abbreviate it to simply “su.”

Now let us turn our attention to how R selects variables.

7.2 Selecting All Variables

In R, if you perform some analyses without selecting any variables, the func-
tions will use all of the variables if they can. For example, to get summary
statistics on all variables (and across all observations or rows), use

summary (mydata)

The variable selection process applies to any R functions that act on vari-
ables, not all do. We will use the summary function so you will see it in the
context of an analysis.

7.3 Selecting Variables Using Index Numbers

Coming from Stata, you would think a discussion of selecting variables in R
would begin with various ways to select variables using their names. R can
use variable names, of course, but column indezxes, also called subscripts, are
more fundamental to the way R works. That is because objects in R need not
name the elements or components they contain, but you can always refer to
them by their index numbers.

Our data frame has two dimensions: rows and columns. We reference the
rows and columns using square brackets as

mydata[rows, columns]

If you leave out the row or column indexes, R will process all rows and all
columns. Therefore, the following three statements have the same result:

summary( mydata )
summary( mydatal ] )
summary( mydatal , 1 )

This chapter focuses on the second parameter, the columns (variables).
Our data frame has six variables or columns, which are automatically given
index numbers, or indexes of 1, 2, 3, 4, 5, and 6. You can select variables by
supplying one index number or a vector of indexes. For example,
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summary( mydatal ,3] )

selects all rows of the third variable or column, ql. If you leave out an index,
it will assume you want them all. If you leave the comma out completely, R
assumes you want a column, so

summary ( mydata[3] )
is almost the same as
summary( mydatal ,3] )

Both refer to our third variable, q1. While the summary function treats the
presence or absence of the comma the same, some functions will have prob-
lems. That is because with the comma, the variable selection passes a vector
and without the comma, it passes a data frame containing only one vector.
See Section 10.17, “Converting Data Structures” for details.

To select more than one variable using indexes, you combine the indexes
into a vector using the ¢ function. Therefore, this will analyze variables 3
through 6.

summary( mydatal c(3,4,5,6) 1 )

You will see the c¢ function used in many ways in R. Whenever R re-
quires one object and you need to supply it several, it combines the several
into one. In this case, the several index numbers become a single numeric
vector.

The colon operator

W,

can generate a numeric vector directly, so
summary ( mydata[3:6] )

will use the same variables.

The colon operator is not just shorthand. We saw in an earlier chap-
ter that entering 1:N causes R to generate the sequence, 1, 2, 3,...N. If
you use a negative sign on an index, you will exclude those columns. For
example:

summary( mydatal -c(3,4,5,6) 1 )

will analyze all variables except for variables 3, 4, 5, and 6. Your index values
must be either all positive or all negative. Otherwise, the result would be
illogical. You cannot say, “include only these” and “include all but these” at
the same time. Index values of zero are accepted but ignored.

The colon operator can abbreviate sequences of numbers, but you need
to be careful with negative numbers. If you want to exclude columns 3:6, the
following approach will not work:

> -3:6
[1] -3 -2 -1 0123456
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This would, of course, generate an error since you cannot exclude 3 and include
3 at the same time. Adding parentheses will clarify the situation, showing R
that you want the minus sign to apply to just the set of numbers from +3
through +6 rather than -3 through +6:

> -(3:6)
[1] -3 -4 -5 -6

Therefore, we can exclude variables 3 through 6 with
summary( mydatal -(3:6) ] )

If you find yourself working with a set of variables repeatedly, you can
easily save a vector of indexes so you will not have to keep looking up index
numbers:

myQindexes <- ¢(3,4,5,6)
summary ( mydata[myQindexes] )

You can list indexes individually or, for contiguous variables, use the colon
operator. For a large data set, you could use variables 1, 3, 5 through 20, 25,
and 30 through 100 as follows:

myindexes <- ¢(1,3,5:20,25,30:100)

This is an important advantage of this method of selecting variables. Most
of the other variable selection methods do not easily allow you to select mixed
sets of contiguous and noncontiguous variables as you are used to doing in
Stata. For another way to do this, see “Selecting Variables Using the Subset
Function”, Section 7.9.

If your variables follow patterns such as every other variable or every 10th,
see Chapter 12, “Generating Data” for ways to generate other sequences of
index numbers.

The names function will extract a vector of variable names from a data
frame. The data.frame function, as we have seen, combines one or more
vectors into a data frame and creates default row names of “1,” “2,” “3.7....
Combining these two functions is one way to quickly generate a numbered list
of variable names that you can use to look up index values:

> data.frame( names(mydata) )

names.mydata.
workshop
gender

ql

q2

q3

q4

DO WN -
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It is easy to rearrange the variables to put the four q variables in the be-
ginning of the data frame. In that way, you will easily remember, for example,
that q3 has an index value of 3 and so on.

Storing them in a separate data frame is another way to make indexes
easy to remember for sequentially numbered variables like these. However,
that approach runs into problems if you sort one data frame, as the rows then
no longer match up in a sensible way. Correlations between the two sets would
be meaningless.

The ncol function will tell you the number of columns in a data frame.
Therefore, another way to analyze all your variables is

summary ( mydatal 1:ncol(mydata) 1 )

If you remember that ql is the third variable and you want to analyze all
of the variables from there to the end, you can use

summary ( mydatal 3:ncol(mydata) 1 )

7.4 Selecting Variables Using Column Names

Variables in Stata are required to have names, and those names must be
unique. In R, you do not need them since you can refer to variables by index
numbers as described in the previous section. Amazingly enough, the names
do not have to be unique, although having two variables with the same name
would be a terrible idea! R data frames usually include variable names, as
does our example data: workshop, gender, ql, q2, q3, q4.

Stata stores its variable names within the respective data sets. However,
you do not know exactly where they reside within the data set. Their location
is irrelevant. They are in there somewhere, and that is all you need to know.
However, in R, they are stored within a data frame in a place called the
names attribute. The names function accesses that attribute, and you can
display them by entering

> names (mydata)

[1] "workshop" "gender"  "ql1" "g2" "g3" "g4"
To select a column by name, you put it in quotes, as in
summary( mydata["ql"] )
R is still using the form
mydata[row, column]

However, when you supply only one index value, it assumes it is the column.

So
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summary( mydatal ,"q1"] )

works as well. Note that the addition of the comma before the variable name
is the only difference between the two examples above. While the summary
function treats the presence or absence of the comma the same, some functions
will have problems. That is because with the comma, the selection results in a
vector, and without the comma, the selection is a data frame containing only
that vector. See Section 10.17 for details.

If you have more than one name, combine them into a single character
vector using the ¢ function. For example,

Summary( mydata[ c("ql","q2","q3","q4") ] )

Unfortunately, the colon operator does not work directly with character
prefixes as it does with indexes. So the form ql:q4 does not work in this
[{P%))

context. However, you can paste the letter “q” onto the numbers you generate
using the paste function.

manames <- paste( uqu, 1:4, sep="")

summary ( mydata[myQnames] )
The paste function call above has three arguments:

1. The string to paste, which for this example is just the letter “q.”

2. The object to paste it to, which is the numeric vector 1, 2, 3, 4 generated
by the colon operator 1:4.

3. The separator character to paste between the two. Since this is set to
"t the function will put nothing between “q” and “1,” then “q” and
“2,” and so on. R will store the resulting names “ql,” “q2,” “q3,” “q4”
in the character vector myQnames. You can use this approach to gen-
erate variable names to use in a variety of circumstances. Note that
merely changing the 1:4 above to 1:400 would generate the sequence
from ql to q400. R can easily generate other patterns of repeating values
that you can use to create variable names. For details, see Chapter 12,
“Generating Data.” For another way to select variables by name using
the colon operator, see “Selecting Variables Using the Subset Function,”
Section 7.9.

7.5 Selecting Variables Using Logic

You can select a column by using a logical vector of TRUE/FALSE values.
You can enter one manually or create one by specifying a logical condition.
Let us begin by entering one manually. For example,

summary ( mydatal c(FALSE,FALSE,TRUE,FALSE,FALSE,FALSE) ] )
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will select the third column, q1, because the third value is TRUE and the third
column is ql. In Stata, the digits 1 and 0 can represent TRUE and FALSE,
respectively. They can do this in R, but they first require processing by the
as.logical function. Therefore, we could also select the third variable with

summary( mydatal as.logical( ¢(0,0,1,0,0,0) ) 1 )

If we had not converted the 0/1 values to logical FALSE/TRUE, the above
function call would have asked for two variables with index values of zero. Zero
is a valid value, but it is is ignored. It would have then asked for the variable
in column 1, which is workshop. Finally, it would have asked for three more
variables in column zero. The result would have been an analysis only for the
first variable, workshop. It would have been a perfectly valid, if odd, request!

Luckily, you do not have to actually enter logical vectors like the ones
above. Instead, you will generate a vector by entering a logical statement
such as

names (mydata)=="q1"

That logical comparison will generate the following logical vector for you:
FALSE, FALSE, TRUE, FALSE, FALSE, FALSE

Therefore, another way of analyzing ql is
summary ( mydatal[ names(mydata)=="qi1" ] )

While that example is good for educational purposes, in actual use you
would prefer one of the shorter approach using variable names:

summary ( mydata["ql1"] )

Once you have mastered the various approaches of variable selection, you
will find yourself alternating among the methods, as each has its advantages
in different circumstances.

The “==” operator compares every element of a vector to a value and
returns a logical vector of TRUE/FALSE values. The vector length will match
the number of variables, not the number of observations, so we cannot store
it in our data frame. So if we have assigned it to an object name, it would
just exist as a vector in our R workspace.

As in Stata, the “!” sign represents NOT, so you can also use that vector
to get all of the variables except for ql using the form

summary ( mydatal !'names(mydata)=="qi1" ] )

To use logic to select multiple variable names, we can use the OR operator,
—. For example, select q1 through g4 with the following approach. Complex
selections like this are much easier when you do it in two steps. First, create
the logical vector and store it; then use that vector to do your selection. In
the name myQtf below, I am using the “tf” part to represent TRUE/FALSE.
That will help us remind that this is a logical vector.

“
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myQtf <- names(mydata)=="q1" |
names (mydata)=="q2" |
names (mydata)=="q3" |
names (mydata)=="q4"

Then we can get summary statistics on those variables using
summary ( mydata[myQtf] )

Whenever you are making comparisons to many values, you can use the
%inY operator. This will generate exactly the same logical vector as the OR
example above.

myQtf <- names(mydata) %in% c("ql","q2","q3","q4")
summary ( mydata[myQtf] )

You can easily convert a logical vector into an index vector that will
select the same variables. For details, see “Converting Data Structures,”
Section 10.17.

7.6 Selecting Variables Using String Search

You can select variables by searching all of the variable names for strings of
text. This approach uses the methods of selection by index numbers, names,
and logic as discussed above, so make sure you have mastered them before
trying this.

Stata uses the form

keep qg*

to select all of the variables that begin with the letter q.

R searches variable names for patterns using the grep function. The name
grep itself stands for Global Regular Expression Print. It is just a fancy name
for a type of search.

The grep function creates a vector containing variable selection criteria
we need in the form of indexes, names, or TRUE/FALSE logical values. The
grep function and the rules that it follows, called regular expressions, appear
in many different software packages and operating systems.

Below we will use the grep function to find the index numbers for names
for those that begin with the letter q:

myQindexes <- grep(""q", names(mydata), value=FALSE)

The grep function call above uses three arguments:
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[13a bl

1. The first is the command string, or regular expression, “~p”, which means,
“find strings that begin with lowercase p.” The symbol “~” represents
“begins with.” You can use any regular expression here, allowing you to
search for a wide range of patterns in variable names. We will discuss
using wildcard patterns later.

2. The second argument is the character vector that you wish to search,
which, in our case, is our variable names. Substituting names (mydata)
here will extract those names.

3. The value argument tells it what to return when it finds a match. The goal
of grep in any computer language or operating system is to find patterns.
A value of TRUE here will tell it to return the variable names that match
the pattern we seek. However, in R, indexes are more important than
names, so the default setting is FALSE to return indexes instead. We
could leave it off in this particular case, but we will use it the other way
in the next example so we will list it here for educational purposes.

The contents of myQindexes will be 3, 4, 5, 6. In all our examples that use
that name, it will have those same values.
To analyze those variables, we can then use

summary ( mydata[myQindexes] )

Now let us do the same thing but have the grep function save the actual
variable names. All we have to do is set value=TRUE.

myQnames <- grep(""q", names(mydata), value=TRUE)

The character vector myQnames now contains the variable names “ql,” “q2,”
“q3,” and “q4” and we can analyze those variables with

summary( mydata[myQnames] )

This approach gets what we expected: variable names. Since it uses names,
it makes much more sense to a Stata user. So, why we did not do this first?
Because in R, indexes are more flexible than variable names.

Finally, let us see how we would use this search method to select variables
using logic. The %inY% function works just like the in operator in Stata.

It finds things that occur in a list. We will use it to find when a member of
all our variable names appears in the list of names beginning with “q” (stored
in myQnames). The result will be a logical set of TRUE/FALSE values that
indicate that the q variables are the last four:

FALSE, FALSE, TRUE, TRUE, TRUE, TRUE
We will store those values in the logical vector myQtf:
myQtf <- names(mydata) %in% myQnames

Now we can use the myQtf vector in any analysis we like:
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summary ( mydata[myQtf] )

It is important to note that since we were searching for variables that
begin with the letter “q,” our program would have also found variables qA
and gB if they had existed. We can narrow our search with a more complex
search expression that says the letter “q” precedes at least one digit. This
would give us the ability to simulate Stata’s ability to refer to variables that
have a numeric suffix, such as “varl-var100.”

This is actually quite easy, although the regular expression is a bit cryptic.

It requires changing the myQnames line in the example above to the following:
myQnames <- grep(""q[1-9]", names(mydata), value=TRUE)

This regular expression means “any string that begins with “q,” and is fol-
lowed by one or more numerical digits.” Therefore, if they existed, this would
select ql, q27, qlold but not qA or gqB. You can use it in your programs by
simply changing the letter “q” to the root of the variable name you are using.

You may be more familiar with the search patterns using wildcards in
Microsoft Windows. That system uses “*” to represent any number of charac-
ters and “?” to represent any single character. So the wildcard version of any
variable name beginning with the letter q is “q*.” Computer programmers
call this type of symbol a “glob,” short for global. R lets you convert globs
to regular expressions with the glob2rx function. Therefore, we could do our

first grep again in the form
myQindexes <- grep(glob2rx("q*"), names(mydata), value=FALSE)

Unfortunately, wildcards or globs are limited to simple searches and cannot
do our example of q ending with any number of digits.

7.7 Selecting Variables Using $ Notation

You can select a column using $ notation, which combines the name of the
data frame and the name of the variable within it, as in

summary ( mydata$ql )
This is referred to several ways in R, including “$ prefixing,” “prefixing by
dataframe$,” or “$ notation.” When you use this method to select multiple
variables, you need to combine them into a single object like a data frame, as
in

summary ( data.frame( mydata$ql, mydata$q2 ) )

Having seen the c function, your natural inclination might be to use it for
multiple variables as in

summary( c( mydata$ql, mydata$q2 ) ) #Not good!
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This would indeed make a single object, but certainly not the one a Stata
user expects. The ¢ function would combine them both into a single variable
with twice as many observations! The summary function would then happily
analyze the new variable. When the data.frame function combines vectors
into a single data frame, they remain separate vectors within that data frame.
That is what we want here.

7.8 Selecting Variables Using Component Names

This section introduces using simple component names for variables stored in
a data frame, like gender instead of mydata$gender. The technical details we
will cover in Chapter 13, “Managing Your Files and Workspace.”

In Stata, you refer to variables by simple names like gender or ql. You
might have many data sets that contain a variable named gender, but there
is no confusion since you have to specify the data set in advance.

In Stata you clarify which data set you want to use by opening it with
use mydata.dta

In R, the potential for confusing variable names is greater because it is
much more flexible. For example, you can actually correlate a variable stored
in one data frame with a variable stored in a different data frame! all of the
variable selection methods discussed above made it perfectly clear which data
frame to use, but they required extra typing. You can avoid this extra typing
in several ways.

7.8.1 The attach Function

One approach R offers to simplify the selection of variables is the attach
function. You attach a data frame using the following function call:

attach(mydata)

Once you have done that, you can refer to just ql, and R will know which
one you mean. With this approach, getting summary statistics might look
like

summary (ql)
or
summary ( data.frame(ql, 92, 93, q4) )

If you finish with that data set and wish to use another, you can detach it
with

detach( mydata )
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Objects will detach automatically when you quit R, so using detach
is not that important unless you need to use those variable names stored
in a different data frame. In that case, detach one file before attaching
the next.

The attach function works well when selecting existing variables, but it is
best avoided when creating them. An attached data frame can be thought of as
a temporary copy, so changes to existing variables will be lost. Therefore, when
adding new variables to a data frame, you need to use any of the other above
methods that make it absolutely clear where to store the variable. Afterward,
you can detach the data and attach it again to gain access to the modified
or new variables. We will look at the attach function more thoroughly in
Chapter 13, “Managing Your Files and Workspace.”

7.8.2 The with Function

The with function is another way to use short variable names. It is similar
to using the attach function, followed by any other single function, and then
followed by a detach function. The following is an example:

with( mydata, summary( data.frame(ql, q2, 93, g4) ) )

It lets you use simple component names and even lets you create variables
safely. The downside is that you must repeat it with every function, whereas
you might need the attach function only once at the beginning of your pro-
gram. The added set of parentheses also increases your odds of making a
mistake. To help avoid errors, you can type this as

with( mydata,
summary( data.frame(ql, 92, g3, g4) )
)

7.8.3 Using Component Names in Formulas

A third way to use short variable (component) names works only with model-
ing functions. Modeling functions use formulas to perform analyses like linear
regression or analysis of variance. They also have a data argument that spec-
ifies which data frame to use. This keeps formulas much shorter.

Here are two ways to perform a linear regression. First, using dollar
notation,

Im( mydata$q4 ~ mydata$ql + mydata$q2 + mydata$q3 )

The following is the same regression, using the data argument to tell the
function which data frame to use:

Im( g4 ~ ql+q2+q3, data=mydata)
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As formulas get longer, this second approach becomes much easier. For
functions that accept formulas, this is the approach we recommend. It is easier
to use than either the attach or with functions. It also offers other benefits
when making predictions from the model. We will defer that discussion to
Chapter 17, “Statistics.”

To use this approach, all of the data must reside in the same data frame,
making it less flexible. However, it is usually a good idea to have all of the
variables in the same data frame anyway.

It is important to know that the data=mydata applies only to the variables
specified in the formula argument. Some modeling functions can specify which
variables to use without specifying a formula. In that case, you must use an
alternate approach (attach or with) if you wish to use shorter variable names.
We will see an example of this when doing t-tests in Chapter 17.

7.9 Selecting Variables with the subset Function

R has a subset function that you can use to select variables (and observa-
tions). It is the easiest way to select contiguous sets of variables by name,
such as in this Stata example:

sum ql-q4

It follows the form

subset (mydata, select=ql:q4)

For example, when used with the summary function, it would appear as
summary( subset(mydata, select=ql:q4 ) )

or

summary ( subset(mydata, select=c(workshop, ql:q4) ) )

The second example above contains three sets of parentheses. It is very
easy to make mistakes with so many nested functions. A syntax-checking
editor like JGR’s or Emacs will help. Another thing that helps is to split
them across multiple lines:

summary (

subset (mydata, select=c(workshop, ql:94) )
)

It is interesting to note that when using the ¢ function within the subset
function’s select argument, it is combining the variable names, not the
vectors themselves. So the following example will analyze the two variables
separately:
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summary (
subset (mydata, select=c(ql,q2) ) # Good.
)

That is very different from
summary ( c(mydata$ql,mydata$q2) ) # Not good.

which combines the two vectors into one long one before analysis. The subset
function’s unique syntax irritates some R users. We find that its usefulness
outweighs its quirks.

7.10 Selecting Variables Using List Index

Our data frame is also a list. The components of the list are vectors that form
the columns of the data frame. You can address these components of the list
using an index value enclosed in two square brackets. For example, to select
our third variable, we can use

summary ( mydatal[[3]] )
With this approach, the colon operator will not extract variables 3 through 6:

mydata[[3:6]] # Will NOT get variables 3 through 6.

7.11 Generating Indexes A to Z from Two Variable
Names

We have seen how the colon operator can help us analyze variables 3 through
6 using the form

summary( mydata[3:6] )

With that method, you have to know the index numbers, and digging through
lists of variables can be tedious work. However, we can have R do that work
for us, finding the index value for any variable name we like. This call to the
names function

names (mydata)== "q1"
will generate the logical vector
FALSE, FALSE, TRUE, FALSE, FALSE, FALSE, FALSE

because ¢l is the third variable. The which function will tell us the index
values of any TRUE values in a logical vector, so
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which( names(mydata)== "ql1" )

will yield a value of 3. Putting these ideas together, we can find the index
number of the first variable we want, store it in myqA, then find the last
variable, store it in myqZ and then use them with the colon operator to
analyze our data from A to Z:

mygA <- which( names(mydata)=="q1" )
myqZ <- which( names(mydata)=="q4" )

summary ( mydatal ,myqA:myqZ 1 )

7.12 Saving Selected Variables to a New Dataset

You can use any variable selection method to create a new data frame that
contains only those variables. If we wanted to create a new data frame that
contained only the q variables, we could do so using any method described
ealier. Here are a few variations:

myqs <- mydatal[3:6]

myqs <_ mydata[ c(llq1|I,Ilq2ll,llq3ll’llq4ll) ]

This next example will work, but R will name the variables “mydata.ql,”
“mydata.q2”...showing the data frame from which they came.

myqgs <- data.frame(mydata$ql, mydata$q2,
mydata$q3, mydata$qd)

You can add variable name indicators to give them any name you like. With
this next one, we are manually specifying original names.

myqgs <- data.frame(ql=mydata$ql, g2=mydata$q2,
g3=mydata$q3, g4=mydata$q4)

Using the attach function, the data.frame function leaves the variable names
in their original form.

attach(mydata)
myqgs <- data.frame(ql, q2, 93, g4)
detach(mydata)

Finally, we have the subset function with its unique and convenient use of
the colon operator directly on variable names.

myqgs <- subset(mydata, select=ql:q4)
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7.13 Example Programs for Variable Selection

In the examples throughout this chapter, we used the summary function to
demonstrate how a complete analysis request would look. However, here we
will use the print function to make it easier to see the result of each selection
when you run these programs. Even though

mydatal["ql"]
is equivalent to
print( mydatal["q1"] )

because print is the default function, we will use the longer form because it
is more representative of its look with most functions. As you learn R, you
will quickly opt for the shorter approach when printing.

For most of the programming examples in this book, the Stata programs
are shorter because the R programs demonstrate R’s somewhat greater flex-
ibility, at least in some instances. However, in the case of variable selection,
Stata has a significant advantage in ease of use. These programs demonstrate
roughly equivalent features.

7.13.1 Stata Program to Select Variables

* Filename: SelectingVars.do

use c:\myRfolder\mydata, clear

list workshop gender ql g2 g3 q4

list workshop-q4

list workshop gender qg*

* Creating a data set from selected variables;

keep g*
save c:\myRfolder\myqgs

7.13.2 R Program to Select Variables

# Filename: SelectingVars.R
# Uses many of the same methods as selecting observations.

setwd ("/myRfolder")
load(file="mydata.RData")

# This refers to no particular variables,
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# so all are printed.
print (mydata)

#---Selecting Variables by Index Numbers—--

# These also select all variables by default.
print( mydatal 1 )
print( mydatal , 1)

# Select just the 3rd variable, ql.
print( mydatal ,3] ) #Passes g3 as a vector.
print( mydatal[3] )  #Passes g3 as a data frame.

# These all select the variables ql1,92,93 and g4 by indexes.
print( mydatal c(3, 4, 5, 6) 1)
print( mydatal 3:6 ] )

# These exclude variables ql1,92,q93,94 by indexes.
print( mydatal -c(3, 4, 5, 6) 1)
print( mydatal -(3:6) ] )

# Using indexes in a numeric vector.
myQindexes <- c(3, 4, 5, 6)
myQindexes

print ( mydata[myQindexes] )

print( mydata[-myQindexes] )

# This displays the indexes for all variables.
print( data.frame( names(mydata) ) )

# Using ncol to find the last index.
print( mydatal 1:ncol(mydata) ] )
print( mydatal 3:ncol(mydata) 1 )

#---Selecting Variables by Column Names---

# Display all variable names.
names (mydata)

# Select one variable.
print( mydatal["qi"] ) #Passes ql as a data frame.
print( mydatal ,"ql"] ) #Passes ql as a vector.

# Selecting several.
print( mydata[ C("q]-","q2","q3","q4") ] )
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# Save a list of variable names to use.
manameS <_ C("ql"’"q2","q3","q4")
print (myQnames)

print ( mydata[myQnames] )

# Generate a list of variable names.
myQnames <- paste( "q", 1:4, sep="")
print (myQnames)

print ( mydata[myQnames] )

#---Selecting Variables Using Logic---

# Select ql by entering TRUE/FALSE values.
print( mydata[ c(FALSE,FALSE,TRUE,FALSE,FALSE,FALSE) ] )

# Manually create a vector to get just ql.
print( mydatal[ as.logical( ¢(0,0,1,0,0,0) ) 1)

# Automatically create a logical vector to get just ql.
print( mydata[ names(mydata)=="qi" ] )

# Exclude ql using NOT operator "!".
print( mydatal !names(mydata)=="q1" ] )

# Use the OR operator, "|" to select ql through g4,
# and store the resulting logical vector in mygs.
myQtf <- names(mydata)=="q1" |

names (mydata)=="q2" |

names (mydata)=="q3" |

names (mydata)=="q4"
print (myQtf)
print( mydata[myQtf] )

# Use the %inJ), operator to select ql through qg4.
myQtf <- names(mydata) %in% c("ql","q2","q3","q4")
print (myQtf)

print( mydata[myQtf] )

#---Selecting Variables by String Search---

# Use grep to save the q variable indexes.
myQindexes <- grep("~q", names(mydata), value=FALSE)
print (myQindexes)

print( mydata[myQindexes] )
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# Use grep to save the q variable names (value=TRUE now).
myQnames <- grep(""q", names(mydata), value=TRUE)

print (myQnames)

print ( mydata[myQnames] )

# Use %in% to create a logical vector
# to select q variables.

myQtf <- names(mydata) %in% myQnames
print (myQtf)

print( mydata[myQtf] )

# Repeat example above but searching for any
# variable name that begins with g, followed
# by one digit, followed by anything.
myQnames <- grep(""ql[[:digit:JI\{1\}",

names (mydata), value=TRUE)
print (myQnames)
myQtf <- names(mydata) %in% myQnames
print (myQtf)
print( mydata[myQtf] )

# Example of how glob2rx converts g* to “q.
glob2rx("qx*")

#---Selecting Variables Using $ Notation---

print( mydata$ql )
print( data.frame(mydata$ql, mydata$q2) )

#---Selecting Variables by Component Names---

# Using the "attach" function.
attach(mydata)

print(ql)

print( data.frame(ql, 92, g3, q4) )
detach(mydata)

# Using the "with" function.
with( mydata,

summary( data.frame(ql, 92, 93, q4) )
)

#---Selecting Variables Using subset Function---
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print ( subset(mydata, select=ql:q4) )

print( subset(mydata,
select=c(workshop, ql:94)

) )

#---Selecting Variables by List Index---
print ( mydatal[[3]] )
#---Generating Indexes A to Z from Two Variables---

mygA <- which( names(mydata)=="q1" )
print (myqAd)

myqZ <- which( names(mydata)=="q4" )
print (myqZ)

print( mydata[myqA:myqZ] )

#--—-Creating a New Data Frame---

# Equivalent ways to create a data frame
# of just the q vars.

mygs <- mydatal[3:6]

print (mygs)

myqs <- mydatal c("ql1","q2","q3","q4") 1]

print (mygs)

myqgs <- data.frame(mydata$ql, mydata$q2,
mydata$q3, mydata$qd)

print (mygs)

myqs <- data.frame(ql=mydata$ql, g2=mydata$q2,
g3=mydata$q3, g4=mydata$qsd)

print (myqgs)

attach(mydata)

myqs <- data.frame(ql,92,93,q94)
print (mygs)

detach(mydata)

myqgs <- subset(mydata, select=ql:q4)
print (mygs)
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Selecting Observations

It bears repeating that the approaches that R uses to select observations are,
for the most part, the same as those discussed in the previous chapter for
selecting variables. This chapter focuses only on selecting observations, and
it does so in the same order as the chapter on selecting variables. The next
chapter will cover the selection of variables and observations at the same time
but will do so in much less detail.

8.1 Selecting Observations in Stata
There are many ways to select observations in Stata, and it is outside our
scope to discuss them all here. However, we will look at some approaches for
comparison purposes. For Stata, if you do not select observations, it assumes
you want to analyze all of the data. So in Stata

describe workshop-q4;
will analyze all of the observations.

To select a subset of observations (e.g., the males), Stata uses the “if”
option.

describe workshop-q4 if gender=="m"

It is also common to create a logical 0/1 value in the form
gen female=gender=="f"
which you could then apply with,

describe workshop=q4 if female

R.A. Muenchen, J.M. Hilbe, R for Stata Users, Statistics 139
and Computing, DOI 10.1007/978-1-4419-1318-0_8,
(© Springer Science+Business Media, LLC 2010



140 8 Selecting Observations

8.2 Selecting All Observations

In R, if you perform an analysis without selecting any observations, the
function will use all of the observations it can. For all descriptive analyses,
Stata works in the same manner.

For example, to get summary statistics on all observations (and all vari-
ables), we could use

summary (mydata)
which is similar to Stata’s version:
summary mydata

The methods to select observations apply to all R functions that accept
variables (vectors and so forth) as input. We will use the summary function so
you will see the selection in the context of an analysis.

8.3 Selecting Observations Using Index Numbers

Although it is as easy to select observations by index numbers, you need to
be careful doing it. This is because sorting a data frame is something you
do often, and sorting changes the index number of each row (if you save the
sorted version of course). Variables rarely change order, so this approach is
much more widely used to select them. That said, let us dive in and see how
R does it.

Our data frame has two dimensions: rows and columns. R refers to these
in the form

mydata[rows, columns]

If you leave out the row or column indexes, R will process all rows and all
columns. Therefore, the following three statements have the same
result:

summary ( mydata )
summary( mydatal ] )
summary( mydatal , 1 )

Since this section focuses on selecting observations, we will now discuss
just the first index, the rows. Our data frame has eight observations or rows,
which are automatically given index numbers, or indexes of 1, 2, 3, 4, 5, 6, 7,
and 8. You can select observations by supplying one index number or a vector
of indexes. For example,

summary( mydatal[5 , ] )
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selects all of the variables for only row 5. There is not much worth analyzing
with that selection! Note that the comma is very important, even though we
request no columns in the example above. If you leave the comma out, R will
assume that any index values it sees are column indexes, and you will end up
selecting variables instead of observations!

As long as you include the comma, this selection goes across columns of
a data frame, so it must return a one-row data frame. A data frame can
contain variables that are numeric, character, or factor. Only a data frame
could store such a mixture. That is the opposite of selecting the fifth variable
with mydatal[ ,5] because that would select a vector. In many cases, this
distinction would not matter, but it might.

To select more than one observation using indexes, you must combine them
into a numeric vector using the c¢ function. Therefore, this will select rows 5
through 8, which happen to be the males:

summary( mydatal c(5,6,7,8) , 1)

You will see the ¢ function used in many ways in R. Whenever R requires
one object and you need to supply it several, it combines the several into
one. In this case, the several index numbers become a single numeric vector.
Again, take note of the comma that precedes the right square bracket. If we
left that comma out, R would try to analyze variables 5 through 8 instead of
observations 5 through 8! Since we have only six variables, that would generate
an error message. However, if we had more variables, the analysis would run,
giving us the wrong result with no error message. We added extra spaces in
this example to help you notice the comma. You do not need additional spaces
in R, but you can have as many as you like to enhance readability.

The colon operator “:” can generate a numeric vector directly, so

summary ( mydata[5:8, ] )

selects the same observations.

The colon operator is not just shorthand. Entering 1:N at the R console
will cause it to generate the sequence, 1,2,3,...,N.

If you use a negative sign on an index, you will exclude those observations.
For example

summary( mydatal -c(1,2,3,4) , 1)

will exclude the first four records, three females and one with a gender of NA.
R will then analyze the males.

Your index values must be either all positive or all negative. Otherwise,
the result would be illogical. You cannot say “include only these observations”
and “include all but these observations” at the same time.

The colon operator can abbreviate sequences of numbers, but you need to
be careful with negative numbers. If you want to exclude rows 1 through 4,
the following sequence will not work:
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> -1:4
(1] -1 0 1 2 3 4

This would, of course, generate an error because they must all have the same
sign. Adding parentheses will clarify the situation, showing R that you want
the minus sign to apply to just the set of numbers from +1 through +4 rather
than —1 through +4:

> -(1:4)
[1] -1 -2 -3 -4

> summary( mydatal -(1:4) , 1)

If you find yourself working with a set of observations repeatedly, you
can easily save a vector of indexes so you will not have to keep looking up
index numbers. In this example, we are storing the indexes for the males
in myMindexes (M for male). If we were not trying to make a point about
indexes, we would choose a simpler name like just “males.”

myMindexes <- ¢(5,6,7,8)
From now on, we can use that variable to analyze the males:
summary ( mydata[myMindexes, ] )

For a more realistic data set, typing all of the observation index numbers
you need would be absurdly tedious and error prone. We will use logic to
create that vector in “Observation Selection, Advanced Topics,” Section 8.8.
You can list indexes individually or, for contiguous observations, use the colon
operator. For a larger data set, you could use observations 1, 3, 5 through 20,
25, and 30 through 100 as follows

mySubset <- ¢(1,3,5:20,25,30:100)

See the Chapter 12, “Generating Data” for ways to generate other sequences
of index numbers.

It is easy to have R list the index for each observation in a data frame.
Simply create an index using the colon operator and append it to the front of
the data frame.

> data.frame(myindex=1:8, mydata)

myindex workshop gender ql q2 g3 q4

1 1 R £f 11 56 1
2 2 Stata f 2 1 4 1
3 3 R f 2 2 4 3
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4 4 Stata <NA> 3 1 NA 3
5 5 R m 4 5 2 4
6 6 Stata m 5 4 5 5
7 7 R m 5 3 4 4
8 8 Stata m 4 5 5 5

Note that the unlabeled column on the left contains the row names. In our
case, the row names look like indexes. However, the row names could have
been descriptive strings like “Bob,” so there is no guarantee of a relation-
ship between row names and indexes. Index values are dynamic, like the
case numbers displayed in the Stata data editor. When you sort or rearrange
the data, they change. Row names, on the other hand, are fixed when you
create the data frame. Sorting or rearranging the rows will not change row
names.

You can use the nrow function to find the number of rows in a data frame.
Therefore, another way to analyze all your observations is

summary ( mydatal 1:nrow(mydata) , 1 )

If you remember that the first male is the fifth record and you want to
analyze all of the observations from there to the end, you can use

summary( mydatal 5:nrow(mydata) , 1 )

8.4 Selecting Observations Using Row Names

Stata data sets have variable names but not observation or case names. In
R, data frames always name the observations and store those names in the
row names attribute. When we read our data set from a text file, we told it
that the first column would be our row names. The row.names function will
display them:

row.names (mydata)
R will respond with
|l1l|, |l2l|, |l3l|, |l4l|, ||5l|, ||6l|, ||7l|, ||8l|

The quotes around them show that R treats them as characters, not as num-
bers. If you do not provide an ID or name variable for R to use as row names,
it will always create them in this form. Therefore, if we had not had an ID
variable, we would have ended up in exactly the same state. I included an ID
variable because it emphasizes the need to be able to track your data back to
its most original source when checking for data entry errors. With such bor-
ing row names, there is little need to use them. Indexes are numerically more
useful. So let us change the names so we will have an example that makes
sense. We will create a new character vector of names:
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> mynames <- c("Ann","Cary","Sue","Carla",
"Bob" , "Scott" R "Mike" s "RiCh")
Now we will write those names into the row names attribute of our data frame:

row.names (mydata) <- mynames

This is a very interesting assignment! It shows that the row.names function
does not just show you the names, it provides access to the names attribute
itself. Assigning mynames to that vector renames all of the rows! In Sec-
tion 10.6, “Renaming Variables (and Observations),” we will see this again
with several variations.

Let us see how this has changed our data frame.

> mydata

workshop gender ql g2 g3 g4

Ann R f 1 1 56 1
Cary Stata f 2 1 4 1
Sue R f 2 2 4 3
Carla Stata <NA> 3 1 NA 3
Bob R m 4 5 2 4
Scott Stata m 5 4 5 5
Mike R m 5 3 4 4
Rich Stata m 4 5 5 5

Now that we have some interesting names to work with, let us see what we
can do with them. If we wanted to look at the data for “Ann,” we could use

mydata["Ann", ]

You might think that if we had several records per person, we could use
row names to select all of the rows for any person. R, however, requires that
row names be unique, which is a good idea. You could always use an id number
that is unique for row names, then have the subjects’ names on each record in
their set and a counter like time 1, 2, 3, 4. We will look at just that structure
in Section 10.15, “Reshaping Variables to Observations and Back.”

To select more than one row name, you must combine them into a single
character vector using the ¢ function. For example, we could analyze the
females using

summary ( mydatal c("Ann","Cary","Sue","Carla"), 1 )

With a more realistically sized data frame, we would probably want to save
the list of names to a character vector that we could use repeatedly. Here we
use F' to represent females and names to remind us of what is in the vector:

myFnames <- c("Ann","Cary","Sue","Carla")
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Now we will analyze the females again using this vector:
summary ( mydata[ myFnames, ] )
Note that, in Stata, observations are selected using the in operator such as:
summ age in 1/4
or

summ age if ql==

8.5 Selecting Observations Using Logic

You can select observations by using a logical vector of TRUE/FALSE values.
You can enter one manually or create by specifying a logical condition. Let
us begin by entering one manually. For example, the following will print the
first four rows of our data set:

> myRows <- c(TRUE, TRUE, TRUE, TRUE,
+ FALSE, FALSE, FALSE, FALSE)

> print( mydata[myRows, ] )

workshop gender ql g2 g3 q4

1 R f 11 5 1
2 Stata f 2 1 4 1
3 R f 2 2 4 3
4 Stata <NA> 3 1 NA 3

In Stata, the digits 1 and 0 can represent TRUE and FALSE. Let us see
what happens when we try this in R.

> myBinary <- c(1, 1, 1, 1, 0, 0, 0, 0)
> print( mydata[myBinary, ] )

workshop gender ql g2 q3 g4

1 R f 1 1 56 1
1.1 R f 1 1 5 1
1.2 R f 1 1 56 1
1.3 R £f 1 1 5 1

What happened? Remember that putting a 1 in for the row index asks for
row 1. So our request asked for row 1 four times in a row and then asked for
row 0 four times. Index values of zero are ignored. We can get around this
problem by using the as.logical function.
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> myRows <- as.logical (myBinary)

Now, myRows contains the same TRUE/FALSE values it had in the previous
example and would work fine. While the above examples make it clear how
R selects observations using logic, they are not very realistic. Hundreds of
records would require an absurd amount of typing. Rather than typing such
logical vectors, you can generate them with logical statement such as

> mydata$gender=="£f"

[1] TRUE TRUE TRUE NA FALSE FALSE FALSE FALSE

The “==" operator compares every value of a vector, like gender, to a value,
like “f”, and returns a logical vector of TRUE/FALSE values. These logical
conditions can be as complex as you like, including all of the usual logical
conditions. See Table 10.2, “Logical operators,” for details.

The length of the resulting logical vector will match the number of obser-
vations in our data frame. Therefore, we could store it our data frame as a
new variable.

Unfortunately, we see that the fourth logical value is NA. That is because
the fourth observation has a missing value for gender. Up until this point, we
have been mirroring Chapter 7, “Selecting Variables.” Logical comparisons of
variable names did not have a problem with missing values. Now, however,
we must take a different approach. First, let us look at what would happen if
we continued down this track.

> print( mydata[ mydata$gender=="£f", ] )

workshop gender ql g2 q3 g4

1 R £f 1 1 5 1
2 Stata f 2 1 4 1
3 R f 2 2 4 3
NA <NA> <NA> NA NA NA NA

What happened to the fourth observation? It had missing values only for
gender and q3. Now all of the values for that observation are missing. R
has noticed that we were selecting rows based on only gender. Not knowing
what we would do with the selection, it had to make all of the other val-
ues missing too. Why? Because we might have been wanting to correlate ql
and q4. Those two had no missing values in the original data frame. If we
want to correlate them only for the females, even their values must be set to
missing.

We could select observations using this logic and then count on R’s other
functions to remove the bad observations as they would any others with miss-
ing values. However, there is little point in storing them. Their presence could
also affect future counts of missing values for other analyses, perhaps when
females are recombined with males.
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Luckily, there is an easy way around this problem. The which function
gets the index values for the TRUE values of a logical vector. Let us see what
it does.

> which( mydata$gender=="£f" )

(11 123

It has ignored both the NA value and the FALSE values to show us that only
the first three values of our logical statement were TRUE. We can save these
index values in myFemales.

> myFemales <- which( mydata$gender=="£f" )

> myFemales
(1] 123

We can then analyze just the females with the following:
summary ( mydata[ myFemales , ] )

Negative index values exclude those rows, so we could analyze the non-females
(males and missing) with the following:

summary ( mydata[-myFemales , ] )

We could, of course, get males and exclude missing the same way we got the
females.

We can select observations using logic that is more complicated. For exam-
ple, we can use the AND operator “&” to analyze subjects who are both male
and who “strongly agree” that the workshop they took was useful. Compound
selections like this are much easier when you do it in two steps. First, create
the logical vector and store it; then use that vector to do your selection.

> HappyMales <- which(mydata$gender=="m"
+ & mydata$qd==5)

> HappyMales
(1] 6 8

So we could analyze these observations with
summary ( mydata[HappyMales , ] )

Whenever you are making comparisons to many values, you can use
the %inj, operator. Let us select observations who have taken the R or
Stata workshop. With just two target workshops, you could use a simple
workshop="R" | workshop="Stata", but the longer the target list, the hap-
pier you will be to save all of the repetitive typing.
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> myRstata <-
+  which( mydata$workshop %in’ c("R","Stata") )

> myRstata
(11 1357

Then we can get summary statistics on those observations using
summary ( mydata[myRstata, ] )

The various methods we described in Chapter 7, “Selecting Variables”
make a big difference in how complicated the logical commands to select
observations appear. Here are several different ways to analyze just the
females:

myFemales <- which( mydata$gender=="£f")
myFemales <- which( mydata[2] == "f")
myFemales <- which( mydata["gender"] == "f")
with(mydata,

myFemales <- which(gender=="f")
)
attach(mydata)

myFemales <- which(gender=="f")
detach(mydata)

You could then use any of these to analyze the data using
summary ( mydata[ myFemales, ] )

You can easily convert a logical vector into index vector that will select
the same observations. For details, see “Converting Data Structures,” Sec-
tion 10.17.

8.6 Selecting Observations Using String Search

If you have character variables, or useful row names, you can select obser-
vations by searching their values for strings of text. This approach uses the
methods of selection by indexes, row names, and logic discussed ealier, so
make sure you have mastered them before trying these.

R searches variable names for patterns using the grep function. The name
grep itself stands for Global Regular Expression Print. It is just an acronym
for a type of search.

The grep function creates a vector containing variable selection criteria
that we need in the form of indexes, names, or TRUE/FALSE logical values.
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The grep function and the rules that it follows, called regular expressions,
appear in many different software packages and operating systems.

We previously replaced our original row names, “1,” “2)”... with more
interesting ones, “Ann”, “Cary,”.... Now we will use the grep function to
search for row names that begin with the letter “C”:

myCindexes <- grep(""C", row.names(mydata), value=FALSE)
This grep function call uses three arguments:

1. The first is the command string, or regular expression, “~C,” which means
“find strings that begin with a capital letter C.” The symbol “~” represents
“begins with.” You can use any regular expression here, allowing you to
search for a wide range of patterns in variable names. We will discuss
using wildcard patterns later.

2. The second argument is the character vector that you wish to search.
In our case, we want to search the row names of mydata, so we use the
row.names function here.

3. The value argument tells it what to store when if finds a match. The
goal of grep in any computer language or operating system is to find
patterns. A value of TRUE here will tell it to save the row names that
match the pattern we seek. However, in R, indexes are more fundamental
than names, which are optional, so the default setting is FALSE to save
indexes instead. We could leave it off in this particular case, but we will use
it the other way in the next example, so we will list it here for educational
purposes. The contents of myCindexes will be 2 and 4 because Cary and
Carla are the second and fourth observations. If we wanted to save this
variable, it does not match the eight values of our other variables, so we
cannot store it in our data frame. We would instead just store it in the
workspace as a vector outside our data frame.

To analyze those observations, we can then use
summary ( mydata[myCindexes , ] )

Now let us do the same thing but have grep save the actual variable names.
All we have to do is change to value=TRUE:

myCnames <- grep(""C", row.names(mydata), value=TRUE)

The character vector myCnames now contains the row names “Cary” and
“Carla” and we can analyze those observations with

summary ( mydata[myCnames , 1 )

Finally, let us do a similar search using the %in% function. In R, it works
just like the in option in Stata. It finds matches between two sets of values.
We will use it to find which of our row names appears in this set of target
names:
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myTargetNames <- ("Carla","Caroline",
"Cary","Cathy","Cynthia")

myMatches <- row.names(mydata) %inJ, myTargetNames

The result will be a logical set of TRUE/FALSE values that indicate that the
names that match are in the second and fourth positions:

FALSE, TRUE, FALSE, TRUE, FALSE, FALSE, FALSE, FALSE
Now we can use the myMatches vector in any analysis like summary:
summary ( mydata[myMatches, ] )

You may be more familiar with the search patterns using wildcards in
Microsoft Windows. They use “*” to represent any number of characters and
“?” to represent any single character. So the wildcard version of any variable
name beginning with the letter “C” is “C*.” Computer programmers call this
type of symbol a “glob,” short for global. R lets you convert globs to regular
expressions with the glob2rx function. Therefore, we could do our first grep
again in the form

myCindexes <- grep( glob2rx("C*"),
row.names (mydata), value=FALSE )

8.7 Selecting Observations Using the subset Function

You can select observations using the subset function. You simply list your
logical condition under the subset argument, as in

subset (mydata, subset=gender=="f")

Note that an equal sign follows the subset argument because that is what R
uses to set argument values. The gender=="£" comparison is still done using
“==” because that is the symbol R uses for logical comparisons. You can use
subset to analyze your selection using the form

summary (
subset (mydata, subset=gender=="f")

)

The following is a slightly more complicated selection, in which we select
the males who were happy with their workshop. In R, the logic is a single
object, a logical vector, regardless of its complexity.

summary (
subset ( mydata, subset=gender=="m" & q4==5 )
)
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Since the first argument to the subset function is the data frame to use,
you do not have to write out the longer forms of names like mydata$ql or
mydata$gender. Also, its logical selections automatically exclude cases for
which the logic would be missing. So it acts like the which function that is
built into every selection. That is a very helpful function!

8.8 Generating Indexes A to Z from Two Row Names

We have discussed various observation selection techniques. Now we are ready
to examine combination methods that use a blend of row names, logic, and
index numbers. If you have not mastered the previous examples, now would
be a good time to review them!

We have seen how the colon operator can help us analyze the males, who
are observations 5 through 8, using the form

summary( mydata[5:8, ] )

However, you had to know the index numbers, and digging through lists of
observation numbers can be tedious work. However, we can use the row.names
function and the which function to get R to find the index values we need.
The function call

row.names (mydata)=="Bob"
will generate the logical vector
FALSE, FALSE, FALSE, FALSE, TRUE, FALSE, FALSE, FALSE

because Bob is the fifth observation. The which function will tell us the index
values of any TRUE values in a logical vector, so

which(FALSE, FALSE, FALSE, FALSE,
TRUE, FALSE, FALSE, FALSE)

will yield a value of 5. Putting these ideas together, we can find the index
number of the first observation we want, store it in myMaleA, then find the last
observation, store it in myMaleZ, and then use them with the colon operator
to analyze our data from A to Z:

myMaleA <- which( names(mydata)=="Bob" )
myMaleZ <- which( names(mydata)=="Rich" )
summary ( mydata[ myMaleA:myMaleZ, ] )
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8.9 Variable Selection Methods with No Counterpart
for Selecting Observations

As we have seen, the methods that R uses to select variables and observa-
tions are almost identical. However, there are several techniques for selecting
variables that have no equivalent in selecting observations:

The $ prefix form (e.g., mydata$gender).

The attach function’s approach to short variable names.
The with function’s approach to short variable names.
The use of formulas.

The list form (e.g., mydata[[2]]).

8.10 Saving Selected Observations to a New Data Frame

You can create a new data frame that is a subset of your original one by using
any of the methods for selecting observations. You simply assign the data to
a new data frame. The examples below all select the males and assign them
to the myMales data frame:

myMales <- mydata[5:8, ]
myMales <- mydatal[ which(mydata$gender=="m") , ]

myMales <- subset( mydata, subset=gender=="m"

8.11 Example Programs for Selecting Observations

The examples below demonstrate the many ways to select observations.
Throughout this chapter we used the summary function to demonstrate how
a complete analysis request would look. Here we will instead use the print
function to make it easier to see the result of each selection when you run the
programs. Even though

mydata[5:8, ]
is equivalent to
print( mydata[5:8, ] )

because print is the default function, we will use the longer form because
it is more representative of its look with most functions. As you learn R,
you will quickly opt for the shorter approach when you only want to print
data.
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8.11.1 Stata Program to Select Observations

* Filename: SelectingObs.do

use c:\myRfolder\mydata, clear
describe workshop-qg4;

describe workshop-gq4 if gender=="m"
gen female=gender=="f"

describe workshop=q4 if female
summ

8.11.2 R Program to Select Observations

# Filename: SelectingObs.R .

setwd ("/myRfolder")
load(file="mydata.RData")
print (mydata)

#---Selecting Observations by Index—-—-—

# Print all rows.
print( mydatal 1 )
print( mydatal , 1)
print( mydata[1:8, ] )

# Just observation 5.
print( mydatal5 , 1 )

# Just the males:

print( mydatal <(5,6,7,8) , 1)

print( mydatal 5:8 , 1)

# Excluding the females with minus sign.
print( mydatal -c(1,2,3,4), 1)

print( mydatal -(1:4) » 1)

# Saving the Male (M) indexes for reuse.
myMindexes <- ¢(5,6,7,8)

summary( mydata[myMindexes, 1 )

# Print a list of index numbers for each observation.
data.frame(myindex=1:8,mydata)

# Select data using length as the end.
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print( mydatal 1:nrow(mydata), 1 )
print( mydatal 5:nrow(mydata), 1 )

#---Selecting Observations by Row Name---

# Display row names.
row.names (mydata)

# Select rows by their row name.
print( mydata[ C(uiu’||2n’||3n’u4n)’ ] )

# Assign more interesting names.

mynames <- c("Ann","Cary","Sue","Carla",
"Bob","Scott","Mike","Rich")

print (mynames)

# Store the new names in mydata.
row.names (mydata) <- mynames
print (mydata)

# Print Ann’s data.
print( mydata["Ann" , 1)
mydata["Ann" , ]

# Select the females by row name.
print( mydatal c("Ann","Cary","Sue","Carla"), ] )

# Save names of females to a character vector.
myFnames <- c("Ann","Cary","Sue","Carla")
print (myFnames)

# Use character vector to select females.
print( mydatal myFnames, ] )

#---Selecting Observations Using Logic---

#Selecting first four rows using TRUE/FALSE.
myRows <- c(TRUE, TRUE, TRUE, TRUE,

FALSE, FALSE, FALSE, FALSE)
print( mydata[myRows, 1 )

# Selecting first four rows using 1s and Os.
myBinary <- c(1, 1, 1, 1, 0, O, O, 0)

print( mydata[myBinary, ] )

myRows <- as.logical(myBinary)
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print( mydatal myRows, 1 )

# Use a logical comparison to select the females.
mydata$gender=="£"

print( mydata[ mydata$gender=="£f", ] )

which( mydata$gender=="£f" )

print( mydatal[ which(mydata$gender=="£") , 1 )

# Select females again, this time using a saved vector.
myFemales <- which( mydata$gender=="£f" )

print (myFemales)

print( mydatal myFemales , ] )

# Excluding the females using the "!" NOT symbol.
print( mydata[-myFemales , ] )

# Select the happy males.

HappyMales <- which(mydata$gender=="m"
& mydata$qd==5)

print (HappyMales)

print( mydata[HappyMales , ] )

# Selecting observations using %in%.
myRstata <-
which( mydata$workshop %in)% c("R","Stata") )
print (myRstata)
print( mydata[myRstata , ] )

# Equivalent selections using different
# ways to refer to the variables.

print( subset(mydata, gender==’f’) )

attach(mydata)

print( mydatal gender=="f" , ] )
detach(mydata)
with(mydata,

print ( mydatal gender=="f" , ] )
)

print( mydatal[ mydata["gender"]=="f" , ] )

print ( mydatal mydata$gender=="£f" , ] )
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#---Selecting Observations by String Search---

# Search for row names that begin with "C".
myCindexes <- grep(""C", row.names(mydata), value=FALSE)
print( mydata[myCindexes , ] )

# Again, using wildcards.

myCindexes <- grep( glob2rx("C*")
row.names (mydata), value=FALSE)

print( mydata[myCindexes , ] )

#---Selecting Observations Using subset Function---
subset (mydata, subset=gender=="£")
summary (
subset ( mydata, subset=gender=="m" & q4==5 )
)
#--—Generating Indexes A to Z From Two Row Names---
myMaleA <- which( row.names(mydata)=="Bob" )
print (myMaleA)
myMaleZ <- which( row.names(mydata)=="Rich" )
print (myMaleZ)
print ( mydata[myMaleA:myMaleZ , ] )

#--—-Creating A New Data Frame---

# Creating a new data frame of only males (all equivalent).
myMales <- mydata[5:8, ]

print (myMales)

myMales <- mydatal which( mydata$gender=="m" ) , ]
print (myMales)

myMales <- subset( mydata, subset=gender=="m"
print (myMales)

# Creating a new data frame of only females (all equivalent).
myFemales <- mydatal[1:3, ]

print (myFemales)

myFemales <- mydatal which( mydata$gender=="£f" ) , ]

print (myFemales)

myFemales <- subset( mydata, subset=gender=="f" )

print (myFemales)
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Selecting Variables and Observations

In the previous two chapters, we focused on selecting variables and
observations separately. You can combine those approaches to select both
variables and observations at the same time. As an example, we will use the
various methods to select the variables workshop and ql to g4 for only the
males.

Previously we began with index numbers because they are so fundamental
to understanding how R works. This time we will discuss the more practical
approaches first.

The explanations in this chapter are much sparser. If you need clarification,
see the detailed discussions of each approach in the previous two chapters.

9.1 The subset Function

Although you can use any of the methods introduced in the previous two
chapters to select both variables and observations, you would usually choose
variables by name and choose observations by logic. The subset function lets
us use that combination easily.

When selecting variables, subset allows you to use the colon operator
on lists of contiguous variables, like gender:q4. Variable selections that are
more complex than a single variable or two contiguous variables separated by
a colon must be combined with the ¢ function, as usual.

When selecting observations, you perform logic like gender=="m" without
having to use which(gender=="m") to get rid of the observations that have
missing values for gender. The logic can be as complex as you like, so we can
select the males who are happy with their workshop using gender=="m" &
g4==5. Note that the result of a logical condition is always a single logical
vector, so you never need the c function for logic. See Table 10.2, “Logical
operators,” for details.

We can perform our selection by nesting the subset function directly
within other functions:

R.A. Muenchen, J.M. Hilbe, R for Stata Users, Statistics 157
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summary (
subset (mydata,
subset=gender=="m",
select=c(workshop, ql:q4) )
)

Since R allows you to skip the names of arguments as long as you have
them in proper order, you often see subset used in the form

summary (
subset (mydata, gender=="m",
c(workshop, ql:94) )
)

If you plan to use a subset like this repeatedly, it would make more sense
to save the subset in a data frame. Here we will add the print function just
to make the point that selection is done once and then used repeatedly with
different functions. Here we are using the name myMalesW(Q to represent the
males with workshop and the q variables.

myMalesWQ <- subset(mydata,
subset=gender=="m",
select=c(workshop, ql:q4)

print (myMalesWQ)
summary (myMalesWQ)

Performing the task in two steps like that often makes the code easier to
read and less error-prone.

9.2 Selecting Observations by Logic and Variables
by Name

Another very useful approach is to use logic to select observations and to use
names to select variables.

summary (
mydata[ which(gender=="m") ,
c ( llworkshopll s Ilql n s Ilq2l| s Ilq3l| s Ilq4l|) ]
)

This is very similar to what we did with the subset function, but with
character index values, we cannot use the form ql:q4 to choose contiguous
variables. So if you had many variables, you would want to use the shortcut
described in Section 7.11, “Generating Indexes A to Z from Two Variable
Names.”
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We could make our example more legible by defining the row and column
indexes in a separate step:

myMales <- which(gender=="m")
myvars <_ c ( "WOrkShOp" s Ilql n s Ilq2 n s Ilq3l| s |Iq4l|)

summary ( mydata[ myMales, myVars] )

This has the added benefit of allowing us to analyze just the males, for all
variables (we are not selecting any specifically) with

summary ( mydatal[ myMales, ] )

We can also analyze males and females (by not choosing only males) for just
my Vars:

summary ( mydatal , myVars] )

If we did not need that kind of flexibility and we planned to use this subset
repeatedly, we would save it to a data frame.

myMalesWQ <- mydatal myMales, myVars]

summary (myMalesWQ)

9.3 Using Names to Select Both Observations
and Variables

The above two approaches usually make the most sense. You usually know
variable names and subset values to select. For completeness sake, we will
continue on with additional combinations, but if you feel you understood the
previous two chapters and the examples above, feel free to skip these examples
and go to Section 9.6, “Saving and Loading Subsets.”

Since the males have character row names of “5” through “8,” we could
use both row names and column with

summary ( mydatal

c(|l5|| , ||6|| , l|7|l s ||8||) s

C("WOrkShop" s Ilql n s ||q2|l s ||q3|l s ||q4|l)
19

This is an odd approach for selecting rows. We do not often bother to learn
such meaningless row names. If we had row names that made more sense, like
“Ann,” “Bob,” “Carla,”. .., this approach would make more sense. However,
we can at least be assured that the row names will not be affected by the
addition of new observations or by sorting. Such manipulations do not change
row names as they do numeric index values.
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If you plan on using these character index vectors often or if you have
many values to specify, it is helpful to store them separately. This also helps
document your program, since a name like myMales will remind you, or your
colleagues, what you were selecting.

myMales <- C("5" s ngn , Urdl s "8")

myvars <—- c(llworkshopll s Ilqlll s Ilq2 n s Ilqsll s Ilq4ll)

Now we can repeat the same examples that we used in the section imme-
diately above. Once you have a vector of index values, it does not matter if
they are character names, logical values, or numeric values.

Here we analyze our chosen observations and variables:

summary ( mydatal[ myMales, myVars] )
Here we analyze only the males, but include all variables:
summary( mydatal[ myMales, 1 )
Here we select all of the observations but analyze only our chosen variables:

summary ( mydatal , myVars] )

9.4 Using Numeric Index Values to Select Both
Observations and Variables

The males have numeric index values of 5 through 8, and we want the first
variable and the last four, so we can use numeric index vectors to choose them
as in either of these two equivalent approaches:

summary( mydatal c(5,6,7,8), c(1,3,4,5,6) 1)

summary ( mydatal 5:8, c(1,3:6) ] )

This selection is impossible to interpret without a thorough knowledge of
the data frame. When you are hard at work on an analysis, you may well recall
these values. However, such knowledge fades fast, so you would do well to add
comments to your programs reminding yourself what these values select.

Adding new variables or observations to the beginning of the data frame,
or sorting it, would change these index values. This is a risky approach!

As we discussed in the last section, we can save the numeric index vectors
for repeated use.

myMales <- ¢(5,6,7,8)

myVars <- c(1,3:6)
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Again, we can repeat the same examples that we used in the sections
above. Once you have a vector of index values, it does not matter if they are
character names or numeric indexes.

Here we analyze our chosen observations and variables:

summary ( mydatal[ myMales, myVars] )
Here we analyze only the males, but include all variables:
summary ( mydatal myMales, ] )
Here we select all of the observations but analyze only our chosen variables:

summary ( mydatal[ , myVars] )

9.5 Using Logic to Select Both Observations
and Variables

Selecting observations with logic makes perfect sense, but selecting variables
using logic is rarely worth the effort. The following is how we would use this
combination for our example:

summary (
mydata[which(gender=="m"),
names (mydata) %in% c("workshop","ql","q2","q3","q4") ]
)

Let us reconsider using variable names directly. For this example, it is clearly
simpler:

summary (
mydata[ which(gender=="m") ,
C("WOIkShOp","ql","q2","q3","q4") ]
)

However, once we save these values, you use them with no more work than
earlier.

myMales <- which(gender=="m")

myVars <- names(mydata) %inj
C(Hworkshop","qlﬂ,ﬂq2ﬂ,ﬂq3"’ﬂq4ﬂ)

Here we analyze our chosen observations and variables:
summary ( mydata[ myMales, myVars] )

Here we analyze only the males but include all variables:
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summary ( mydatal[ myMales, ] )
Here we select all of the observations but analyze only our chosen variables:

summary ( mydatal , myVars] )

9.6 Saving and Loading Subsets

All of the methods we used to create subsets result in a temporary copy that
exists only in our workspace. To use it in future R sessions, we will need
to write it out to our computer’s hard drive using the save or save.image
functions. The more descriptive a name you give it, the better.

myMalesWQ <- subset(mydata,
subset=gender=="m",
select=c(workshop,ql:q4)
)

If your files are not too large, you can save your original data and your
subset with

save (mydata, myMalesWQ, file="mydata.RData")

The next time you start R, you can load both data frames with
load("mydata.RData")

If you are working with large files, you can save only the subset.
save (myMalesWQ, file="myMalesWQ.RData")

Now when you start R, you can load and work with just the subset to save
space.

load("myMalesWQ.RData")

summary (myMalesWQ)

9.7 Example Programs for Selecting Variables
and Observations

9.7.1 Stata Program for Selecting Variables and Observations

* Filename: SelectingVarsAndObs.do

use c:\myRfolder\mydata, clear
display
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* ---Equivalent to the Subset Function---
list workshop q* if gender=="m"
preserve

keep if gender=="m"
keep workshop g*
save c:\myRfolder\mymalesWQ

list

summ

* —---Logic for Obs, Names for Vars---
list

gen id = 0

replace id=_n+4

order id workshop qgx*

save c:\myRfolder\mymaleWQ, replace
list

restore

list

use c:\myRfolder\mymalesWQ, clear
list

* ---Names for Both---
list

gen id = 0

replace id=_n+4

order id workshop qx*
list

restore

list workshop qgx*

* ———Numeric Indexes for Both-—-

di gender[1] // display value first observation of gender
di q1[1] + qi[4] // sum of 1st and 4th observations of qi

di q1[2] * q2[2] // product of 2nd obs of gl and g2

* —--Saving and Loading Subsets-—-
use c:\myRfolder\mymalesWQ, clear
keep workshop g*

save, replace

list

9.7.2 R Program for Selecting Variables and Observations

# Filename: SelectingVarsAndObs.R

163
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setwd ("/myRfolder")
load(file="mydata.RData")
attach(mydata)

print (mydata)

#---The subset Function--—-

print(
subset (mydata,
subset=gender=="m",
select=c(workshop, ql:q4) )

myMalesWQ <- subset(mydata,
subset=gender=="m",
select=c(workshop, ql:q4)

print (myMalesWQ)
summary (myMalesWQ)

#---Logic for Obs, Names for Vars---

print(
mydata[ which(gender=="m") ,
C("Workshop" s Ilq1 n s Ilq2l| s |lq3l| s |lq4l|) ]

myMales <- WhiCh(gender=="m"
myVars <- c("workshop","q1","q2","q3","q4")

print( mydatal myMales, myVars] )
print( mydatal myMales, ] )
print( mydatal , myVars] )

#-—--Names for Both——-

print ( mydatal

C(|l5|| , ’|6|l , l|7|l s ||8") s

C(Ilworkshop" s llqlll s |Iq2ll s llqsll s llq4ll)
1)

myMales <- c("5" Jnen e ngmy
myVars <- c("workshop","ql","q2","q3","q4")
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print( mydatal myMales, myVars] )
print( mydatal myMales, ] )
print( mydatal , myVars] )

#-—--Numeric Indexes for Both---

print( mydatal c(5,6,7,8), c(1,3,4,5,6) 1)
print( mydatal 5:8, c(1,3:6) ] )

myMales <- ¢(5,6,7,8)
myVars <- c(1,3:6)

print( mydata[ myMales, myVars] )
print ( mydatal[ myMales, ] )
print( mydatal , myVars] )
#---Logic for Both---
summary (

mydatal[ which(gender=="m"

names (mydata) %in%
C("WOI’kShOP" s llqlll s llq2ll s ||q3ll s ||q4ll) ]

# Switching to names for vars for comparison
summary (
mydata[ which(gender=="m")
C(IIWorkshopll , Ilq1l| s Ilq2l| s Ilq3l| s Ilq4l|) ]

myMales <- which(gender=="m")

myVars <- names(mydata) %in/
c ( |lworkshopll s Ilql n s ||q2|l s ||q3|l s ||q4|l)

print( mydatal[ myMales, myVars] )
print ( mydatal[ myMales, ] )

print( mydatal , myVars] )
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#---Saving and Loading Subsets---

myMalesWQ <- subset(mydata,
subset=gender=="m",

select=c(workshop,ql:q4)
save (mydata, myMalesWQ, file="myBoth.RData")
load("myBoth.RData")

save (myMalesWQ, file="myMalesWQ.RData")
load("myMalesWQ.RData")

print (myMalesWQ)
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Data Management

There is an old rule of thumb that says 80% of your data analysis time is
spent transforming, reshaping, merging, and otherwise managing your data.
Stata has a reputation of being more flexible than R for data management.
However, as you will see in this chapter, R can do everything that Stata can
do on these important tasks.

10.1 Transforming Variables

Unlike Stata, R has no separation of phases for data modification and analysis.
Like Stata, anything that you have read into or created in your R workspace
you can modify at any time.

R performs transformations such as adding or subtracting variables on the
whole variable at once, as does Stata. It calls that vector arithmetic. R has
loops, but you do not need them for this type of manipulation. R can nest one
function call within another within any other. This applies to transformations
as well. For example, taking the logarithm of our g4 variable and then getting
summary statistics on it, you have a choice of a two-step process like

mydata$qélog <- log(mydata$q4d)
summary ( mydata$qéLlog )

or you could simply nest the log function within the summary function:
summary( log(mydata$q4) )

If you planned to do several things with the transformed variable, saving it
under a new name would lead to less typing and quicker execution. Table 10.1
shows basic transformations in both packages. In Chapter 7, “Selecting Vari-
ables,” we chose variables using various methods: by index, by column name,
by logical vector, using the style mydata$myvar, by using simply the variable

R.A. Muenchen, J.M. Hilbe, R for Stata Users, Statistics 167
and Computing, DOI 10.1007/978-1-4419-1318-0_10,
(© Springer Science+Business Media, LLC 2010
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Table 10.1. Mathematical operators in Stata and R.

R Stata

Addition X+y x+y
Antilog, base 10 107x 107x
Antilog, natural exp(x) exp(x)
Division x/y x/y
Exponentiation x"2 x"2
Logarithm, base 10 logl0(x) logl0(x)
Logarithm, natural log(x) log(x)

or 1n(x)
Multiplication xX*y X*y
Round off round (x) round (x)
Square root sqrt(x) sqrt(x)
Subtraction x-y x-y

name after you have attached a data frame, and using the subset or with
functions.

Here are several examples that perform the same transformation using
different variable selection approaches. The within function is a variation of
the with function that has some advantages for variable creation that are
beyond our scope. We have seen that R has a mean function, but we will
calculate the mean the long way just for demonstration purposes.

mydata$meanQ <- (mydata$ql + mydata$q2
+ mydata$q3 + mydata$q4d)/4

mydatal,"meanQ"] <- (mydatal ,"ql1"] + mydatal ,"q2"]
+ mydatal[ ,"q3"] + mydatal ,"q4"] )/4

within( mydata,
meanQ <- (ql + g2 + g3 + g4)/4
)

Another way to use the shorter names is with the transform function. It
is similar to attaching a data frame, performing as many transformations as
you like using short variable names, and then detaching the data (we do that
example next). It looks like

mydata <- transform(mydata, meanQ=(ql+q2+q3+q4)/4 )

W_"

It may seem strange to use the now in an equation instead of “<-)”
but in this form, meanQ is a named argument, and those are always specified
using “=.” If you have many transformations, it is easier to read them on
separate lines:

mydata <- transform( mydata,
scorel=(ql+q2)/2,
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score2=(q3+q4) /2
)

The transform function reads the data before it begins, so if you want to
continue to transform variables you just created, you must do it in a second
call to that function. For example, to get the means of scorel and score2, you
cannot do the following:

mydata <- transform( mydata,
scorel=(ql+q2)/2,
score2=(q3+q4)/2,
meanscore=scorel+score2/2 #does not work!

)

It will not know what scorel and score2 are for the creation of meanscore.
You can could do that in two steps:

mydata <- transform( mydata,
scorel=(ql+q2)/2,
score2=(q3+q4)/2

)

mydata <- transform( mydata,
meanscore=scorel+score2/2 #this works.

)

You can create a new variable using the index method too, but it requires
a bit of extra work. Let us load the data set again since we already have a
variable named mean( in the current one.

load(file="mydata.RData")

Now we will add a variable at index position 7 (we currently have six
variables). Using the index approach, it is easier to initialize a new variable
by binding a new variable to mydata. Otherwise, R will automatically give
it a column name of V7 that we would want to rename later. We used the
column bind function, cbind, to create mymatrix earlier. Here we will use it
to name the new variable, meanQ), initialize it to zero, and then bind it to
mydata.

mydata <- data.frame( cbind( mydata, meanQ=0.) )
Now we can add the values to column 7.

mydatal[7] <- (mydata$ql + mydata$q2 +
mydata$q3 + mydata$q4d)/4

Let us examine what happens when you create variables using the attach
function. WARNING! The attach function is hazardous for variable cre-
ation! You can think of the attach function as creating a temporary copy
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of the data frame, so changing that is worthless. You can use the attach
method to simplify naming variables only on the right side of the equa-
tion. This is a safe example, because the variable being created uses the long
dataframe$varname style:

attach(mydata)
mydata$meanQ <- (ql+q2+q3+qd)/4

detach(mydata)

If you were to modify a variable in your data frame, you would have to re-
attach it before you would see it. In the following example, we attach mydata
and look at ql:

> attach(mydata)
> ql

[11 12234554

So we see what ql looks like. Next, we will see what it looks like squared and
then write it to mydata$ql (choosing a new name would be wiser but would
not make this point clear). By specifying the full name mydata$ql, we know
R will write it to the original data frame, not the temporary working copy:

> mydata$ql~2
[11 1 4 4 9 16 25 25 16

> mydata$ql <- q172

However, what does the simple name of 1 show us? The unmodified tem-
porary version!

> ql
[11 12234554

If we attach the file again, it will essentially make a new temporary copy and
ql finally shows that we did indeed square it:

> attach(mydata)

The following object(s) are masked from mydata (position 3):
gender ql g2 g3 g4 workshop

> ql

[1] 1 4 4 9 16 25 25 16
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The message warning about masked objects is telling you that there were
other objects with those names that are now not accessible. Those are just the
ones we attached earlier, so that is fine. We could have avoided this message
by detaching mydata before attaching it a second time. The only problem
that presents us now is a bit of wasted workspace.

Just like Stata, R does all its of calculations in the computer’s main mem-
ory. You can use them immediately, but they will exist only in your current
session unless you save your workspace. We recommend using either the save
or the save.image function to write your work to a file:

setwd ("/myRfolder")
save.image ("myWorkspace.RData")

See Chapter 13, “Managing Your Files and Workspace” for more ways to
save new variables.

10.1.1 Example Programs for Transforming Variables
Stata Program for Transforming Variables

* Filename: Transform.do

use c:\myRfolder\mydata, clear
gen totalq = ql+q2+q3+q4

gen logtotalq = loglO(totalq)
gen meanl = totalq/4

egen mean2 = mean(ql-q4)

save c:\myRfolder\mydataT

R Program for Transforming Variables

# Filename: Transform.R

setwd ("/myRfolder")
load(file="mydata.RData")
mydata

#Transformation in the middle of another function.
summary( log(mydata$q4) )

#Creating mean(] with dollar notation.
mydata$meanQ <- (mydata$ql + mydata$q2

+ mydata$q3 + mydata$q4d)/4
mydata
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# Creating mean( using attach.
attach(mydata)

mydata$meanQ <- (ql+q2+q3+q4d)/4
detach(mydata)

mydata

# Creating mean(] using transform.

mydata <- transform(mydata,
meanQ=(q1+q2+q3+q4) /4 )

mydata

# Creating two variables using transform.
mydata <- transform( mydata,
scorel=(ql+q2)/2,
score2=(q3+q4)/2 )
mydata

# Creating mean( using index notation on the left.
load(file="mydata.RData")
mydata <- data.frame( cbind( mydata, meanQ=0.) )
mydatal[7] <- (mydata$ql + mydata$q2 +

mydata$q3 + mydata$q4d)/4
mydata

save.image(file="mydataT.RData")

10.2 Functions or Commands? The apply
Function Decides

The last section described data transformations but said little about statistical
functions. Stata has two independent ways to calculate statistics: functions
and commands. Statistics may also be calculated using Mata, Stata’s matrix
language facility. In general, Stata functions and commands work as follows:
Statistical functions work within each observation to calculate a statistic like
the mean of our q variables for each observation. Statistical commands work
within a variable to calculate statistics like the mean of our g4 variable across
all observations.

R, on the other hand, has only one way to calculate: functions. What
determines if the function is working on variables or observations is how you
apply it!

In the previous subsection, we created a mean variable using

mydata$meanQ <- (mydata$ql + mydata$q2
mydata$q3 + mydata$qd) / 4
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This approach gets tedious with long lists of variables. It also has a problem
with missing values. The meanQ variable will be missing if any of the variables
has a missing value. The mean function solves that problem.

10.2.1 Applying the mean Function

We have previously seen that R has both a mean function and a summary
function. For numeric objects, the mean function returns a single value, where-
ase the summary function returns the minimum, first quartile, median, mean,
third quartile, and maximum. We could use either of these functions to create
a mean(Q variable. However, the mean function returns only the value we need,
o it is better for this purpose.

Let us start examining our options by first putting our q variables into a
matrix. Simply selecting the variables with the command below will not work,
because even though variables 3 through 6 are all numeric, it will maintain
its form as a data frame.

myQmatrix <- mydatal ,3:6] #Not a matrix!
The proper way to convert the data is with the as.matrix function:

> myQmatrix <- as.matrix( mydatal ,3:6] )

> myQmatrix

ql g2 g3 g4
11 1 5 1
2 2 1 4 1
3 2 2 4 3
4 3 1DNA 3
5 4 5 2 4
6 5 4 5 5
7 5 3 4 4
8 4 5 5 5

Let us review what happens if we use the mean function on myQmatrix:

> mean( myQmatrix )
[1] NA

The result is NA, or missing, because the matrix contains an NA value. The
default method of dealing with missing values in R is to set the resulting value
to missing. To remove missing values, most basic statistical functions have the
na.rm argument. The value is FALSE by default, so we will set it to TRUE
to get our grand mean:

> mean( myQmatrix, na.rm=TRUE )
[1] 3.322581



174 10 Data Management

This is an interesting ability, but it is not that useful in our case. What
is of much more interest is the mean of each variable, as a Stata command
would do, or the mean of each observation, as a Stata function would do. We
can do either by using the apply function. Let us start by getting the means
of the variables:

> apply(myQmatrix, 2, mean, na.rm=TRUE)

ql q2 q3 qé
3.250000 2.750000 4.142857 3.250000

The apply function call above has three arguments and passes a fourth to
the mean function.

1. The name of the matrix (or array) you wish to analyze.

2. The margin you want to apply the function over, with 1 representing rows
and 2 representing columns. This is easy to remember since R uses the
index order of [rows,columns], so the margins values are [1,2] respectively.

3. The function you want to apply to each row or column. In our case, this
is the mean function.

4. The apply function passes any other arguments on to the function you are
applying. In our case, na.rm=TRUE is an argument for the mean function,
not the apply function. If you look at the help file for the apply function,
you will see its form is apply(X, MARGIN, FUN, ...). That means it
only has three arguments but will pass other arguments, indicated by the
ellipses “...,” to the function “FUN” ( mean in our case). So na.rm=TRUE
means nothing to the apply function other than something to pass to the
function it is applying.

Applying the mean function to rows is as easy as changing the value 2,
representing columns, to 1, representing rows:

> apply(myQmatrix, 1, mean, na.rm=TRUE)

1 2 3 4 5
2.000000 2.000000 2.750000 2.333333 3.750000
6 7 8

4.750000 4.000000 4.750000

Since means and sums are such popular calculations, there are special-
ized functions to get them: rowMeans, colMeans, rowSums, and colSums. For
example, to get the row means of myQmatrix, we can do

> rowMeans (myQmatrix, na.rm=TRUE)

1 2 3 4 5
2.000000 2.000000 2.750000 2.333333 3.750000
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6 7 8
4.750000 4.000000 4.750000

To add a new variable to our data frame that is the mean of the q variables,
we could any one of the following forms:

> mydata$meanQ <- apply(myQmatrix, 1, mean, na.rm=TRUE)
> mydata$meanQ <- rowMeans(myQmatrix, na.rm=TRUE)

> mydata <- transform(mydata,
+ meanQ=rowMeans (myQmatrix, na.rm=TRUE)

+)
> mydata

workshop gender ql g2 g3 q4 mean(Q)
1 R f 1 1 5 1 2.000000
2 Stata £f 2 1 4 1 2.000000
3 R f 2 2 4 3 2.750000
4 Stata <NA> 3 1 NA 3 2.333333
5 R m 4 5 2 4 3.750000
6 Stata m 5 4 5 5 4.750000
7 R m 5 3 4 4 4.000000
8 Stata m 4 5 5 5 5.750000

Finally, we can apply a function to each vector in a data frame by using
the lapply function. A data frame is a type of list, and the letter “I” in
lapply stands for list. The function applies other functions to lists, and it
returns its results in a list. Since it is clear we want to apply the function
to each component in the list, there is no need for a row/column margin
argument.

> lapply(mydatal ,3:6], mean, na.rm=TRUE)

$q1
[1] 3.25

$q2
[1] 2.75

$q3
[1] 4.1429

$q4
[1] 3.25
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Since the output is in the form of a list, it takes up more space when printed
than the vector output from the apply function. You can also use the sapply
function on a data frame. Its simplified vector output would be much more
compact. The “s” in sapply means it simplifies its output whenever possible
to vector, matrix, or array form. Both the lapply and sapply functions can
apply functions that return more than one value, because lists and matrices or
arrays can store much more information than the vectors to which the apply
function is restricted.

> sapply(mydatal ,3:6], mean, na.rm=TRUE)
ql 92 q3 q4
3.250000 2.750000 4.142857 3.250000
Since the result is a vector, it is very easy to get the mean of the means:

> mean(
+  sapply(mydatal ,3:6], mean, na.rm=TRUE)
+ )

[1] 3.3482

Other statistical functions that work very similarly are sd for standard
deviation, var for variance, and median. The length function is similar to
the Stata length function but different enough to deserve its own section
(below).

10.2.2 Finding N or NVALID

In Stata saying, egen varok = rownonmiss(ql 92 g3 g4), would count the
valid values of those variables for each observation. Running descriptive sta-
tistical procedures would give you the number of valid observations for each
variable. R has several variations on this theme. First, let us look at the
length function.

> length(mydatal ,"q3"]1 )

(11 8

The variable g3 has seven valid values and one missing value. The length
function is telling us the number of total responses. Another approach is to
ask for values that are not missing. The “!” sign means “not,” so let us try
the following;:

> lis.na( mydatal ,"q3"] )

[1] TRUE TRUE TRUE FALSE TRUE TRUE TRUE TRUE
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That identified them logically. Since statistical functions will interpret TRUE
as 1 and FALSE as 0, summing them will give us the number of valid values.

> sum( !is.na( mydatal ,"q3"] ) )

(11 7

Jim Lemon and Philippe Grosjean’s prettyR package has a function that
does that very calculation. Let us load that package from our library and
apply the function to our data frame using sapply.

> library("prettyR")
> sapply(mydata, valid.n)

workshop  gender ql q2 q3 q4
8 7 8 8 7 8

That is the kind of output we would get from descriptive statistics procedures
in Stata. In Chapterl?7, “Statistics” we will see functions that provide that
information and much more, like means and standard deviations.

What about applying it across rows, like the Stata rownonmiss function?
Let us create a myQn variable that contains the number of valid responses in
ql through g4. First, we will pull those variables out into a matrix. That will
let us use the apply function to the rows.

> myMatrix <- as.matrix( mydatal ,3:6] )

> myMatrix

ql 92 g3 g4
11 1 5 1
2 2 1 4 1
3 2 2 4 3
4 3 1NA 3
5 4 5 2 4
6 5 4 5 5
7 5 3 4 4
8 4 5 5 5

Now we use the apply function with the margin argument set to 1, which
asks it to go across rows.

> apply(myMatrix, 1, valid.n)
4
3

123456738
44434444
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So we see that all of the observations have four valid values except for the
fourth. Now let us do that again, but this time save it in our data frame as
variable myQn.

> mydata$myQn <- apply(myMatrix, 1, valid.n)
> mydata

workshop gender ql 92 g3 g4 myQn

1 1 f 1 1 5 1 4
2 2 f 2 1 4 1 4
3 1 f 2 2 4 3 4
4 2 <NA> 3 1 NA 3 3
5 1 m 4 5 2 4 4
6 2 m 5 4 5 5 4
7 1 m 5 3 4 4 4
8 2 m 4 5 5 5 4

Another form of the apply function is tapply. It exists to create tables,
by applying a function repeatedly to groups in the data. For details, see the
Section 10.11, “Creating Collapsed or Aggregated Data Sets.”

Finally, there is the mapply function, which is a multivariate version of
sapply. See help(mapply) for details.

The functions we have examined in this section are very basic. Their sparse
output is similar to Stata functions. For R functions that act more like Stata
commands, see Chapter 17, Statistics. Still, R does not differentiate one type
of function from another as Stata does for its functions and commands.

10.2.3 Example Programs for Applying Statistical Functions
Stata Program for Applying Statistical Functions

* Filename: FunctionsCommands.do

use c:\myRfolder\mydata, clear
preserve

* Some statistical functions
egen mymean = rowmean(ql-q4)
egen mysum = rowtotal(ql-q4)
gen myn = mysum/mymean
restore

* A statistical command
summ



10.2 Functions or Commands? The apply Function Decides 179
R Program for Applying Statistical Functions

# Filename: FunctionsCommands.R

setwd ("/myRfolder")
load(file="mydata.RData")
mydata

attach(mydata)

# Create my(matrix.

myQmatrix <- as.matrix( mydatal ,3:6] )
myQmatrix

# Get mean of whole matrix.

mean( myQmatrix )

mean( myQmatrix,na.rm=TRUE )

# Get mean of matrix columns
apply (myQmatrix,2,mean,na.rm=TRUE)

# Get mean of matrix rows.
apply (myQmatrix,1,mean,na.rm=TRUE)
rowMeans (myQmatrix,na.rm=TRUE)

# Add row means to mydata.
mydata$meanQ <- apply(myQmatrix, 1, mean, na.rm=TRUE)
mydata$meanQ <- rowMeans (myQmatrix,na.rm=TRUE)
mydata <- transform(mydata,

meanQ=rowMeans (myQmatrix, na.rm=TRUE)
mydata

# Means of data frames & their vectors.
mean(mydata, na.rm=TRUE)
lapply(mydatal ,3:6], mean, na.rm=TRUE)
sapply(mydatal ,3:6], mean, na.rm=TRUE)
mean (

sapply (mydatal[ ,3:6], mean, na.rm=TRUE)
)

# Length of data frames & their vectors.
length(mydatal ,"q3"] )

is.na( mydatal ,"q3"] )

lis.na( mydatal ,"q3"] )

sum( !is.na( mydatal ,"q3"] ) )
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# Like the Stata count from stat procedures.
library("prettyR")
sapply(mydata, valid.n)

# Like the Stata count function.
apply(myMatrix, 1, valid.n)

mydata$myQn <- apply(myMatrix, 1, valid.n)
mydata

10.3 Conditional Transformations

Conditional transformations apply different formulas to various groups in your
data. For example, the formulas for recommended daily allowances of vitamins
differ for males and females. The ifelse function does conditional transfor-
mations in a way that is similar to the Stata approach. The general form of
the function is

ifelse(logic, true, false)

where “logic” is a logical condition to test, “true” is the value to return when
the logic is true, and “false” is the value to return when the logic is false. For
example, to create a variable that has a value of 1 for people who strongly
agree with question 4 on our survey, we could use

> mydata$qéSagree <- ifelse( g4 == 5, 1, 0)
> mydata$qéSagree

[t o0OOCO1O01
This is such a simple outcome that we can also do this using
mydata$qéSagree <- as.numeric( g4 == 5 )

However, the latter approach only allows the outcomes of 1 and 0, whereas
the former version allows for any value. The statement q4==5 will result in a
vector of logical TRUE/FALSE values. The as.numeric function converts it
into zeros and ones.

R has some slightly different symbols and rules for logical comparisons.
The table of logical operators, Table 10.2, shows the symbols and some of the
rules used by each package.

If we want a variable to indicate when people agree with question 4, (i.e.,
they responded with agree or strongly agree), we can use

> mydata$qdagree <- ifelse( g4 >= 4, 1,0)
> mydata$qdagree

[fJ]ooOO1111
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Table 10.2. Logical operators in Stata and R.

R Stata

Equals == ==

Less than < <

Greater than > >

Less than or equal <= <=

Greater than or equal >= >=

Not equal 1= “=or !=

And & &

Or | |

0<=x<=1 (x >=0) & (x<=1) 0<=x<=1

Missing value size Missing values have no Missing values are
size greater than all numbers

in logical comparisons
Logic for missing values x=NA can never be true. x=. can be true
Use is.na(x) instead.

The logical condition can be as complicated as you like. The following is
one that creates a score of 1 when people took workshop 1 (abbreviated wsl)
and agreed that it was good:

> mydata$wslagree <- ifelse( workshop == 1 & g4 >=4 , 1,0)
> mydata$wslagree

[t o0001010

We can fill in equations that will supply values under the two conditions.
The following equations for males and females are a bit silly, but they make the
point obvious. You might think that if gender were missing, the gender=="£"
condition would be false and the second equation would apply. However, in
this circumstance, R, like Stata, sets the result to missing.

> mydata$score <- ifelse( gender=="f", (2*ql)+q2, (3*ql)+q2 )
The following is our resulting data frame:
> mydata

workshop gender ql g2 q3 g4 g4Sagree gdagree wslagree score

1 1 f 11 5 1 0 0 0 3
2 2 f 2 1 4 1 0 0 0 5
3 1 £ 2 2 4 3 0 0 0 6
4 2 <NA> 3 1 NA 3 0 0 0 NA
5 1 m 4 5 2 4 0 1 1 17
6 2 m 5 4 5 5 1 1 0 19
7 1 m 5 3 4 4 0 1 1 18
8 2 m 4 5 5 5 1 1 0 17
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10.3.1 Example Programs for Conditional Transformations
Stata Program for Conditional Transformations

* Filename: TransformIF.do

use c:\myRfolder\mydata, clear
preserve

if g4 == 5 {

gen x1=1

X

else {

gen x1=0

X

if q4>=4 {

gen x2=1

by

else {

gen x2=0

I

if workshop == 1 & g4>=5 {
gen x3=1

¥

else {

gen x3=0

I

if gender=="f" {

gen scoreA = 2xql+q2
3

else {

gen scoreA = 3xql+qg2
¥

if workshop==1 & q4>5 {
gen scoreB = 2xql+q2
X

else {

gen scoreB = 3*ql+q2
X

restore

R Program for Conditional Transformations

# Filename: TransformIF.R

setwd ("/myRfolder")
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load(file="mydata.RData")
mydata
attach(mydata)

#Create a series of dichotomous 0/1 variables

# The new variable qg4SAgree will be 1 if g4 equals 5,
# (Strongly agree) otherwise zero.

mydata$q4Sagree <- ifelse( g4 == 5, 1,0)
mydata$q4Sagree

# This does the same as above.
mydata$qéSagree <- as.numeric( g4 == 5 )
mydata$qéSagree

# Create a score for people who agree with qg4.
mydata$qdagree <- ifelse( g4 >= 4, 1,0)
mydata$qdagree

# Find the people only in workshopl agree to item 5.
mydata$wslagree <- ifelse( workshop == 1 & g4 >=4 , 1,0)
mydata$wslagree

# Use equations to calculate values.
mydata$score <- ifelse( gender=="f", (2xql)+q2, (3*ql)+q2 )
mydata

10.4 Multiple Conditional Transformations

Conditional transformations apply different formulas to different subsets of
your data. If you have only a single formula to apply to each group, read
Section 10.3, “Conditional Transformations.” Like Stata, R uses the same
approach for single conditional transformations as it does for multiple con-
ditional transformations. It does, however, let us look at some interesting
variations in R.

The simplest approach is to use the ifelse function a few times. Here
we create two scores, cleverly named scorel and score2, which are calculated
differently for the males and the females:

mydata$scorel <- ifelse( gender=="f", (2xql)+q2, (20xql)+q2 )
mydata$score2 <- ifelse( gender=="f", (3%ql)+q2, (30*xql)+q2 )
As earlier, the calls to the ifelse functions have three arguments:

1. The gender=="£" argument provides the logical condition to test.

2. The first formula applies to the TRUE condition, for the females.
3. The second formula applies to the FALSE condition, for the males.
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We can do the same thing using the index approach, but it is a bit trickier.

First, let us add the new score names to our data frame so that we can refer
to the columns by name:

> mydata <- data.frame( mydata, scorel=NA, score2=NA )
> mydata

workshop gender ql g2 q3 g4 scorel score2

1 R f 1 1 5 1 NA NA
2 Stata f 2 1 4 1 NA NA
3 R f 2 2 4 3 NA NA
4 Stata <NA> 3 1 NA 3 NA NA
5 R m 4 5 2 4 NA NA
6 Stata m 5 4 5 5 NA NA
7 R m 5 3 4 4 NA NA
8 Stata m 4 5 5 5 NA NA

This initializes the scores to zero. We could also have initialized them to
missing by changing “scorel=0, score2=0", to “scorel=NA, score2=NA".

Next, we want to differentiate between the genders. We can use the
form gender=="f", but we do not want to use it directly as indexes to
our data frame because gender has a missing value. What would R do with
mydata[NA, 17 Luckily, the which function only cares about TRUE values,
so we will use that to locate the observations we want:

> gals <- which( gender=="f" )
> gals

[1] 1 2 3

> guys <- which( gender=="m" )

> guys
[11 65678

We can now use the gals and guys variables (American slang for women and
men) to make the actual formula with the needed indexes much
shorter:

> mydatalgals,"scorel"] <- 2xql[gals] + g2[gals]
> mydatal[gals,"score2"] <- 3xql[gals] + q2[gals]
> mydatal[guys,"scorel"] <- 20*ql[guys] + q2[guys]
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> mydatalguys, "score2"] <- 30xqllguys] + q2[guys]

> mydata

workshop gender ql g2 q3 g4 scorel score2
1 1 f 11 5 1 3 4
2 2 f 2 1 4 1 5 7
3 1 f 2 2 4 3 6 8
4 2 <NA> 3 1 NA 3 0 0
5 1 m 4 5 2 4 85 125
6 2 m 5 4 5 5 104 154
7 1 m 5 3 4 4 103 153
8 2 m 4 5 5 5 85 125

We can see that this approach worked, but look closely at the index values.
We are selecting observations based on the rows. So where is the required
comma? When we attached the data frame, the variables q1 and g2 became
accessible by their simple component names. In essence, they are vectors now,
albeit temporary ones. Vectors can use index values too, but since they only
have one dimension, they only use one index. If we had not attached the file,
we would have had to write the formulas as

2x mydatal[gals, "qi"] + mydata[gals, "q2"]

We no longer need the guys and gals variables, so we can remove them
from our workspace.

rm(guys,gals)

10.4.1 Example Programs for Multiple Conditional
Transformations

Stata Program for Multiple Conditional Transformations

* Filename: TransformIF2.do

use c:\myRfolder\mydata, clear
preserve

if gender=="m"

gen scorel = (1.1xql)+q2

gen score2 = (1.2xql)+q2

}

else if gender=="f" {

gen scorel = (2.1%ql) + g2
gen score2 = (2.2xql) + g2

}

restore
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R Program for Multiple Conditional Transformations

# Filename: TransformIF2.R

# Read the file into a data frame and print it.
setwd ("/myRfolder")

load(file="mydata.RData")

attach(mydata)

mydata

# Using the ifelse approach.
mydata$scorel <-

ifelse( gender=="f", (2xql)+q2, (20%q1)+q2 )
mydata$score2 <-

ifelse( gender=="f", (3*ql)+q2, (30*ql)+q2 )
mydata

# Using the index approach.
load(file="mydata.RData")

# Create names in data frame.

mydata <- data.frame( mydata, scorel=0, score2=0 )
attach(mydata)

mydata

# Find which are males and females.
gals <- which( gender=="f" )

gals

guys <- which( gender=="m" )

guys

mydatal[gals,"scorel"] <- 2*ql[gals] + q2[gals]

+
mydatal[gals,"score2"] <- 3*ql[gals] + q2[gals]
mydata[guys, "scorel"] <- 20x*ql[guys] + g2[guys]
mydata[guys,"score2"] <- 30*qll[guys] + q2[guys]
mydata
# Clean up.

rm(guys, gals)

10.5 Missing Values

We have discussed missing values briefly in several previous chapters. Let us
bring those various topics together to review and expand on. R represents
missing values with NA, for Not Available. The letters NA are also an object
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in R that you can use to assign missing values. In Stata, numeric missing values
are indicated with a period, while a string missing value is simply displayed
in double quotes, "". Stata also has extended missing numeric values ranging
from .a, .b, through .z in ascending order. Relational operators such as these
missing value indicators are stored as very high numeric values, (i.e., higher
than the range of real numbers).

When importing numeric data, R reads blanks as missing (except when
blanks are delimiters). R reads the string NA as missing for both numeric
and character variables. When importing a text file, Stata recognizes a
period as a missing value for numeric variables. R will, instead, read the
whole variable as a character vector! If you have control of the source of the
data, it is best not to write them out that way. If not, you can use a text
editor to replace the periods with NA, but you have to be careful to do so
in a way that does not also replace valid decimal places. Some editors make
that easier than others. A safer method would be to fix it in R, which we do
below.

When other values represent missing, you will, of course, have to tell R
about them. The read.table function provides an argument, na.strings,
which allows you to provide a set of missing values. However, it applies that
value to every variable, so its usefulness is limited. The following is a data set
that we will use to demonstrate the various ways to set missing values. The
data frame we use, mydatalNA, is the same as mydata in our other examples,
except that it uses several missing value codes:

> mydataNA <- read.table("mydataNA.txt")
> mydataNA

workshop gender ql g2 g3 q4

1 1 f 1 1 565 1
2 2 f 2 1 499
3 . f 9 2 4 3
4 2 3 99 3
5 1 m 4 5 2 4
6 . m 9 9 5 65
7 1 . 5 39 4
8 2 m 4 5 5 99

In the data we see that workshop and gender have periods as missing val-
ues, ql and g2 have 9’s, and q3 and g4 have 99’s. Do not be fooled by the
periods in workshop and gender; they are not already set to missing! If so,
they would have appeared as NA instead. R has seen the periods and has
converted both variables to character (string) variables. Since read.table
converts string variables to factors unless the as.is=TRUE argument is added,
both workshop and gender are now factors. We can set all three codes to miss-
ing by simply adding the na.strings argument to the read.table function:
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> mydataNA <- read.table("mydataNA.txt",
+ na.strings=c(".", "9", "99") )

v

mydataNA

workshop gender ql g2 g3 q4

1 1 f 1 1 5 1
2 2 f 2 1 4 NA
3 NA fNA 2 4 3
4 2 <NA> 3 NA NA 3
5 1 m 4 5 2 4
6 NA mNANA 5 6
7 1 <NA> 5 3 NA 4
8 2 m 4 5 5 NA

If the data did not come from a text file, we could still easily scan every
variable for 9 and 99 to replace with missing values using

mydataNA [mydataNA==9 | mydataNA==99] <- NA

Both of the above approaches treat all variables alike. If any variables, like
age, had valid values of 99, it would set them to missing too! For how to handle
that situation, see Section 10.5.3, “When “99” Has Meaning.” Of course “.”
never has meaning by itself, so getting rid of them all with na.strings="."
is usually fine.

10.5.1 Substituting Means for Missing Values

There are several methods for replacing missing values with estimates of what
they would have been. These methods include simple mean substitution, re-
gression, and,—the gold standard—multiple imputation. We will just do mean
substitution.

Any logical comparison on NAs results in an NA outcome, so q1==NA will
never be TRUE, even when ql is indeed NA. Therefore, if you wanted to
substitute another value such as the mean, you would need to use the is.na
function. Its output is TRUE when a value is NA. The following shows how
you can use it to substitute missing values.

attach(mydataNA)

mydataNA$qli[ is.na(ql) ] <- mean( g1, na.rm=TRUE )

On the left-hand side, the statement above selects mydataNA$ql as a vec-
tor and then finds its missing elements with is.na(mydata$ql). On the right,
it calculates the mean of ql across all observations to assign to those NA val-
ues on the left. We are attaching mydata so we can use short variables names
to simplify the code, but we are careful to use the long form, mydataNA$ql,
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where we write the result. This ensures that the result will be stored within
the data frame, mydata, rather than in the attached copy. See Section 13.3,
“Attaching Data Frames” for details.

10.5.2 Finding Complete Observations

You can omit all observations that contain any missing values with the
na.omit function. The new data frame, myNoMissing, contains no missing
values for any variables.

> myNoMissing <- na.omit(mydataNA)

> myNoMissing

workshop gender ql g2 g3 q4
1 1 f 1 1 5 1
5 1 m 4 5 2 4

Yikes! We do not have much data left. Thank goodness this is not our
dissertation data. The complete.cases function returns a value of TRUE
when a case is complete —that is, when an observation has no missing
values:

> complete.cases(mydatalNA)

[1] TRUE FALSE FALSE FALSE TRUE FALSE FALSE FALSE

Therefore, we can use this to get the cases that have no missing values (the
same result as the na.omit function) by doing

> myNoMissing <- mydataNA[ complete.cases(mydataNA), ]

> myNoMissing

workshop gender ql g2 g3 q4
1 1 f 1 1 5 1
5 1 m 4 5 2 4

Since we already saw na.omit do that, it is of more interest to do the
reverse. If we want to see which observations contain any missing values, we
can use “!” for NOT:

> myIncomplete <- mydataNA[ !complete.cases(mydataNA), ]

> myIncomplete
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workshop gender ql g2 g3 q4

2 2 f 2 1 4 NA
3 NA fNA 2 4 3
4 2 <NA> 3 NANA 3
6 NA mNANA 5 6
7 1 <NA> 5 3 NA 4
8 2 m 4 5 5 NA

10.5.3 When “99” Has Meaning

Occasionally, data sets use different missing values for different sets of vari-
ables. In that case, the methods described earlier would not work because
they assume every missing value code applies to all variables.

Variables often have several missing value codes to represent things like,
“not applicable,” “do not know,” and “refused to answer.” Early statistics
programs used to read blanks as zeros, so researchers got used to filling their
fields with as many 9’s as would fit. For example, a two-column variable such
as years of education would use 99, to represent missing. The data set might
also have a variable like age, for which 99 is a valid value. Age, requiring
three columns, would have a missing value of 999. Data archives like the
Interuniversity Consortium of Political and Social Research (ICPSR) have
many data sets coded with multiple values for missing.

We will use conditional transformations, covered earlier in this chapter, to
address this problem. Let us read the file again and put NAs in for the values
9 and 99 independently:

> mydataNA <- read.table("mydataNA.txt", na.strings=".")
> attach(mydataNA)

mydataNA$ql[ql==9 ] <- NA
mydataNA$q2[q2==9 ] <- NA
mydataNA$q3[q3==99] <- NA
mydataNA$q4 [q4==99] <- NA

vV V V V

> mydatalNA

workshop gender ql g2 g3 q4

1 f 1 1 5 1
2 f 2 1 4NA
NA fNA 2 4 3

2 <NA> 3 NANA 3
m 4 5 2 4

O W

[y
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6 NA mNANA 5 6
7 1 <NA> 5 3 NA 4
8 2 m 4 5 5 NA

That approach can handle any values we might have and assign NAs only
where appropriate, but it would be quite tedious with hundreds of variables.
We have used the apply family of functions to execute the same function
across sets of variables. We can use that method here. First, we need to create
some functions, letting x represent each variable. We can do this using the
index method:

my9isNA  <- function(x) { x[x==9 ] <- NA; x}
my99isNA <- function(x) { x[x==99 ] <- NA; x}

or we could use the ifelse function:

my9isNA <- function(x) { ifelse( x==9, NA, x) }
my99isNA <- function(x) { ifelse( x==99, NA, x) }

Either of these approaches create functions that will return a value of NA
when x==9 or x==99 and will return a value of just x if they are false. If
you leave off that last “...x}” above, what will the functions return when the
conditions are false? That would be undefined, so every value would become
NA!

Now we need to apply each function where it is appropriate, using the
lapply function.

> mydataNA <- read.table("mydataNA.txt", na.strings=".")
> attach(mydataNA)

> mydataNA[3:4] <- lapply( mydataNA[3:4], my9isNA )
> mydataNA[5:6] <- lapply( mydataNA[5:6], my99isNA )

> mydataNA

workshop gender ql g2 q3 q4

1 1 f 1 1 5 1
2 2 f 2 1 4NA
3 NA fNA 2 4 3
4 <NA> 3 NANA 3
5 1 m 4 5 2 4
6 NA m NANA 5 5
7 1 <NA> 5 3 NA 4
8 m 4 5 5 NA
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The sapply function could have done this too. With our small data frame,
this has not saved us much effort. However, to handle thousands of variables,
all we would need to change are the above indices from 3:4 and 5:6 to perhaps
3:4000 and 4001:6000.

10.5.4 Example Programs to Assign Missing Values
Stata Program to Assign Missing Values

* Filename: MissingValues.do

use c:\myRfolder\mydata, clear
preserve

replace ql=. if ql1==9

replace qg2=. if g2==9

replace g3=. if q3==99

replace qg4=. if q4==99

* Same thing but is quicker for lots of vars
restore

forvalues i = 1/2 {

replace q‘i’=. if q‘i’==

}

forvalues i = 3/4 {

replace q‘i’=. if q‘i’==90

¥

restore

R Program to Assign Missing Values

# Filename: MissingValues.R

setwd ("/myRfolder")
# Read the data to see what it looks like.

mydataNA <- read.table("mydataNA.txt")
mydatalNA

# Now read it so that ".", 9, 99 are

# converted to missing.

mydataNA <- read.table("mydataNA.txt",
na.strings=c(".", "9", "99") )

mydatalNA

# Convert 9 and 99 manually
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mydataNA <- read.table("mydataNA.txt",
na.strings=".")

mydataNA [mydataNA==9 | mydataNA==99] <- NA

mydatalNA

# Substitute the mean for missing values.

mydataNA$ql[is.na(mydataNA$ql)] <-
mean(mydataNA$ql, na.rm=TRUE)

mydatalNA

# Eliminate observations with any NAs.
myNoMissing <- na.omit (mydatalNA)
myNoMissing

# Test to see if each case is complete.
complete.cases (mydataNA)

# Use that result to select compete cases.
myNoMissing <- mydataNA[ complete.cases(mydataNA), 1]
myNoMissing

# Use that result to select incomplete cases.
myIncomplete <- mydataNA[ !complete.cases(mydatalNA), ]
myIncomplete

# When "99" Has Meaning...
# Now read it and set missing values
# one variable at a time.

mydataNA <- read.table("mydataNA.txt", na.strings=".")
mydataNA
attach(mydatalA)

# Assign missing values for q variables.
mydataNA$ql[q1==9] <- NA
mydataNA$q2[q2==9] <- NA
mydataNA$q3[q3==99] <- NA

mydataNA$q4 [q4==99] <- NA

mydataNA

detach(mydataNA)

# Read file again, this time use functiomns.

mydataNA <- read.table("mydataNA.txt",na.strings=".")
mydataNA

attach(mydataNA)

#Create a functions that replaces 9, 99 with NAs.

193



194 10 Data Management

my9isNA <- function(x) { x[x==9 1 <- NA; x}
my99isNA <- function(x) { x[x==99 ] <- NA; x}

# Now apply our functions to the data frame using lapply.
mydataNA[3:4] <- lapply( mydataNA[3:4], my9isNA )
mydataNA[5:6] <- lapply( mydataNA[5:6], my99isNA )
mydataNA

10.6 Renaming Variables (and Observations)

In Stata, you do not know where variable names are stored or how. You just
know they are in the data set somewhere. Renaming is simply a matter of
matching the new name to the old name with a rename command. In R,
however, both row and column names are stored in attributes—essentially
character vectors—within the data frame. In essence, they are just another
form of variable that you can manipulate.

If you use Microsoft Windows, you can see the names in the data editor,
and changing them there by hand is a very easy way to rename them. The
function call fix(mydata) brings up the data editor. Clicking on the name of
a variable opens a box that enables you to change its name. In Fig. 10.1, we
are in the midst of changing the name of the variable q1 (see the name in the
spreadsheet) to x1.

Closing the Variable Name box, the Data Editor completes your changes.
If you use Macintosh or Linux, the fix function does not work this way.
However, on any operating system, you can use functions to change variable
names. The programming approach to changing names that feels the closest
to Stata is the rename function in Hadley Wickham’s reshape package [53].
To use it, install the package and then load it with the library function.
Then create a character vector whose values are the new names. The names
of the vector elements are the old variable names. This approach makes it
particularly easy to to rename only a subset of your variables. It also feels
very familiar to Stata users since it follows the old-name=new-name style of
their rename command.

> library("reshape")
> myChanges <- c(ql="x1", q2="x2", g3="x3", q4="x4")
> myChanges

ql g2 93 a4
IIX1II IIX2II IIX3II IIX4II

Now it is very easy to change names with
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> L£ix(mydaca)

workshop|gender |ql qz2 q3 q4
1]1 - 4 1 1 S 1
e |2
3 |1
4 |2
S |1
6 |2
Zall 1
8 |2
g — H = — >

Fig. 10.1. Renaming a variable using R’s data editor.

> mydata <- rename(mydata, myChanges)

> mydata

workshop gender x1 x2 x3 x4
1 1 f 1 1 56 1
2 2 f 2 1 4 1
3 1 f 2 2 4 3
4 2 <NA> 3 1 NA 3
5 1 m 4 5 2 4
6 2 m 5 4 5 5
7 1 m 5 3 4 4
8 2 m 4 5 5 5

R’s built-in approach to renaming variables is to use the names function.
Simply entering names (mydata) causes R to print out the names vector.

> names (mydata)

[1] Ilgroupll Ilgenderll llqlll I|q2ll "qB" Ilq4ll

You can also assign a character vector of equal length to that function,
which renames the variables. With this approach, you can supply a name for
every variable.
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> names (mydata) <- c("group","gender","x1","x2","x3","x4")
> mydata

group gender x1 x2 x3 x4
1 1 f 1 1 5 1
2 2 f 2 1 4 1

You can also use subscripting for this type of renaming. Since gender is
the second variable in our data frame, you could change just the name gender
to sex as follows:

names (mydata) [2] <- "sex"

The edit function, described in Section 6.1, “The R Data Editor,” will
generate a character vector of variable names, complete with the ¢ function
and parentheses.

In Fig. 10.2, you can see the command we entered and the window that it
opened, titled names(mydata) — R Editor. We have changed the name of the
variable “gender” to “sex.” When we finish our changes, closing the box will
execute the command.

> names (mydata) <- edit( names (mydata) )

names(mydata) - R Editor E\@@

c (ﬂworkshopﬂ' "Se I‘!' PI(:[]_"r nqzn‘ Hq3"' NqQH)

Fig. 10.2. Renaming variables using the edit function.

10.6.1 Renaming Variables—Advanced Examples

The methods shown above are often sufficient to rename your variables. You
can view the next few sections as either beating the topic to death or as a
wonderful opportunity to extend what you have learned about R into further
examples. I think it is worthwhile because if you read the R-help e-mail sup-
port list, you will see these methods used to rename variables. The approach
used in Section 10.6.4, “Renaming Many Sequentially Numbered Variable
Names,” can be a real time saver.
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10.6.2 Renaming by Index

Let us extract the names of our variables using the names function.

> mynames <- names(mydata)
> mynames

[1] "group" "gender" llqlll llq2ll llq3ll nq4n

Now we have a character vector whose values we can change using the R
techniques we have covered elsewhere. We would like to get the index value
of each variable name. Recall that whenever a data frame is created, row
names are added that are sequential numbers by default. So we can use the
data.frame function to number our variable names:

> data.frame (mynames)

mynames
group
gender
ql

q2

q3

qé

o O W N

We see from the above list that ql is the third name and g4 is the sixth.
We can now use that information to enter new names directly into this vector
and print the result so that we can see if we had made errors:

mynames [3] <- "x1"
mynames [4] <- "x2"
mynames [6] <- "x3"
mynames [6] <- "x4"

vV V V V

> mynames

[1] Ilgroupll llgenderll "Xl" ||X2|l "X3" IIX4II

That looks good, so let us place those new names into the names attribute of
our data frame and look at the results:

> names (mydata) <- mynames
> mydata
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group gender x1 x2 x3 x4
1 1 f 1 1 5 1
2 2 f 2 1 4 1

As you will see in the program below, each time we do another method
of name changes, we need to restore the old names to demonstrate the new
techniques. We can accomplish that by either reloading our original data frame
or by using

names (mydata) <- c("group“ s "gender" s "ql" s l|q2ll s nq3|| s nq4||)

10.6.3 Renaming by Column Name

If you prefer to use variable names instead of index numbers, that is easy to
do. We will make another copy of mynames:

> mynames <- names(mydata)
> mynames

[1] Ilgroupll llgenderll llqlll ||q2|l I|q3|l Ilq4l|

Now we will make the same changes but using a logical match to find where
mynames=="q1l" and so on and assigning the new names to those locations.

> mynames [ mynames=="ql1" ] <- "x1"

> mynames [ mynames=="q2" ] <- "x2"

> mynames [ mynames=="q3" ] <- "x3"

> mynames [ mynames=="qg4" ] <- "x4"

> mynames

[1] Ilgroupll llgenderll "Xl" "X2" "XS" "X4"

Finally, we put the new set mynames into the names attribute of our data
frame, mydata.

> names(mydata) <- mynames
> mydata
group gender x1 x2 x3 x4

1 1 f 1 1 56 1
2 2 f 2 1 4 1
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You can combine all these steps into one, but we find it very confusing to
read.

names (mydata) [names (mydata)=="q1"] <- "x1"
names (mydata) [names (mydata)=="q2"] <- "x2"
names (mydata) [names (mydata)=="q3"] <- "x3"
names (mydata) [names (mydata)=="q4"] <- "x4"

10.6.4 Renaming Many Sequentially Numbered Variable Names

Our next example works well if you are changing many variable names, like
100 variables named x1, x2,. .. over to similar names like y1, y2,.... You occa-
sionally have to make changes like this when you measure many variables at
different times and you need to rename the variables in each data set before
joining them all.

We learned how the paste function can append sequential numbers onto
any string in Section 7.4, “Selecting Variables by Column Name.” We will use
it here to create the new variable names:

> mst <- paste( nx", 1:4, Sep=||||)
> myXs

[1] IIX1II le2l| IIX3l| "X4"

Now we need to find out where to put the new names. We already know
this of course, but we found that out in the previous example by listing
all of the variables. If we had thousands of variables, that would not be a
very good method. We will use the method we covered previously (and in
more detail) in Section 7.11, “Generating Indexes A to Z from Two Variable
Names”:

> myA <- which( names(mydata)=="ql1" )
> myA
[1] 3
> myZ <- which( names(mydata)=="q4" )
> myZ

(1] 6
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Now we know the indexes of the variable names to replace; we can replace
them with the following:

> names (mydata) [myA:myZ] <- myXs
> mydata

group gender x1 x2 x3 x4
1 1 f 1 1 5 1
2 2 f 2 1 4 1

10.6.5 Renaming Observations

R has row names that work much the same as variable names, but they apply
to observations. These names must be unique and often come from an ID
variable. When reading a text file using read.table, the row.names argument
allows you to specify an ID variable. See Section 6.2, “Reading Delimited Text
Files” for details.

Row names are stored in a vector called the row names attribute. Therefore,
when renaming rows using a variable, you must select it so that it will pass as
a vector. In the examples below, the first three select a variable named ”id”
as a vector, so they work. The last approach looks almost like the first, but it
selects id as a data frame, which will not fit in the row names attribute. Recall
that leaving out the comma in mydata["id"] makes R select a variable as a
data frame. The moral of the story is that when renaming observations using
index values, keep the comma!

> row.names (mydata) <- mydatal[ ,"id"] #This works.

> row.names (mydata) <- mydata$id #This works too.
> row.names (mydata) <- mydatal[["id"]] #This does too.
> row.names (mydata) <- mydata["id"]  #This does not.
Error in ‘row.names<-.data.frame‘(‘*tmp*‘,

value = list(id = c(1, 2, 3,
invalid ’rowrow.names’ names length

10.6.6 Example Programs for Renaming Variables

For many of our programming examples, the R programs are longer be-
cause they demonstrate a wider range of functionality. In this case, renaming
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variables is definitely easier in Stata. R does have a greater flexibility in this
area, but it is an ability that only a fanatical programmer could love!

Stata Program for Renaming Variables

* Filename: Rename.do

use c:\myRfolder\mydata, clear
preserve

rename ql x1

rename g2 x2

rename g3 x3

rename g4 x4

* or

restore

forvalues i = 1/4 {
rename q‘i’ x‘i’

3

R Program for Renaming Variables

# Filename: Rename.R
setwd ("/myRfolder")
load(file="mydata.RData")
mydata

# Using the data editor.

fix(mydata)
mydata

# Restore original names for next example.
names (mydata) <- c("group", "gender",
llqlll s llq2|l , Ilq3l| s Ilq4ll)

# Using the reshape package.

library("reshape")

myChanges <- c(ql="x1",q2="x2",q3="x3",q4="x4")
myChanges

mydata <- rename(mydata, myChanges)
mydata
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# Restore original names for next example.
names (mydata) <- c("group", "gender",
llqlll , llq2ll , Ilq3’l , llq4ll)

# The standard R approach.

names (mydata) <- c("group", "gender",
"Xl", IIXQII’ "X3", "X4")
mydata

# Restore original names for next example.
names (mydata) <- c("group", "gender",
llqlll , llq2ll , Ilq3ll , llq4ll)

# Using the edit function.
names (mydata) <- edit( names(mydata) )
mydata

# Restore original names for next example.
names (mydata) <- ¢ ("workshop", "gender",
llqlll s llq2ll , Ilq3l| , llq4")

#---Selecting Vaiables by Index Numbers---
mynames <- names (mydata)

# Data.frame adds index numbers to names.
data.frame (mynames)

# Then fill in index numbers in brackets.
mynames [3] <- "q1"
mynames [4] <- "q2"
mynames [6] <- "q3"
mynames [6] <- "qg4"

# Finally, replace old names with new.
names (mydata) <- mynames
mydata

# Restore original names for next example.
names (mydata) <- c("group", "gender",
llqlll s llq2ll , Ilq3l| s Ilq4l|)
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#---Selecting Variables by Name---
# Make a copy to work on.

mynames <- names (mydata)

mynames

# Replace names in copy.

mynames [ mynames=="q1" ] <- "x1"
mynames [ mynames=="q2" ] <- "x2"
mynames [ mynames=="q3" ] <- "x3"
mynames [ mynames=="qg4" ] <- "x4"

mynames

# Then replace the old names.
names (mydata) <- mynames
mydata

# Restore original names for next example.
names (mydata) <- ¢ ("group", "gender",
llqlll , llq2ll , Ilq3ll s llq4")

#---Same as Above, but Confusing!---

names (mydata) [names (mydata)=="q1"] <- "x1"
names (mydata) [names (mydata)=="q2"] <- "x2"
names (mydata) [names (mydata)=="q3"] <- "x3"
names (mydata) [names (mydata)=="q4"] <- "x4"
print (mydata)

# Restore original names for next example.
names (mydata) <- c("group", "gender",
llqlll , l|q2ll , Ilq3l| s Ilq4ll)

#---Replacing Many Numbered Names---

# Examine names
names (mydata)

# Generate new numbered names.
myXs <- paste( "x", 1:4, sep="")
myXs

# Find out where to put the new names.
myA <- which( names(mydata)=="ql1" )
myA

myZ <- which( names(mydata)=="q4" )

203
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myZ
# Replace names at index locations.
names (mydata) [myA:myZ] <- myXs(mydata)

#remove the unneeded objects.
rm(myXs, myA, myZ)

10.7 Recoding Variables

Recoding is just a simpler way of doing a set of related IF/THEN conditional
transformations. Survey researchers often collapse five-point Likert-scale items
to simpler three-point Disagree/Neutral/Agree scales to summarize results.
This can also help when a cross-tabulation (or similar analysis) with other
variables creates tables that are too sparse to analyze.

Recoding can also reverse the scale of negatively worded items so that
a large numeric value has the same meaning across all items. It is easier to
reverse scales by subtracting each score from 6 as in

mydata$qrl <- 6-mydata$ql

That results in 6-5=1, 6-4=2, and so on.

There are two important issues to consider when recoding data. First,
collapsing a scale loses information and power. You will lessen your ability to
find significant, and hopefully useful, relationships. Second, recoding nominal
categorical variables like race can be disastrous. For example, inexperienced
researchers often recode race into Caucasian and Other without checking to
see how reasonable that is beforehand. You should do an analysis to see if the
groups you are combining show similar patterns with regard to your dependent
variable of interest. Given how much time that can add to the overall analysis,
it is often far easier to set values to missing. Simply focus your analysis on the
groups for which you have sufficient data rather than combine groups without
justification.

Stata has a specific recode command by that name and offers a “label”
option that allows value labels to follow the recoding.

You can also recode the data with a series of IF/THEN statements. We
show both methods below. For simplicity, we leave the value labels out of
the Stata and R programs. We cover those in Section 11.1, “Value Labels or
Formats (and Measurement Level).”

For recoding continuous variables into categorical, see the cut function in
base R and the cut2 function in Frank Harrell’s Hmisc package. For choosing
optimal cut points with regard to a target variable, see the rpart function in
the rpart package or the tree function in the Hmisc package.

It is wise to avoid modifying your original data, so recoded variables are
typically stored under new names. If you named your original variables ql,
q2,. . .then you might name the recoded ones qrl, qr2,..., with ”r” represent-
ing recoded.
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10.7.1 Recoding a Few Variables

We will work with the recode function from John Fox’s car package, which
you will have to install before running this. See Chapter 2, “Installing and
Updating R,” for details. We will apply it below to collapse our five-point
scale down to a three-point one representing just disagree, neutral, and agree.

> library("car")

> mydata$qrl <- recode(ql, "1=2; 5=4")
> mydata$qr2 <- recode(q2, "1=2; 5=4")
> mydata$qr3 <- recode(q3, "1=2; 5=4")
> mydata$qrd <- recode(qd, "1=2; 5=4")

> mydata

workshop gender ql g2 g3 g4 qrl qr2 qr3 qré

1 1 f 1 1 5 1 2 2 4 2
2 2 f 2 1 4 1 2 2 4 2
3 1 f 2 2 4 3 2 2 4 3
4 2 <KNA> 3 1 NA 3 3 2 NA 3
5 1 m 4 5 2 4 4 4 2 4
6 2 m 5 4 5 5 4 4 4 4
7 1 m 5 3 4 4 4 3 4 4
8 2 m 4 5 5 65 4 4 4 4

The recode function needs only two arguments: the variable you wish to
recode and a string of values in the form “oldi=newl; old2=new2;....”

10.7.2 Recoding Many Variables

The above approach worked fine with our tiny data set, but in a more realistic
situation, we would have many variables to recode. So let us scale this example
up. We learned how to rename many variables in Section 10.6.4, so we will
use that knowledge here.

> myQnames <- paste( "q", 1:4, sep="")
> myQnames

[1] "ql" "g2" "g3" "ga"

> myQRnames <- paste( "qr", 1:4, sep="")
> myQRnames

[1] Ilqull "qr2" |Iqr3ll llqr4ll
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Now we will use the original names to extract the variables we want to recode
to a separate data frame.

> myQRvars <- mydatal ,myQnames]
> myQRvars

ql 92 g3 g4
11 1 5 1
2 21 4 1
3 2 2 4 3
4 3 1NA 3
5 4 5 2 4
6 5 4 5 5
7 5 3 4 4
8 4 5 5 5

We will use our other set of variable names to rename the variables we just
selected.

> names (myQRvars) <- myQRnames
> myQRvars

qrl qr2 qr3 qr4

1 1 1 5 1
2 2 1 4 1
3 2 2 4 3
4 3 1 NA 3
5 4 5 2 4
6 5 4 5 b5
7 5 3 4 4
8 4 5 5 b

Now we need to create a function that will allow us to apply the recode
function to each of the selected variables. Our function only has one argument,
x, which will represent each of our variables.

myRecoder <- function(x) { recode(x,"1=2;5=4") }

Here is how we can use myRecoder on a single variable. Notice that the
qrl variable had a 1 for the first observation, which myRecoder made a 2. It
also had values of 5 for the sixth and seventh observations, which became 4s.

> myQRvars$qril

[11 12234554
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> myRecoder (myQRvars$qril)

[11 22234444

To apply this function to our whole data frame, myQRvars, we can use the
sapply function.

> myQRvars <- sapply( myQRvars, myRecoder)
> myQRvars

qrl qr2 qr3 qr4

1,17 2 2 4 2
2,1 2 2 4 2
3,] 2 2 4 3
[4,] 3 2 NA 3
[5,] 4 4 2 4
6,] 4 4 4 4
[7,] 4 3 4 4
8,1 4 4 4 4

The sapply function has converted our data frame to a matrix, but that is
fine. We will use the cbind function to bind these columns to our original
data frame.

> mydata <- cbind(mydata,myQRvars)
> mydata

workshop gender ql g2 g3 g4 qrl qr2 qr3 qr4

1 1 f 1 1 5 1 2 2 4 2
2 2 f 2 1 4 1 2 2 4 2
3 1 f 2 2 4 3 2 2 4 3
4 2 <NA> 3 1 NA 3 3 2 NA 3
5 1 m 4 5 2 4 4 4 2 4
6 2 m 5 4 5 65 4 4 4 4
7 1 m 5 3 4 4 4 3 4 4
8 2 m 4 5 5 5 4 4 4 4

Now we can use either the original variables or their recoded counterparts in
any analysis we choose. In this simple case, it was not necessary to create the
myRecorder function. We could have used the form,

sapply (myQRvars, recode, "1=2;5=4")

However, you can generalize the approach we took to far more situations.
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10.7.3 Example Programs for Recoding Variables
Stata Program for Recoding Variables

* Filename: Recode.do

use c:\myRfolder\mydata, clear
recode ql-q4 (1=2) (5=4)

R Program for Recoding Variables

# Filename: Recode.R

setwd ("/myRfolder")
load(file="mydata.RData")
mydata

attach(mydata)

library("car"

mydata$qrl <- recode(ql, "1=2; 5=4")
mydata$qr2 <- recode(q2, "1=2; 5=4")
mydata$qr3 <- recode(q3, "1=2; 5=4")
mydata$qrd <- recode(qd, "1=2; 5=4")

mydata

# Do it again, stored in new variable names.
load(file="mydata.RData")
attach(mydata)

# Generate two sets of var names to use.
myQnames <- paste( "q", 1:4, sep="")
myQnames

myQRnames <- paste( "qr", 1:4, sep="")
myQRnames

# Extract the q variables to a separate data frame.
myQRvars <- mydata[ ,myQnames]
myQRvars

# Rename all of the variables with R for Recoded.
names (myQRvars) <- myQRnames
myQRvars

# Create a function to apply the labels to lots of variables.
myRecoder <- function(x) { recode(x,"1=2;5=4") }
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# Here’s how to use the function on one variable.
myQRvars$qri
myRecoder (myQRvars$qril)

#Apply it to all of the variables.
myQRvars <- sapply( myQRvars, myRecoder)
myQRvars

# Save it back to mydata if you want.
mydata <- cbind(mydata,myQRvars)
mydata

summary (mydata)

10.8 Keeping and Dropping Variables

In Stata, you use the keep and drop commands to determine which variables
to save in your data set. In R, the main methods to do this within a data
frame are in Chapter 7, “Selecting Variables.” For example, if we want to keep
variables on the left side of our data frame, workshop through 2 (variables 1
through 4), an easy way to do this is with

myleft <- mydatal ,1:4]

We will strip off the ones on the right side in a future example on merging
data frames.
Another way to drop variables is to assign the NULL object to the variable:

mydata$varname <- NULL

This has the advantage of removing a variable without having to make a
copy of the data frame. That may come in handy with data frames so large
that your workspace will not hold a copy, but it is usually much safer to work
on copies when you can. Mistakes happen! You can apply NULL repeatedly
with the form

myleft <- mydata

myleft$q3 <- myleft$q4 <- NULL

NULL is only used to remove components from data frames and lists. You
cannot use it to drop elements of a vector nor can you use it to remove a
vector by itself from your workspace.

In Section 13.5, “Removing Objects from Your Workspace,” we will discuss
removing objects using the rm function. That function removes only whole
objects; it cannot remove variables from within a data frame:

rm( mydata$qd ) #This does NOT work.
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10.8.1 Example Programs for Keeping and Dropping Variables
Stata Program for Keeping and Dropping Variables

* Filename: KeepDrop.do

use c:\myRfolder\mydata, clear
keep id workshop gender ql g2

* Or equivalently;
* drop q3 g4

save c:\myRfolder\myleft, replace

R Program for Keeping and Dropping Variables

# Filename: KeepDrop.R

setwd ("/myRfolder")
load(file="mydatda.RData")

# Using variable selection.
myleft <- mydatal ,1:4]
myleft

# Using NULL.

myleft <- mydata

myleft$q3 <- myleft$qd <- NULL
myleft

10.9 Stacking/Appending Data Sets

Often we find data with observations divided into two or more sets due to
collection at different times or places. Combining them is an important step
prior to analysis. Stata calls this appending data sets and accomplishes this
with the append command. R, with its row/column orientation calls it binding
rOWS.

To demonstrate this, let us take our practice data set and split it into
separate ones for females and males. Then we will bind the rows back together.
A split function exists to do this type of task, but it puts the resulting data
frames into a list, so we will use an alternate approach.

First, let us get the females:

> females <- mydatal[ which(gender=="f"), ]
> females
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workshop gender ql g2 g3 q4

1 1 f 11 5 1
2 2 f 2 1 4 1
3 1 f 2 2 4 3

Now we get the males:

> males <- mydatal which(gender=="m"), ]
> males

workshop gender ql g2 g3 q4

5 1 m 4 5 2 4
6 2 m 5 4 5 5
7 1 m 5 3 4 4
8 2 m 4 5 5 b

We can put them right back together by binding their rows with the rbind

(43}

function. The “r” in rbind stands for row.

> both <- rbind(females, males)
> both

workshop gender ql g2 q3 q4

1 1 f 1 1 5 1
2 2 f 2 1 4 1
3 1 f 2 2 4 3
5 1 m 4 5 2 4
6 2 m 5 4 5 5
7 1 m 5 3 4 4
8 2 m 4 5 5 5

This works fine when the two data frames share the exact same vari-
ables. Often the data frames you will need to bind have a few variables
missing. We will drop variable q2 in the males data frame to create such a
mismatch.

> males$q2 <- NULL
> males

workshop gender ql g3 q4

5 1 m 4 2 4
6 2 m 5 5 5
7 1 m 5 4 4
8 2 m 4 5 5

Note that variable 2 is indeed gone. Now let us try to put the two data
frames together again.
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> both <- rbind(females, males)

Error in match.names(clabs, names(xi))
names do not match previous names

It fails because the rbind function needs both data frames to have the ex-
act same variable names. Luckily, Hadley Wickham’s reshape package has a
function, rbind.fill, that binds whichever variables it finds that match and
then fills in missing values for those that do not. This next example assumes
that you have installed the reshape package. See Chapter 2, “Installing and
Updating R,” for details.

> library("reshape")
> both <- rbind.fill(females, males)
> both

workshop gender ql g2 q3 g4

1 1 f 1 1 5 1
2 2 f 2 1 4 1
3 1 f 2 2 4 3
5 1 m 4NA 2 4
6 2 m 5NA 5 5
7 1 m 5NA 4 4
8 2 m 4NA 5 65

We can do the same thing with the built-in rbind function, but we have to
first determine which variables we need to add and then add them manually
with the data.frame function and set them to NA.

> males <- data.frame( males, g2=NA )
> males

workshop gender ql g3 g4 g2

5 1 m 4 2 4 NA
6 2 m 5 5 5 NA
7 1 m 5 4 4 NA
8 2 m 4 5 5 NA

The males data frame now has a variable q2 again and so we can bind the
two data frames using rbind. The fact that g2 is now on at the end will not
matter. The data frame you list first on the rbind function call will determine
the order of the final data frame. However, if you use index values to refer to
your variables, you need to be aware of the difference!
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> both <- rbind(females, males)
> both

workshop gender ql g2 q

w
Q
N

1 1 f 1 1 5 1
2 2 f 2 1 4 1
3 1 f 2 2 4 3
5 1 m 4NA 2 4
6 2 m 5NA 5 5
7 1 m 5NA 4 4
8 2 m 4NA 5 65

This was an easy way to do it with such a tiny data frame. In situations
that are more realistic, rbind.fil1 is usually a great time saver.

10.9.1 Example Programs for Stacking/Appending Data Sets
Stata Program for Stacking/Appending Data Sets

* Filename: Append.do

use c:\myRfolder\mydata, clear
preserve

keep if gender=="m"
save c:\myRfolder\mymale
restore

keep if gender=="f"
save c:\myRfolder\myfemale
use c:\myRfolder\mymale, clear

append using c:\myRfolder\myfemale
save c:\myRfolder\both

R Program for Stacking/Appending Data Sets

# Filename: Append.R

setwd ("/myRfolder")
load(file="mydata.RData")
mydata

attach(mydata)

# Create female data frame.
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females <- mydatal[ which(gender=="f"), ]
females

# Create male data frame.
males <- mydata[ which(gender=="m"), ]
males

#Bind their rows together with the rbind function.
both <- rbind(females, males)
both

# Drop g2 to see what happens.
males$q2 <- NULL
males

# See that row bind will not work.
both <- rbind(females, males)

# Use reshape’s rbind.fill.
library("reshape")

both <- rbind.fill(females, males)
both

# Add a g2 variable to males.
males <- data.frame( males, g2=NA )
males

# Now rbind can handle it.
both <- rbind(females,males)
both

10.10 Joining/Merging Data Sets

One of the most frequently used data manipulation methods is joining or
merging two data sets, each of which contains variables that the other lacks.
Stata does this with its merge command.

If you have a one-to-many join, it will create a row for every possible
match. A common example is a short data frame containing household-
level information such as family income joined to a longer data set of in-
dividual family member variables. A complete record of each family mem-
ber along with his or her household income will result. Duplicates in more
than one data frame are possible, but you should study them carefully for
errors.
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So that we will have an ID variable to work with, let us read our practice
data without the row.names argument. That will keep our ID variable as is
and fill in row names with 1, 2, 3,....

> mydata <- read.table("mydata.csv",

+ header=TRUE, sep="," ,na.strings=" ")
> mydata

id workshop gender ql q2 g3 g4
1 1 1 f 1 1 5 1
2 2 2 f 2 1 4 1
3 3 1 £f 2 2 4 3
4 4 2 <NA> 3 1 NA 3
5 5 1 m 4 5 2 4
6 6 2 m 5 4 5 5
T 7 1 m 5 3 4 4
8 8 2 m 4 5 5 5

Now we will split the left half of the data frame into one called myleft:

> myleft <- mydatal c("id","workshop","gender","ql","q2") 1]
> myleft

id workshop gender ql g2

1 1 1 £f 1 1
2 2 2 f 2 1
3 3 1 f 2 2
4 4 2 <KNA> 3 1
5 5 1 m 4 5
6 6 2 m 5 4
T 7 1 m 5 3
8 8 2 m 4 5

We then do the same for the variables on the right, but we will keep id and
workshop to match on later.

> myright <- mydatal c("id","workshop","q3","q4") ]
> myright

id workshop q3 q4

1 1 1 5 1
2 2 2 4 1
3 3 1 4 3
4 4 2 NA 3
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Now we can use the merge function to put the two data frames back together.

> both <- merge(myleft, myright, by="id")
> both

id workshop.x gender ql g2 workshop.y q3 g4

1 1 1 f 1 1 1 5 1
2 2 2 f 2 1 2 4 1
3 3 1 f 2 2 1 4 3
4 4 2 <KNA> 3 1 2 NA 3
5 b 1 m 4 5 1 2 4
6 6 2 m 5 4 2 5 5
T 7 1 m 5 3 1 4 4
8 8 2 m 4 5 2 5 5

This call to the merge function has three arguments.

1. The first data frame to merge.

. The second data frame to merge.

3. The by argument that has either a single variable name in quotes or a
character vector of names.

[\

If you leave out the by argument, it will match by all variables with com-
mon names! That is quite unlike Stata, which would simply match the two
row-by-row. That is what the R cbind function will do. It is much safer to
match on some sort of ID variable(s) though. Very often, rows do not match
up as well as you think.

Sometimes the same variable has two different names in the data frames
you need to merge. For example, one may have “id” and another “subject.”
If you have such a situation, you can use the by.x argument to identify the
first variable or set of variables and the by .y argument to identify the second.
The merge function will match them up in order and do the proper merge. In
this next example, we do just that. In our case variables have the same name,
but now they would not have to.

> both <- merge(myleft, myright,
+ by.x="id", by.y="id")

> both
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id workshop gender ql g2 g3 g4
1 1 1 f 11 56 1
2 2 2 f 2 1 4 1
3 3 1 f 2 2 4 3
4 4 2 <NA> 3 1 NA 3
5 5 1 m 4 5 2 4
6 6 2 m 5 4 5 5
T 7 1 m 5 3 4 4
8 8 2 m 4 5 5 5

If you have multiple variables in common, but you only want to match on
a subset of them, you can use the form

both <- merge( myleft,myright,
by=c("id","workshop") )

If each file had variables with slightly different names, you could use the form

both <- merge( myleft,myright,
by.x=c("id", "workshop"),
by.y=c("subject","shortCourse")
)

By default, Stata keeps all records regardless of whether or not they match
(a full outer join). For observations that do not have matches in the other
file, the merge function will fill in with missing values. R takes the opposite
approach, keeping only those that have a record in both (an inner join). To
get merge to keep all records, use the argument all=TRUE. You can also use
all.x=TRUE to keep all of the records in the first file regardless of whether
or not they have matches in the second. The all.y=TRUE argument does the
reverse.

While Stata can merge any number of files at once, base R can only do two
at a time. To do more, you can use the merge_all function in the reshape
package.

10.10.1 Example Programs for Joining/Merging Data Sets
Stata Program for Joining/Merging Data Sets

* Filename: Merge.do

use c:\myRfolder\mydata, clear
drop q3 g4
save c:\myRfolder\myleft

use c:\myRfolder\mydata, clear
drop workshop-q2
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save c:\myRfolder\myright

use c:\myRfolder\myleft, clear
sort id

merge id using c:\myRfolder\myright
save c:\myRfolder\both, replace

R Program for Joining/Merging Data Sets

# Filename: Merge.R
setwd ("/myRfolder")

# Read data keeping ID as a variable.
mydata <- read.table("mydata.csv",

header=TRUE,sep=",",na.strings=" ")
mydata

#Create a data frame keeping the left two q variables.
myleft <- mydatal c("id","workshop","gender","ql","q2") ]
myleft

#Create a data frame keeping the right two q variables.

myright <- mydatal c("id","workshop","q3","q4") 1]
myright

#Merge the two dataframes by ID.
both <- merge(myleft,myright,by="id")
both

#Merge the two dataframes by ID.
both <- merge(myleft, myright,
by.x="id", by.y="id" )

#Merge dataframes by both ID and workshop.
both <- merge(myleft,myright,by=c("id","workshop"))
both

#Merge dataframes by both ID and workshop,
#while allowing them to have different names.
both <- merge(myleft,
myright,
by.x=c("id", "workshop"),
by.y=c("id", "workshop") )
both
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10.11 Creating Collapsed or Aggregated Data Sets

We often have to work on data that is a summarization of other data. For
example, you might work on household-level data that you aggregated from
a data set that had each family member as its own observation. Stata calls
this collapsing data and performs it with the collapse command. Database
programmers call this rolling up data.

R has three distinct advantages over Stata aggregation.

1. It is possible to perform multilevel calculations and selections in a single
step. We will perform some of each below.

2. R can aggregate with every function it has and any function you write! It
is not limited to the few that Stata has in its collapse command.

3. R has data structures optimized to hold aggregate results. Other functions
offer methods to take advantage of those structures.

10.11.1 The aggregate Function

We will use the aggregate function to calculate the mean of the ql variable
by gender and save it to a new (very smalll) data frame.

> attach(mydata)

> myAggl <- aggregate(ql,
+ Dby=data.frame(gender),
+ mean, na.rm=TRUE)

> myAggl

gender X
1 f 1.666667
2 m 4.500000

The aggregate function call above has four arguments.

1. The variable you wish to aggregate.

2. One or more grouping factors. Unlike Stata, the data does not have
to be sorted by these factors. This must be in the form of a list (or
data frame, which is a type of list). Recall that single subscripting of
a data frame creates a list. So mydata["gender"] and mydata[2] work.
Adding the comma to either one will prevent them from working. There-
fore, mydatal ,"gender"] or mydatal ,2] will not work. If you have at-
tached the data frame, data.frame(gender) will work. The function call
list(gender) will also work, but it loses track of the grouping variable
names.
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3. The function that you wish to apply—in this case, the mean function. An
important limitation of the aggregate function is that it can apply only
functions that return a single value. If you need to apply a function that
returns multiple values, you can use the tapply function.

4. Arguments to pass to the function applied. Here na.rm=TRUE is passed to
the mean function to remove missing, or NA, values.

Next we will aggregate by two variables: workshop and gender. To keep
our by-factors in the form of a list (or data frame), we can use any one of the
following forms:

mydatal c("workshop","gender")]
or
mydatal c(2,3) ]
or if you have attached the data frame,
data.frame( workshop, gender)
In this example, we will use the latter form.

> myAgg2 <- aggregate(ql,
+ Dby=data.frame(workshop, gender),
+ mean, na.rm=TRUE)

> myAgg2

workshop gender x
1 R f 1.5
2 Stata £ 2.0
3 R m 4.5
4 Stata m 4.5

Now let us use the mode and class functions to see the type of object the
aggregate function creates is a data frame.

> mode (myAgg2)
[1] "1list"
> class(myAgg2)

[1] "data.frame"

It is small, but ready for further analysis.
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10.11.2 The tapply Function

In the last subsection we discussed the aggregate function. That function has
an important limitation: You can only use it with functions that return single
values. The tapply function works very similarly to the aggregate function
but can perform aggregation using any R function. To gain this ability, it has
to abandon the convenience of creating a data frame. Instead, its output is in
the form of a matrix or an array.

Let us first duplicate the last example from the above subsection using
tapply.

> myAgg2 <- tapply(ql,

+ data.frame(workshop,gender),

+ mean, na.rm=TRUE)

> myAgg2
gender
workshop f m
R 1.5 4.5

Stata 2.0 4.5
The tapply function call above uses four arguments.

1. The variable to aggregate.

2. One or more grouping factors. Unlike Stata, the data does not have to be
sorted by these factors. This must be in the form of a list (or data frame,
which is a list). Recall that single subscripting of a data frame creates a
list. So mydata["gender"] and mydata[2] work. Adding the comma to ei-
ther one will prevent them from working. Therefore, mydatal ,"gender"]
or mydatal ,2] will not work. If you have attached the data frame,
data.frame (gender) will work. The function call 1ist (gender) will also
work, but it loses track of the grouping variable names.

3. The function to apply—in this case, the mean function. This function can
return any result, not just single values.

4. Any additional parameters to pass to the applied function. In this case,
na.rm=TRUE is used by the mean function to remove NA or missing values.

The actual means are, of course, the same as we obtained earlier using the
aggregate function. However, the result is now a numeric matrix rather than
a data frame.

> class(myAgg2)

[1] "matrix"

> mode (myAgg2)
[1] "numeric"
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Now let us do an example that the aggregate function could not perform.
The range function returns two values: the minimum and maximum for each
variable.

> myAgg2 <- tapply(ql,
data.frame(workshop,gender),
+ range, na.rm=TRUE)

+

> myAgg2
gender
workshop £ m
R Numeric,2 Numeric,?2

Stata Numeric,2 Numeric,2

This output looks quite odd! It is certainly not formatted for communicating
results to others. Let us see how it is stored.

> mode (myAgg?2)
[1] "list"
> class(myAgg2)

[1] "matrix"

It is a matrix, whose elements are lists. Let us look at the entry for the
females who took the R workshop. That result is stored in the first row and
first column.

> class( myAgg2[1,1] )
[1] "list"
> myAgg2([1,1]

[[1]1]
[11 1 2

So we see that each component in this matrix is a list that contains a
single vector of minimum and maximum values. The opinions of the females
who took the R workshop range from 1 to 2.

While this output is not very useful for communicating results, it is very
useful as input for further programming.

10.11.3 Merging Aggregates with Original Data

It is often useful to add aggregate values back to the original data frame.
This allows you to perform multilevel transformations that involve both
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individual-level and aggregate-level values. A common example of such a cal-
culation is a Z score, which subtracts a variable’s mean and then divides by its
standard deviation (the scale function performs this particular calculation
more easily).

Another important use for merging aggregates with original data is to
perform multilevel selections of observations. To select individual-level obser-
vations based on aggregate-level values requires access to both at once. For
example, we could create a subset of subjects who fall below their group’s
mean value.

This is an area in which R has a distinct advantage over Stata. R’s greater
flexibility allows it to do both multi-level transformations and selections in a
single step.

Now let us calculate a Z-score for variable ql with the single following
statement. Note that we are specifying the long form of the name for our new
variable, mydata$Zql, so that it will go into our data frame.

> mydata$Zql <- (q1 - mean(ql) ) / sd(ql)

> mydata

workshop gender ql g2 q3 g4 Zql
1 R f 1 1 5 1 -1.5120484
2 Stata f 2 1 4 1 -0.8400269
3 R f 2 2 4 3 -0.8400269
4 Stata <NA> 3 1 NA 3 -0.1680054
5 R m 4 5 2 4 0.5040161
6 Stata m 5 4 5 5 1.1760376
7 R m 5 3 4 4 1.1760376
8 Stata m 4 5 5 5 0.5040161

You can also select the observations that were below average with this single
statement.

> mySubset <- mydatal ql < mean(ql), ]

> mySubset

workshop gender ql g2 q3 g4 Zq1
1 R f 1 1 5 1 -1.5120484
2 Stata f 2 1 4 1 -0.8400269
3 R f 2 2 4 3 -0.8400269
4 Stata <NA> 3 1 NA 3 -0.1680054

Stata cannot perform such calculations and selections in one step. You
would have to create the aggregate-level data and then merge it back into the
individual-level data set. R can use that approach too, and as the number of
levels you consider increases, it becomes more reasonable to do so.
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So let us now merge myAgg2, created in Section 10.11.1, “The aggregate
Function.” to mydata. To do that, we will rename the mean of ql from x to

mean.ql. We will use the rename function from the reshape package. If you
do not have that installed, see Chapter 2, “Installing and Maintaining R.”

> library("reshape")
> myAgg3 <- rename (myAgg2, c(x="mean.ql"))
> myAgg3

workshop gender mean.ql

1 R f 1.5
2 Stata f 2.0
3 R m 4.5
4 Stata m 4.

Now we merge the mean onto each of the original observations.

> mydata2 <- merge(mydata, myAgg3,
+  Dby=c("workshop","gender") )

> mydata2

workshop gender ql g2 g3 g4 Zql mean.ql
1 R f 1 1 5 1 -1.5120484 1.5
2 R f 2 2 4 3 -0.8400269 1.5
3 R m 4 5 2 4 0.5040161 4.5
4 R m 5 3 4 4 1.1760376 4.5
5 Stata f 2 1 4 1 -0.8400269 2.0
6 Stata m 5 4 5 5 1.1760376 4.5
7 Stata m 4 5 5 5 0.5040161 4.5

The merge function call above has only two arguments.

1. The two data frames to merge. Unlike Stata, which can merge many data
sets at once, R can only do two at a time.

2. The by argument specifies the variables to match on. In this case, they
have the same name in both data frames. They can, however, have different
names. See the merge help files for details. While some other functions
require by variables in list form, here you provide more than one variable
in the form of a character vector.

We could now perform multilevel transformations or selections on
mydata2.
10.11.4 Tabular Aggregation

The aim of table creation in Stata is to communicate the results to people. You
can create simple tables of frequencies and percents using the Stata tabulate
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command. However, no other procedures are programmed to process these
tables further automatically.

While R can create tables that are nicely formatted for presentation, its
output is usually sparse and optimized for further use by other functions. They
are a different form of aggregated data set. See Chapter 17, “Statistics,” for
other uses of tables.

Let us revisit simple frequencies using the table function. First, let us
look at just workshop attendance (the data frame is attached, so we are using
short variable names).

> table(workshop)

workshop
R Stata
4 4

And now gender and workshop.

> table(gender,workshop)
workshop

gender R Stata
f2 1
m 2 2

Let us save this table to an object myCounts and check its mode and class.

> myCounts <- table(gender, workshop)
> mode (myCounts)

[1] "numeric"

> class(myCounts)

[1] "table"

We see that the mode of myCounts is numeric and its class is table. Other
functions that exist to work with presummarized data know what to do
with table objects. In Chapter 15, “Traditional Graphics,” we will see the
kinds of plots we can make from tables. In Chapter 17, “Statistics,” we will
also work with table objects to calculate related values like row and column
percents.

Other functions prefer count data in the form of a data frame. This is the
type of output created by the Stata collapse command. The as.data.frame
function makes quick work of it.

> myCountsDF <- as.data.frame(myCounts)

> myCountsDF
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gender workshop Freq

1 f R 2
2 m R 2
3 f Stata 1
4 m Stata 2

> class(myCountsDF)
[1] "data.frame"

This approach is particularly useful for people who use analysis of variance.

You can get cell counts for very complex models in a form that is very easy
to read and use in further analyses.

10.

11.5 The reshape Package

If you perform a lot of aggregation, you will want to learn how to use
Hadley Wickham’s powerful reshape package [53].

10.

11.6 Example Programs for Collapsing/Aggregating Data

Stata Program for Collapsing/Aggregating Data

* Filename: Collapse.do

use c:\myRfolder\mydata
* Get means of ql for each gender
tabstat ql, by(gender)

* Get means of ql by workshop and gender;
tabulate outwork gender, summarize(ql) means

* Strip out just the mean and matching variables;
collapse (mean) workshop gender, by(ql)

* Merge aggregated data back into mydata.
* mydata assumed to be sorted by ql

sort ql

merge ql using mydata

R Program for Collapsing/Aggregating Data

# Filename: Collapse.R

setwd ("/myRfolder")
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load(file="mydata.RData")
attach(mydata)
mydata

# The aggregate F